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Preface
See the Data Archive User Guide to learn how to perform tasks involving data backup, restore, and retrieval in 
Data Archive. Read about application retirement, retention management, and retirement report generation.

Informatica Resources
Informatica provides you with a range of product resources through the Informatica Network and other online 
portals. Use the resources to get the most from your Informatica products and solutions and to learn from 
other Informatica users and subject matter experts.

Informatica Network
The Informatica Network is the gateway to many resources, including the Informatica Knowledge Base and 
Informatica Global Customer Support. To enter the Informatica Network, visit 
https://network.informatica.com.

As an Informatica Network member, you have the following options:

• Search the Knowledge Base for product resources.

• View product availability information.

• Create and review your support cases.

• Find your local Informatica User Group Network and collaborate with your peers.

Informatica Knowledge Base
Use the Informatica Knowledge Base to find product resources such as how-to articles, best practices, video 
tutorials, and answers to frequently asked questions.

To search the Knowledge Base, visit https://search.informatica.com. If you have questions, comments, or 
ideas about the Knowledge Base, contact the Informatica Knowledge Base team at 
KB_Feedback@informatica.com.

Informatica Documentation
Use the Informatica Documentation Portal to explore an extensive library of documentation for current and 
recent product releases. To explore the Documentation Portal, visit https://docs.informatica.com.

If you have questions, comments, or ideas about the product documentation, contact the Informatica 
Documentation team at infa_documentation@informatica.com.
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Informatica Product Availability Matrices
Product Availability Matrices (PAMs) indicate the versions of the operating systems, databases, and types of 
data sources and targets that a product release supports. You can browse the Informatica PAMs at 
https://network.informatica.com/community/informatica-network/product-availability-matrices.

Informatica Velocity
Informatica Velocity is a collection of tips and best practices developed by Informatica Professional Services 
and based on real-world experiences from hundreds of data management projects. Informatica Velocity 
represents the collective knowledge of Informatica consultants who work with organizations around the 
world to plan, develop, deploy, and maintain successful data management solutions.

You can find Informatica Velocity resources at http://velocity.informatica.com. If you have questions, 
comments, or ideas about Informatica Velocity, contact Informatica Professional Services at 
ips@informatica.com.

Informatica Marketplace
The Informatica Marketplace is a forum where you can find solutions that extend and enhance your 
Informatica implementations. Leverage any of the hundreds of solutions from Informatica developers and 
partners on the Marketplace to improve your productivity and speed up time to implementation on your 
projects. You can find the Informatica Marketplace at https://marketplace.informatica.com.

Informatica Global Customer Support
You can contact a Global Support Center by telephone or through the Informatica Network.

To find your local Informatica Global Customer Support telephone number, visit the Informatica website at 
the following link: 
https://www.informatica.com/services-and-training/customer-success-services/contact-us.html.

To find online support resources on the Informatica Network, visit https://network.informatica.com and 
select the eSupport option.
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C h a p t e r  1

Introduction
This chapter includes the following topics:

• Data Archive Overview, 17

• Data Archive Use Cases, 18

Data Archive Overview
Data Archive is a comprehensive solution for relocating application data to meet a range of business 
requirements.

Features
• Enterprise archive engine for use across multiple databases and applications

• Streamlined flow for application retirement

• Analytics of data distribution patterns and trends

• Multiple archive formats to meet different business requirements

• Seamless application access to archived data

• Data Discovery search of offline archived or retired data

• Accessibility or access control of archived or retired data

• Retention policies for archived or retired data

• Purging of expired data based on retention policies and expiration date

• Catalog for the retired applications to see retired application details

• Complete flexibility to accommodate application customizations and extensions

Benefits
• Improve production database performance

• Maintain complete application integrity

• Comply with data retention regulations

• Retire legacy applications

• High degreee of compression reduces application storage footprint

• Enable accessibility to archived data
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• Immutability ensures data authenticity for compliance audits

• Reduce legal risk for data retention compliance

Data Archive Use Cases
Improving application performance, complying with data retention regulations, and retiring legacy 
applications are all use cases for Data Archive.

Data Archive for Performance
Customers need to continuously improve the operational efficiency of their production environment. The Data 
Archive for Performance solution provides flexible archive and purge functionality to quickly reduce the 
overall size of production databases. Proactive archiving enables you to keep pace with the increasing rate of 
your business activity. Data Archive reduces transaction volume for intensively used modules, thereby 
ensuring that inactive data does not interfere with the day to day use of active data.

Data Archive for Compliance
Data Archive for Compliance retires data with encapsulated BCP files to meet long term data retention, legal, 
and regulatory compliance requirements. Each object contains the entire configuration, operational, and 
transactional data needed to identify any business transaction.

With Enterprise Data Manager, accelerators for Oracle E-Business Suite, PeopleSoft, and Siebel applications 
are available to “jump start” your compliance implementation. In addition, you can use Enterprise Data 
Manager for additional metadata customization.

Data Archive for Retirement
Organizations upgrading or implementing newer versions of enterprise applications often face the challenge 
of existing legacy applications that have outlived their usefulness. To eliminate infrastructure and licensing 
costs, as well as functional redundancy, organizations must shut down these applications. However, the 
question of application data remains. Many organizations want to ensure accessibility to this older data 
without either converting it to the format of a new application or maintaining the technology necessary to run 
the legacy application. Data Archive provides all functionality necessary to retire legacy applications.
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C h a p t e r  2

Accessing Data Archive
This chapter includes the following topics:

• Data Archive URL, 19

• Log In and Out of Data Archive, 19

• Update User Profile, 20

Data Archive URL
Access Data Archive with the following URL format:

http://<host name>:<port number>/<web application name>
Or, if SSL is enabled:

https://<host name>:<port number>/<web application name>
The URL includes the following variables:
Host Name

Name of the machine where Data Archive is installed.

Port Number

Port number of the machine where Data Archive is installed.

Web Application Name

Name of the Data Archive web application, typically Informatica. Required if you do not use embedded 
Tomcat. Omit this portion of the URL if you use embedded Tomcat.

When you launch the URL, the Data Archive login page appears. Enter your user name and password to log in.

Log In and Out of Data Archive
Besides initial login, Data Archive provides its user the capability to log in again. Typically, this functionality is 
meant for switching between users. However, it might also be applicable when a user’s access level is 
modified. In such a circumstance, a re-login is necessary.

A user can log in again from Home > Login Again and log out from Home > Logout.
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Update User Profile
View and edit your user profile from Home > User Profile. You can update your name, email and password. 
You can also view the system-defined roles assigned to you.
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C h a p t e r  3

Working with Data Archive
This chapter includes the following topics:

• Data Archive Editions, 21

• Organization of Menus, 21

• Predefined List of Values (LOVs), 22

• Online Help, 22

Data Archive Editions
Data Archive is available in Standard and Enterprise editions. This manual looks at the application from the 
Enterprise edition perspective and explains functionality differences within editions, wherever applicable.

Note: The Standard edition of Enterprise Data Management Suite allows the user to select only a single ERP, 
whereas the Enterprise edition encompasses all supported platforms.

Organization of Menus
The functionality of Data Archive is accessible through a menu system consisting of seven top-level menus 
and respective submenus as shown in the following figure:

Note: Some of these menu options might not be available in the Standard edition of Data Archive. System-
defined roles restrict the menu paths that are available to users. For example, only users with the discovery 
user role have access to the Data Discovery menu. 
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Predefined List of Values (LOVs)
Most tasks performed from the Data Archive user interface involve selecting a value from a list. Such lists 
are abbreviated as LOVs and their presence is marked by the LOV button, usually followed by an asterisk sign 
(*) to indicate that it is mandatory to specify a value for the preceding text box.

The list is internally generated by a query constructed from Constraints specified on a number of tables 
through the Enterprise Data Manager.

Mandatory Fields
Throughout the application, red asterisks * indicate mandatory information that is essential for subsequent 
processes.

Edit and Delete Options
Most sections of the application provide edit and delete options for elements like Policies, Users, Security 
Groups, Repositories, and Jobs, in the form of an Edit button and a Delete button respectively.

Clicking Edit usually leads you to the Create/Edit page for the corresponding element in the section, while 
clicking Delete triggers a confirmation to delete the element permanently.

Navigation Options
The breadcrumb link in each page denotes the current location in the application.

When the number of elements in a section, represented as rows (for example, Roles i.e. “elements” in the 
Role Workbench i.e. “section”) exceed ten in number, navigation options are introduced, to navigate to the 
first, previous, next, and last page respectively.

The user can change the number of rows to be displayed per page.

The number of elements (represented as rows) in a section are specified at the end of a page.

Expand and Collapse Options
In certain sections, elements (i.e. rows) contain detailed information and are expandable. For such sections, 
Expand All and Collapse All options are available on the top right corner of the section.

Additionally, for each row, a Collapse All button to the left suggests that further detail can be extracted by 
clicking on it.

Online Help
The Data Archive user interface is enabled with a context sensitive online help system which can be 
accessed by clicking on the Help button on the top right corner of the screen.
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C h a p t e r  4

Scheduling Jobs
This chapter includes the following topics:

• Scheduling Jobs Overview, 23

• Standalone Jobs, 23

• Scheduling Jobs, 44

• Job Logs, 44

• Monitoring Jobs, 45

• Pausing Jobs, 46

• Searching Jobs, 47

• Troubleshooting Jobs, 47

Scheduling Jobs Overview
Data Archive allows a user to run one-time jobs or schedule jobs to run periodically. Users can also search, 
view, monitor, and manage jobs.

Standalone Jobs
A standalone job is a job that is not linked to a Data Archive project. Standalone jobs are run to accomplish a 
specific task.

You can run standalone jobs from Data Archive. Or, you can use a JSP-API to run standalone jobs from 
external applications.

Archive Structured Digital Records
Use the Archive Structured Digital Records standalone job to archive structured digital records, such as call 
detail records. When you run the job, the job populates the AMHOME tables and creates an entity in EDM. You 
provide the entity creation details in a metadata file, such as the application name, application version, 
application module, and entity name. The job generates a metadata .xml file and calls the Data Vault Loader 
to load the files into the Data Vault. The Data Vault Loader loads the files from the root staging directory that 
is configured in the Data Vault target connection.
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In the job step log on the Monitor Jobs page, you can view a row count report for the records that were 
successfully loaded to Data Vault.

The date field in the digital record must be in the format yyyy-MM-dd-HH.mm.ss.SSS. For example: 
2012-12-27-12.11.10.123.

After you run the job, assign a Data Vault access role to the entity. Then, assign users to the Data Vault 
access role. Only users that have the same role assignment as the entity can use Browse Data to view the 
structured digital records in Data Discovery.

Metadata File
The metadata file is an XML file that contains the details of the entity that the job creates. The file also 
contains the structure of the digital records, such as the column and row separators, and the table columns 
and datatypes.

The following example shows a sample template file for the structured metadata file:

<?xml version="1.0" encoding="UTF-8"?>

<ATTACHMENT_DESCRIPTOR>
     <ENTITY>
            <APP_NAME>CDR</APP_NAME>
            <APP_VER>1.10</APP_VER>
            <MODULE>CDR</MODULE>
            <ENTITY_NAME>CDR</ENTITY_NAME>
            <ENTITY_DESC>CDR Records</ENTITY_DESC>
     </ENTITY>           
     <FILE_DESC>
            <COLUMN_SEPARATOR>,</COLUMN_SEPARATOR>
            <ROW_SEPARATOR>%#%#</ROW_SEPARATOR>
            <DATE_FORMAT>yyyy-MM-dd-HH.mm.ss</DATE_FORMAT>
            <TABLE NAME="CDR">
                   <COLUMN PRIMARY_KEY="Y" ORDER="1" DATATYPE="NUMERIC" 
PRECISION="10">CALL_FROM</COLUMN>
                   <COLUMN ORDER="2" DATATYPE="NUMERIC" PRECISION="10">CALL_TO</COLUMN>
                   <COLUMN ORDER="3" DATATYPE="DATETIME">CALL_DATE</COLUMN>
                   <COLUMN ORDER="4" DATATYPE="VARCHAR" LENGTH="100">LOCATION</COLUMN>
                   <COLUMN ORDER="5" DATATYPE="NUMERIC" PRECISION="10" 
SCALE="2">DURATION</COLUMN>
            </TABLE>
      </FILE_DESC>
</ATTACHMENT_DESCRIPTOR>

You can also indicate whether or not a column is nullable. Use the following syntax: <COLUMN NULLABLE="N"> 
</COLUMN> or <COLUMN NULLABLE="Y"></ COLUMN>.

For example:

<TABLE NAME="SAMPLE">

<COLUMN PRIMARY_KEY="Y" ORDER="9" DATATYPE="DATETIME" LENGTH="1000" 
NULLABLE="N">callDate_callTime</COLUMN>

</TABLE>
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Archive Structured Digital Records Job Parameters
Each standalone job requires program-specific parameters as input.

The following table describes the job parameters for the Archive Structured Digital Records job:

Parameter Description

Metadata File XML file that contains the details of the entity that the job creates and the structure of the digital 
records, such as the column and row separators, and the table columns and datatypes.

Target Archive 
Store

Destination where you want to load the structured digital records. Choose the corresponding Data 
Vault target connection. The list of values is filtered to only show Data Vault target connections.

Purge After Load Determines whether the job deletes the attachments from the staging directory that is configured 
in the Data Vault target connection.
- Yes. Deletes attachments from the directory.
- No. Keeps the attachments in the directory. You may want to select no if you plan to manually 

delete the attachments after you run the standalone job.

Collect Data Growth Stats
The Collect Data Growth Stats job allows you to view database statistics for the selected data source.

Provide the following information to run this job:

• Source repository. Database with production data.

Create Archive Cycle Index
The Create Archive Cycle Index job creates database indexes based on job IDs for archive job executions. 
Run this job to optimize the restore performance. Perform the restore operation for a database archive after 
this job completes.

Provide the following information to run this job:

• Target repository. Database with archived data.

• Entity name. Name of the entity for which database indexes need to be created.

Create Archive Folder
The Create Archive Folder job creates an archive folder for each retired application in the Data Vault. Run this 
job if you are retiring an application for the first time.

Provide the following information to run this job:

• Destination Repository. Archive folder you want to load the archive data to. Choose the archive folder 
from the list of values. The target connection name appears before the archive folder name.

Create History Index
The Create History Index job creates database indexes for all tables involved during seamless data access. 
Run this job after running the Create Seamless Data Access job.

Provide the following information to run this job:

• Output location of generated script file. The output location of the generated script file.
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• Source repository. Database with production data.

• Target repository. Database with archived data.

Create History Table
The Create History Table job creates table structures for all tables that will be involved in seamless data 
access for a data source and data target. Run this job prior to running the Create Seamless Data Access job.

Note: If additional tables are moved in a second archive job execution from the same data source, seamless 
data access will not be possible for the archived data, unless the Create History Tables job is completed. 

Provide the following information to run this job:

• Output location of generated script file. The output location of the generated script file.

• Source repository. Database with production data.

• Target repository. Database with archived data.

Create Indexes on Data Vault
Before you can search for records across applications in Data Vault, you must first create search indexes. 
Run the Create Indexes on Data Vault job to create a search index for each table that you want to include in 
the search.

If you add or remove columns from the search index, delete the search indexes first. Then run the Create 
Indexes on Data Vault to create the new indexes. Alternatively, you can run the Reindex on Data Vault 
standalone job, which runs the Delete Indexes on Data Vault job and the Create Indexes on Data Vault job 
back-to-back.

If the job fails while creating the indexes, some table records are indexed multiple times when you resume 
the job. To remove the duplicate indexing, run the Delete Indexes on Data Vault job and select the connection 
and table from the list of values. After the Delete Indexes on Data Vault job is complete, run the Create 
Indexes on Data Vault job again with the same connection and table selected for the job.

Provide the following information to run this job:

Destination Repository

Required. Database with archived data.

Entity

Optional. The name of the entity for the table with the columns you want to add or remove from the 
search index.

Table

Optional. The name of the table with the columns you want to add or remove from the search index. 
Verify that you have selected the columns for indexing in the Enterprise Data Manager. If a table does 
not have any columns selected for indexing, the job enters a warning state.
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Create Materialized Views Job
You can define materialized views in the Enterprise Data Manager. After you define the materialized views, 
run the create materialized views job to create the views in the Data Vault.

Provide the following information to run the job:

Destination Repository 

The archive folder in the Data Vault where you retired the application data. Click the list of values button and 
select from the available folders.

Schema Name 

The schema in which you want to create the materialized views.

Entity 

The entity for the view. This field is optional.

View 

The name of the view. If you selected a value for the entity parameter, the entity value overrides the view 
parameter. This field is optional.

Create Seamless Data Access Job

The Data Archive Seamless Data Access job creates the two schemas and populates them with the 
appropriate synonyms and views.

Provide the following information to run this job:

• Source. Database with production data.

• Target. Database with archived data.

• Combined Schema Name. Schema name for seamless access across the two databases.

• Combined Schema Password. Schema password for seamless access across the two databases.

• Archive Schema Name. Schema name for allowing access to archived data.

• Archive Schema Password. Schema password for allowing access to archived data.

• Combined / Archive Schema Location. Specify whether schemas were created at the data source or data 
target.

• Database Link Name. Database link name from data source to data target.

Create Seamless Data Access Script Job

To configure seamless access, you must create views and synonyms in the database. If your policies do not 
allow external applications to create database objects, use the Create Seamless Data Access Script 
standalone job to create a script that you can review and then run on the database. The script includes 
statements to create the required views and synonyms for seamless access.

When you run the job, the job creates a script and stores the script in the location that you specified in the job 
parameters. The job uses the following naming convention to create the script file:

SEAMLESS_ACCESS_<Job ID>.SQL
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The job uses the parameters that you specify to create the script statements. The script can include 
statements to create one of the following seamless access views:

• Combined view of the production and archived data.

• Query view of the archived data.

The script generates statements for the schema that you provide in the job parameters. You can enter the 
combined schema or the query schema. For example, if you provide the combined schema, then the script 
includes statements to create the views and synonyms for the combined seamless access view.

If you want to create both the combined view and the query view, run the job once for each schema.

Create Seamless Data Access Script Job Parameters

Provide the following information to run the Seamless Data Access Script job:
Source Repository

Archive source connection name. Choose the source connection for the IBM DB2 database that stores 
the source or production data.

Destination Repository

Archive target connection name. Choose the target connection for the IBM DB2 database that stores the 
archived data.

Combined Schema Name

Schema in which the script creates the seamless access view of both the production and the archived 
data.

Note that the job creates statements for one schema only. Configure either the Combined Schema Name 
parameter or the Query Schema Name parameter.

Combined Schema Password

Not required for IBM DB2.

Query Schema Name

Schema in which the script creates the view for the archived data.

Note that the job creates statements for one schema only. Configure either the Combined Schema Name 
parameter or the Query Schema Name parameter.

Query Schema Password

Not applicable for IBM DB2.

Combined/Query Schema Location

Location of the combined and query schemas.

Use one of the following values:

• Source

• Destination

The combined and query schemas may exist on the source database if a low percentage of the source 
application data is archived and a high percentage of data remains on the source.

The combined and query schema may exist on the target location if a high percentage of the source 
application data is archived and a low percentage of data remains on the source.
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Generate Script

Determines if the job generates a script file. Always choose Yes to generate the script.

Database Link

Not required for IBM DB2.

Default is NONE. Do not remove the default value. If you remove the default value, then the job might fail.

Script Location

Location in which the job saves the script. Enter any location on the machine that hosts the ILM 
application server.

Create Seamless Data Access Physical and Logical Script
You can create seamless access between an IBM DB2 for AS/400 source connection with physical and 
logical files and a IBM DB2 for AS/400 target connection with archived data. Use the Create Seamless Data 
Access Physical and Logical Script standalone job to create a script that you can review and then run on the 
target database. The script includes statements to create the required database objects for seamless access 
between the source and target connections.

Provide the following information to run this job:

SourceRep 

The IBM DB2 for AS/400 source connection that stores the source or production data.

DestRep 

The IBM DB2 for AS/400 target connection that stores the archived data.

Script Location 

Location where you want to save the scripts that the job creates. This location must be accessible to the ILM 
application server.

After the job completes successfully, download the script files from the Monitor Jobs page. To download the 
script files, expand the Job ID and click the Download Physical and Logical Script link. Then extract the 
downloaded file, which is named ScriptGeneration_xx.zip.

Within the extracted folder, the bin folder contains a connections properties file. Update the parameters to be 
specific to your environment. The lib_name and file_name parameters should be eight characters or less.

After you edit the connections file, run the GenerateScriptForDb2AS400.bat file on a Microsoft Windows 
operating system or the GenerateScriptForDb2AS400.sh file on a UNIX/Linux operating system. When the 
shell script or batch file runs, it creates the seamless access scripts in the location that you specified in the 
job parameters.

For more information, see the Informatica Data Archive Administrator Guide.

Copy Application Version for Retirement
Use the Copy Application Version for Retirement job to copy metadata from a pre-packaged application 
version to a customer-defined application version. Run the job to modify the metadata in a customer-defined 
application version. The metadata in pre-packaged application versions is read-only.

When you run the Copy Application Version for Retirement job, the job creates a customer-defined application 
version. The job copies all of the metadata to the customer-defined application version. The job copies the 
table column and constraint information. After you run the job, customize the customer-defined application 
version in the Enterprise Data Manager. You can create entities or copy pre-packaged entities and modify the 
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entities in the customer-defined application version. If you upgrade at a later time, the upgrade does not 
change customer-defined application versions.

Provide the following information to run this job:

• Product Family Version. The pre-packaged application version that you want to copy.

• New Product Family Version Name. A name for the application version that the job creates.

Delete Indexes on Data Vault
The Delete Indexes on Data Vault job deletes all search indexes in a specified archive folder or on all Data 
Vault connections. Run this job every time you add or remove columns from search indexes. You must also 
run this job after you purge an application that was included in the search indexes. After this job completes, 
run the Create Indexes on Data Vault job to create the new search indexes.

Alternatively, you can run the Reindex on Data Vault standalone job, which runs the Delete Indexes on Data 
Vault job and the Create Indexes on Data Vault job back-to-back.

To run the Delete Indexes on Data Vault job, a user must have one of the following system-defined roles:

• Administrator

• Retention Administrator

• Scheduler

Provide the following information to run this job:

Destination Repository 

The Data Vault connection configured to the specific archive folder that you want to delete indexes on. 
Choose either the specific connection or "all connections" to delete indexes on all available Data Vault 
connections.

Entity 

Optional. The name of the entity.

Table 

Optional. The name of the table.

Encrypt Data in Data Vault Job
The encrypt data in Data Vault job gives you the option to encrypt data that has already been archived or 
retired to the Data Vault. You can also use the job to rotate encryption keys on a regular basis, as required by 
company security policy.

Typically when you archive or retire data to the Data Vault, you enable data encryption when you create the 
archive or retirement project. If you archive or retire to the Data Vault without enabling data encryption, you 
can use the encrypt data in Data Vault job to encrypt the data at a later time. You can also use the job to 
rotate encryption keys for data that has already been encrypted, either during the initial project run or with 
this standalone job.

Access Roles

To be able to view and schedule the encrypt data in Data Vault job, a user must have both the encryption user 
role as well as a role that allows a user to schedule jobs, such as the scheduler role. The encryption user role 
is assigned to the Administrator role by default. For more information on system-defined roles, see the 
chapter "Security" in the Data Archive Administrator Guide.
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Conf.properties File

The following table describes the properties that you can configure in conf.properties:

Property Description

informia.encryptionkey.command Command to generate the encryption key if you use a third-party 
utility. Provide the command to run the third-party key generator.

informia.encryption.RegistrationThreadCount Defines the number of registration threads used to encrypt the Data 
Vault data. Default value is 5.

informia.encryption.WorkerThreadCount Defines the number of worker threads used to encrypt the Data Vault 
data. Default value is 10.

informia.encryption.SCTRegistrationType Defines whether the SQL or admin registers the encrypted .SCT files 
in Data Vault. Valid property values are SQL and admin. Default is 
SQL.

informia.encryption.AdminTimeout Defines the admin timeout in seconds.

informia.encryption.DeleteOldDataFiles Specifies whether or not to delete the original unencrypted data files 
during the encryption job. Valid property values are Y and N. Default 
value is N.
If you set this property to N, the encrypt job unregisters but does not 
delete the original unencrypted .SCT files. The job also creates new, 
encrypted data files and registers those files. Because the original 
files are still present in their physical location, the total size of 
the .SCT files will double.
If you set this property to Y, the job deletes the original files during 
the encryption job.
There is no automated process to validate the encrypted data 
against the original data. You must manually validate the encrypted 
data against the original data. After you validate the data, refer to 
the steps in the "Restoring and Deleting Old .SCT files" section below 
for cleanup instructions.
Informatica recommends setting this property to N, so that you can 
manually validate the encrypted data.
Default is N.

informia.encryption.IDVDeBugMode Specifies whether or not Data Vault runs the encryption job in debug 
mode. Valid property values are Y and N.
Default value is N.
Debug mode provides more troubleshooting information if the 
encryption job fails.

For more information on the conf.properties file, see the Data Archive Administrator Guide.

Job Properties

Archive Store 

The Data Vault target connection that contains the data that you want to encrypt. The job encrypts all of the 
tables in the archive folder that is defined in the target connection that you select. To encrypt the data on all 
available Data Vault connections, you can also choose "All Connections."
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Encryption Key 

Type of encryption key used to encrypt the data. You can choose either the random key generator provided by 
Informatica, or a third-party key generator. When you choose the third-party key generator, you must configure 
the property "informia.encryptionkey.command" in the conf.properties file. For more information on 
random and third-party encryption keys, see the chapters "Creating Retirement Archive Projects" and "Creating 
Data Archive Projects" in the Data Archive User Guide.

Rotate Keys 

Select Yes or No. When you select yes, the job generates a new key used to encrypt the data. The data is 
encrypted with the new key.

Parallel Jobs

The encrypt data in Data Vault job is a single-thread job. You cannot run two encrypt jobs in parallel on the 
same Data Vault connection, nor can you run a job to encrypt all available connections and then start a 
second job on any connection. You can run two encrypt jobs in parallel provided they are running on different 
Data Vault connections. This design preserves the consistency of Data Vault metadata. When the encrypt 
data in Data Vault job runs, it unregisters the original unencrypted .SCT files in the Data Vault and registers 
the new encrypted files with the suffix "_ENC" appended to the file name. If you run the job to rotate 
encryption keys, the original encrypted .SCT files are unregistered.

If you try to run an encrypt job on a connection while a different encrypt job is running on the same 
connection, the job fails with an error that another encryption job is running. You must wait for the first 
encryption job to finish before starting another encryption job on the same connection.

In rare circumstances you may have the same Data Vault archive folder available on two different Data Vault 
connections. Because the underlying Data Vault database is the same, you cannot run parallel encryption 
jobs on this archive folder even though it exists on different connections.

In addition to parallel encryption jobs, you cannot simultaneously run any job that updates Data Vault 
metadata while an encryption job is running on the same connection. If you try to run any job that updates 
Data Vault metadata while an encryption job is running on the same connection, or all connections, the 
second job fails with an error. You can run a job that updates Data Vault metadata in parallel with an 
encryption job only if the encryption job is running on a different connection and archive folder than the 
second job.

The following list contains the specific jobs that you cannot run while an encryption job runs on the same 
target connection:

• Archive crawler

• Move external attachments

• Update retention policy

• Delete expired records

• Purge expired records

• Add tagging

• Update tagging

• Remove tagging

• Apply legal hold

• Remove legal hold

• Load external attachments

• Restore external attachments from archive folder

• Audit log archive loader

32       Chapter 4: Scheduling Jobs



• Archive structured digital records

• Restore file archive

• Move external attachments

• Create materialized views

• Refresh materialized views

• Release of information index record

Logs and Reports

The encryption job creates logs that are stored in the <ILM_HOME>/logs/ directory. The logs contain 
information about the archive folder and individual tables that were encrypted during the job, such as the 
time that the job took to encrypt each table.

The encryption job creates logs inside of the <ILM_HOME>/logs/ folder with the following directory structure: 
<ILM_HOME>/logs/encryption_logs/<Job ID>/<Repository ID>/<Logs_entry_ID>. The <Logs_entry_ID> 
directories contain a log for each table in the archive folder that was encrypted during the job. To find the 
table associated with a particular entry ID, you can query the ILM repository table 
"xa_encryption_job_status." The table contains the column ENTRY_ID for each table in the encryption job. 
The table also has a STATUS column to indicate the encryption status of a particular table. The STATUS 
column contains either C for complete, P for pending, or E for error.

An encryption job status report is also available in the Data Archive user interface, on the Monitor Jobs page. 
Expand the encryption job and then the job details to display the link that launches the PDF status report. The 
report is dynamic, so you can launch the report and track the progress of the job as it runs.

Restore Process

The job generates restore scripts every time you run it. The scripts are stored in the following location: 
<ILM_HOME>/webapp/file_archive/restore/. The job creates one folder for each table, with the folder 
structure JOBID/repid/tableid.

If necessary, you can restore the previous .SCT files after the encryption job is complete. To restore the 
previous .SCT files, run the following commands from the Plugin folder:

source the fasplugin.sh
go to <ILM_HOME>/webapp/file_archive
. ./fasplugin.sh <ILM_HOME>/webapp/file_archive
go to <ILM_HOME>/webapp/file_archive 
ssaencrypt -G -F
<ILM_HOME>/webapp/file_archive/restore/JOBID/repid/tableid/
<Restore_YYYY_MM_DD_hh_mm_ss.adm>
-P <PORT> -Q <AdminPort> -H <IDV Hostname> -u
<IDV user/password>

The command will unregister the new encrypted .SCT files, register the old .SCT files, and delete the new 
encrypted .SCT files.

Note: When the .SCT files are located on external storage, the files will not be deleted if they are under 
retention.

Deletion of Old .SCT Files

After you validate the data, if you want to delete the old .SCT files, run the following commands:

source the fasplugin.sh
go to <ILM_HOME>/webapp/file_archive
. ./fasplugin.sh <ILM_HOME>/webapp/file_archive
ssaencrypt -O -F
<ILM_HOME>/webapp/file_archive/restore/JOBID/repid/tableid/
<Restore_YYYY_MM_DD_hh_mm_ss.adm>
-P <PORT> -Q <AdminPort> -H <IDV Hostname> -u
<IDV user/password>
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The command deletes the old .SCT files.

Note: When the .SCT files are located on external storage, the files will not be deleted if they are under 
retention.

Encryption Report Job
To check the encryption status of the archive folders, run the Encryption Report standalone job. The 
Encryption Report standalone job generates a report that returns the encryption status of all archive folders 
present in Data Vault. After you run the job, you can access the encryption report from the Encryption Report 
job details on the Monitor Jobs page.

The Encryption Report job does not require you to provide any information. You must have the Encryption 
User role to access the encryption report.

Export Informatica Data Vault Metadata Job
The Export Informatica Data Vault Metadata job exports metadata files, including run-time files, a log file, and 
a .tar file, to a directory that you specify. Run the job during the application migration process, when you want 
to migrate a retired application from a source (pre-production) environment to a target (production) 
environment. For more information about the application migration process, see the chapter "Creating 
Retirement Archive Projects."

Provide the following information to run this job:
Source IDV Folder Name 

Required. Name of the source Data Vault archive folder that you want to migrate.

Target File Archive Data Directory 

Required. Full path of the location in the target Data Vault system that stores the SCT data files.

Export File Directory 

Required. Full path of the temporary directory on the source Data Archive system that stores the run-time files, 
the log file, and the .tar file. This directory must be accessible to the source Data Archive system.

Staging Directory for Target External Storage 

Optional for a local file system. Required when the -n directory is an external storage directory. Full path of 
the location in the target external storage system that stores the SCT data files that you want to import to the 
external storage system.

Target to Use Same Storage as Source 

Required. If you select Yes, the job keeps the original SCT data file location.

Copy Data Files to Export File Directory 

Required. If you select yes, the SCT files are copied to export file directory along with the run-time files, log 
file, and .tar file.

Export Materialized View Statements 

Required. If you select yes, any materialized view statements on the source will be exported during the job run. 
When you run the Import Informatica Data Vault Metadata job later in the process, the materialized views will 
be recreated on the target.
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Data Vault Loader Job
When you publish an archive project to archive data to the Data Vault, Data Archive moves the data to the 
staging directory during the Copy to Destination step. You must run the Data Vault Loader standalone job to 
complete the move to the Data Vault. The Data Vault Loader job executes the following tasks:

• Creates tables in the Data Vault.

• Registers the Data Vault tables.

• Copies data from the staging directory to the Data Vault files.

• Registers the Data Vault files.

• Collects row counts if you enabled the row count report for the Copy to Destination step in the archive 
project.

• Deletes the staging files.

• Generates a row count report and a row count summary report accessible under the Job ID on the Monitor 
Jobs page. The row count report lists each entity loaded to the Data Vault by archive job ID, along with the 
tables for each entity and row counts in the source database and the Data Vault archive folder. The report 
also lists any discrepancies. The row count summary report is a summary of the Data Vault Loader job, 
and lists each table loaded to the Data Vault along with their source row count, Data Vault archive folder 
row count, and any discrepancies.

Provide the following information to run this job:

• Archive Job ID. Job ID generated after you publish an archive project. Locate the archive job ID from the 
Monitor Job page.

Note: Data Vault supports a maximum of 4093 columns in a table. If the Data Vault Loader tries to load a 
table with more than 4093 columns, the job fails.

IBM DB2 Bind Package

Use the DB2 Bind Package standalone job to bind packages. You must bind packages on the source before 
you can use DataDirect JDBC drivers to connect to IBM DB2 sources.

Provide the following information to run this job:

• DB2 Host Address. Name or IP address of the server that hosts the IBM DB2 source.

• DB2 Port Number. Port number of the server that hosts the IBM DB2 source.

• DB2 Location / Database Name. Location or name of the database.

• User ID. User that logs in to the database and runs the bind process on the source. Choose a user that has 
the required authorizations.

• User Password. Password for the user ID.

Import Informatica Data Vault Metadata Job
Run the Import Informatica Data Vault Metadata job as part of the application migration process. The job 
imports metadata to the target Data Vault instance and registers the SCT files. For more information about 
the application migration process, see the "Creating Retirement Archive Projects" chapter.

Provide the following information to run this job:
Target IDV Connection 

Required. The connection that links to the target Data Vault instance.
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Export IDV Metadata Job ID and IDV Folder Name 

The Export Data Vault Metadata job ID (from the source Data Archive environment) and the Data Vaualt folder 
name that you want to migrate to the target Data Vault.

TAR Archive File Directory 

Required. The directory of the .tar file exported by the Export Informatica Data Vault Metadata job. This 
directory must be accessible to the target Data Archive instance.

Load External Attachments
Use the Load External Attachments standalone job to archive external attachments. When you run the job, the 
job reads the attachments from the directory you specify in the job parameters. The job archives records 
from the directory and all subdirectories within the directory. The job creates BCP files and loads the 
attachments to the AM_ATTACHMENTS table in the Data Vault

The job creates an application module in EDM, called EXTERNAL_ATTACHMENTS. Under the application 
module, the job creates an entity and includes the AM_ATTACHMENTS table. You specify the entity in the job 
parameters. The entity allows you to use Browse Data to view the external attachments in Data Discovery 
without a stylesheet.

After you run the job, assign a Data Vault access role to the entity. Then, assign users to the Data Vault 
access role. Only users that have the same role assignment as the entity can use Browse Data to view the 
attachments in Data Discovery. A stylesheet is still required to view attachments in the App View.

You can run the job for attachments that you did not archive yet or for attachments that you archived in a 
previous release. You may want to run the job for attachments that you archived in a previous release to use 
Browse Data to view the attachments in Data Discovery.

If the external attachments you want to load have special characters in the file name, you must configure the 
LANG and LC_ALL Java environment variables on the operating system where the ILM application server 
runs. Set the LANG and LC_ALL variables to the locale appropriate to the special characters. For example, if 
the file names contain United States English characters, set the variables to en_US.utf-8. Then restart the 
ILM application server and resubmit the standalone job.

Note: You cannot load files that are larger than 2 GB into Data Vault.

Load External Attachments Job Parameters
Each standalone job requires program-specific parameters as input.

The following table describes the job parameters for the Load External Attachments job:

Parameter Description

Directory Directory that contains the attachments you want to archive.
For upgrades, choose a directory that does not contain any files.

Attachment 
Entity Name

Entity name that the job creates. You can change the default to any name. If the entity already 
exists, the job does not create another entity.
Default is AM_ATTACHMENT_ENTITY.
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Parameter Description

Target Archive 
Store

Data Vault destination where you want to load the external attachments. Choose the 
corresponding archive target connection.
For upgrades, choose the target destination where you archived the attachments to.

Purge After Load Determines whether the job deletes the attachments from the directory that you provide as the 
source directory.
- Yes. Deletes attachments from the directory.
- No. Keeps the attachments in the directory. You may want to select no if you plan to manually 

delete the attachments after you run the standalone job.

Migrate Data Archive Metadata Job
The Migrate Data Archive Metadata standalone job migrates the Data Archive metadata, including source 
connections, target Data Vault connection, roles, application and data model metadata, labels, retention, and 
more to the ILM repository of the target Data Archive system. Run the job during the application migration 
process. For more information about the application migration process, see the chapter "Creating Retirement 
Archive Projects."

Provide the following information to run this job:
Target Metadata Repository 

Required. Name of the target ILM repository connection.

Product Family Version 

Required. The product family version/application version that you want to migrate.

Copy Users and Roles 

Required. If you select no, the job migrates only the retirement entity-related roles. If you select yes, the job 
migrates users related to the retirement entity-related roles, in addition to other roles related to the users.

Migrate Export Migration Status Table Only 

Required. If you select yes, the job migrates only the export migration status table.

Note: If SSL is not enabled in the preproduction environment but is enabled in the production environment, 
you must manually update the nucleus.ini file of the production environment Data Archive Data Vault plugin 
in the preproduction to production migration job.

Move External Attachments
The Move External Attachments job moves external attachments along with their records during an archive or 
restore job. Run the Move External Attachments job only if all the following conditions apply:

• You enabled Move Attachments in Synchronous Mode on the Create or Edit an Archive Source page.

• The entities support external attachments.

Provide the following information to run this job:

• Add on URL. URL to the Data Vault Service for external attachments.

• Archive Job ID. Job ID generated after you publish an archive project. Locate the archive job ID from the 
Monitor Job page.
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Purge Expired Records Job
The Purge Expired Records job purges records that are eligible for purge from the Data Vault. A record is 
eligible for purge when the retention policy associated with the record has expired and the record is not under 
legal hold. Create and assign retention policies before you run the Purge Expired Records job.

Run the Purge Expired Records job to perform one of the following tasks:

• Generate the Retention Expiration report. The report shows the number of records that are eligible for 
purge in each table. When you schedule the purge expired records job, you can configure the job to 
generate the retention expiration report, but not purge the expired records.

• Generate the Retention Expiration report and purge the expired records. When you schedule the purge 
expired records job, you can configure the job to pause after the report is generated. You can review the 
expiration report. Then, you can resume the job to purge the eligible records.

When you run the Purge Expired Records job, by default, the job searches all entities in the Data Vault archive 
folder for records that are eligible for purge. To narrow the scope of the search, you can specify a single 
entity. The Purge Expired Records job searches for records in the specified entity alone, which potentially 
decreases the amount of time in the search stage of the purge process.

To determine the number of rows in each table that are eligible for purge, generate the detailed or summary 
version of the Retention Expiration report. To generate the report, select a date for Data Archive to base the 
report on. If you select a past date or the current date, Data Archive generates a list of tables with the number 
of records that are eligible for purge on that date. You can pause the job to review the report and then 
schedule the job to purge the records. If you resume the job and continue to the delete step, the job deletes 
all expired records up to the purge expiration date that you used to generate the report. If you provide a future 
date, Data Archive generates a list of tables with the number of records that will be eligible for purge by the 
future date. The job stops after it generates the report.

You can choose to generate one of the following types of reports:
Retention Expiration Detail Report

Lists the tables in the archive folder or, if you specified an entity, the entity. Shows the total number of 
rows in each table, the number of records with an expired retention policy, the number of records on 
legal hold, and the name of the legal hold group. The report lists tables by retention policy.

Retention Expiration Summary Report

Lists the tables in the archive folder or, if you specified an entity, the entity. Shows the total number of 
rows in each table, the number of records with an expired retention policy, the number of records on 
legal hold, and the name of the legal hold group. The report does not categorize the list by retention 
policy.

The reports are created with the Arial Unicode MS font. To generate the reports, you must have the font file 
ARIALUNI.TTF saved in the <Data Archive installation>\webapp\WEB-INF\classes directory.

To purge records, you must enable the purge step through the Purge Deleted Records parameter. You must 
also provide the name of the person who authorized the purge.

Note: Before you purge records, use the Search Within an Entity in Data Vault search option to review the 
records that the job will purge. Records that have an expired retention policy and are not on legal hold are 
eligible for purge.

When you run the Purge Expired Records job to purge records, Data Archive reorganizes the database 
partitions in the Data Vault, exports the data that it retains from each partition, and rebuilds the partitions. 
Based on the number of records, this process can increase the amount of time it takes for the Purge Expired 
Records job to run. After the Purge Expired Records job completes, you can no longer access or restore the 
records that the job purged.
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Note: If you purge records, the Purge Expired Records job requires staging space in the Data Vault that is 
equal to the size of the largest table in the archive folder, or, if you specified an entity, the entity.

Purge Expired Records Job Parameters
The following table describes the job parameters for the Purge Expired Records job:

Parameter Description Required or 
Optional

Archive Store The name of the archive folder in the Data Vault that contains the records that 
you want to delete.
Select a folder from the list.

Required.

Purge Expiry 
Date

The date that Data Archive uses to generate a list of records that are or will be 
eligible for delete.
Select a past, the current, or a future date.
If you select a past date or the current date, Data Archive generates a report 
with a list of all records eligible for delete on the selected date. You can pause 
the job to review the report and then schedule the job to purge the records. If 
you resume the job and continue to the delete step, the job deletes all expired 
records up to the selected date.
If you select a future date, Data Archive generates a report with a list of 
records that will be eligible for delete by the selected date. However, Data 
Archive does not give you the option to delete the records.

Required.

Report Type The type of report to generate when the job starts.
Select one of the following options:
- Detail. Generates the Retention Expiration Detail report.
- None. Does not generate a report.
- Summary. Generates the Retention Expiration Summary report.

Required.

Pause After 
Report

Determines whether the job pauses after Data Archive creates the report. If you 
pause the job, you must resume it to delete the eligible records.
Select Yes or No from the list.

Required.

Entity The name of the entity with related or unrelated tables in the Data Vault archive 
folder.
To narrow the scope of the search, select a single entity.

Optional.

Purge Deleted 
Records

Determines whether to delete the eligible records from the Data Vault.
Select Yes or No from the list.

Required.

Email ID for 
Report

Email address to which to send the report. Optional.

Purge Approved 
By

The name of the person who authorized the purge. Required if you 
select a past 
date or the 
current date for 
Purge Expiry 
Date.
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Reindex on Data Vault Job
The Reindex on Data Vault job runs the Delete Indexes on Data Vault and Create Indexes on Data Vault jobs 
back-to-back, so that you do not have to run the jobs separately.

When you run the Reindex on Data Vault job, you specify the Data Vault connection and archive folder that 
you want to reindex. You can also choose to reindex all of the available Data Vault connections. You cannot 
run the reindex job on a folder if no indexes exist for the selected archive folder.

You might need to run the Reindex on Data Vault job if you update the legal hold on a row, or perform some 
operation that updates the row ID. When the row ID is updated in Data Vault, you can no longer see the details 
for the record in the Details pane when you perform a keyword search on the Data Vault. In this scenario, run 
the Reindex on Data Vault job to reindex the data so that you can view the record details in the search results.

If you upgrade from a previous version of Data Archive, Informatica recommends running the Reindex on 
Data Vault job on all connections.

Provide the following information to run this job:

Destination Repository 

The Data Vault connection configured to the specific archive folder that you want to re-index on. Choose 
either the specific connection or "all connections" to reindex on all available Data Vault connections.

Refresh Materialized Views Job
The refresh materialized views job refreshes selected materialized views that exist in the Data Vault. To run 
the refresh materialized views job, select the job from the standalone programs list. Then define the job 
parameters and schedule the job.

Provide the following information to run the job:
Destination Repository 

Archive folder in the Data Vault where you retired the application data. Click the list of values button and 
select from the available folders.

Schema 

Name of the retired schema.

Entity 

Name of the entity that contains the view or views you want to refresh.This field is optional.

Refresh All Views 

Determines whether to refresh all of the materialized views. If you do not know the entity or name of the view 
you need to refresh, click the list of values button and select Yes. If you select No, you must provide the entity 
or the name of the view you want to refresh.

View 

Name of view you want to refresh. Click the list of values button and select the view. This field is optional.

Refresh MongoDB Schema Job
The Refresh Schema for MongoDB standalone job refreshes the MongoDB metadata in the local embedded 
driver database. If the MongoDB metadata has changed since the creation of the source, the Refresh Schema 
for MongoDB standalone job is required.

To run the Refresh Schema for MongoDB standalone job, provide the following information:
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Repository Name

Name of the MongoDB Source connection.

Refresh Schema for Salesforce Job
The Refresh Schema for Salesforce standalone job refreshes the Salesforce metadata in the local embedded 
driver database and is required if the Salesforce metadata has changed since the creation of the source 
connection. For example, an object might be added to the Salesforce organization after the source 
connection was created. For more information, see the chapter "Salesforce Archiving."

Provide the following information to run this job:

Repository Name 

Name of the Salesforce source connection.

Restore External Attachments from Archive Folder
The Restore External Attachments from Archive Folder job restores external attachments from the Data 
Vault.

Provide the following information to run this job:

Job ID 

Job ID of the Archive Structured Digital Records job. Locate the job ID from the Monitor Job page.

Override Existing Files 

Specifies whether the job will restore the external attachments when an attachment with the same name 
already exists in the source directory.

If you select Yes, the job restores the external attachments from Data Vault even if an attachment or 
attachments with the same name exists in the source directory.

If you select No, the job will error out if any attachment selected for restore has the same name as an 
attachment already in the source directory.

Default is No.

Purge After Restore 

Specifies whether the job purges the attachments from the Data Vault after the job restores them.

Select Yes or No. Default is No.

Pause After Restore 

Specifies whether the job pauses after the step "Restore External Attachments from Archive Folder" completes 
successfully.

If you select Yes, the job pauses after the "Restore External Attachments from Archive Folder" step, so that 
you can validate that all of the attachments have been restored to the source directory.

If you select No, the job proceeds to the "Purge External Attachments from Archive Folder" step without 
pausing after the restore step.

Default is No.
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Sync with LDAP Server Job
The Sync with LDAP Server job synchronizes users between the LDAP directory service and Data Archive. Use 
the job to create users in Data Archive. Run the job when you initially set up LDAP authentication and after 
you create additional users in the LDAP directory service.

If you enable LDAP authentication, you must create and maintain users in the LDAP directory service and use 
the job to create user accounts in Data Archive. Run the job once for each group base that you want to 
synchronize.

When you run the job, the job uses the LDAP properties that are configured in the conf.properties file to 
connect to the LDAP directory service. If you specify the group base and the group filter in the job 
parameters, the job finds all of the users within the group and any nested groups. The job compares the 
users to users in Data Archive. If a user is in the group, but not in Data Archive, then the job creates a user 
account in Data Archive.

If you enabled role assignment synchronization, the job checks the security groups that the user is assigned 
to, including nested groups. The job matches the security group names to the names of the system-defined 
or Data Vault access role names. If the names are the same, the job adds the role to the user account in Data 
Archive. Data Archive automatically synchronizes any subsequent changes to security group assignments 
when users log in to Data Archive.

After the job creates users in Data Archive, any additional changes to users in the LDAP directory service are 
automatically synchronized when users log in to Data Archive. For example, if you change user properties, 
such as email addresses, or role assignments.

Sync with LDAP Server Job Parameters
When you configure the job parameters for the Sync with LDAP Server job, you specify how Data Archive 
synchronizes users from the LDAP directory service. You configure the connection properties to connect to 
the LDAP directory service and filter criteria to determine which users you want to synchronize.

The Sync with LDAP Server job includes the following parameters:
LDAP System

Type of LDAP directory service.

Use one of the following options:

• Active Directory

• Sun LDAP

Host of LDAP Server

The IP address or DNS name of the machine that hosts the LDAP directory service.

For example, ldap.mycompany.com.

Port of LDAP Server

The port on the machine where the LDAP directory service runs.

For example, 389.

User

User that logs in to the LDAP directory service. You can use the administrator user. Or, you can use any 
user that has privileges to access and read all of the LDAP directories and privileges to complete basic 
filtering.

For example, corpid@domain.com.
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Password

Password for the user.

Search Base

The search base where the LDAP definition starts before running the filter.

For example, dc=mycompany,dc=com

User Filter

A simple or complex filter that enables Data Archive to identify individual users in the LDAP security 
group.

For example, you might use one of the following filters:

• objectClass=inetOrgPerson
• objectClass=Person
• objectClass=* where * indicates that all entries in the LDAP security group should be treated as 

individual users.

Group Base

Optional. Sets the base entry in the LDAP tree where you can select which groups you want to use to 
filter users from the user filter.

If you do not specify a group base, then the job synchronizes all users in the LDAP directory service.

For example, OU=Application Access,OU=Groups,DC=mycompany,DC=com.

Group Filter

Optional. Determines which groups are selected. After the user filter returns the result set to the 
application, those users are compared to users in the selected groups only. Then, only true matches are 
added to Data Archive.

For example, cn=ILM.

Parameter Usage

Data Archive uses the following parameter combinations to fetch the list of users from the LDAP server:

Search Base and User Filter

or

Group Base and Group Filter

If you include values for both parameters, the Group Base and Group Filter combination takes precedence. If 
one of the parameters is empty, the Search Base and User Filter combination takes precedence.

Test Email Server Configuration Job
Run the Test Email Server Configuration job to verify that Data Archive can connect to the mail server. Run 
the job after you define the mail server properties in the system profile. After you verify the connection, you 
can configure email notifications when you schedule jobs or projects.

When you run the Test Email Server Configuration job, the job uses the mail server properties defined in the 
system profile to connect to the mail server. If the connection is successful, the job sends an email to the 
email address that you specify in the job parameters. Data Archive sends the email from the mail server user 
address defined in the system properties. If the connection is not successful, you can find an error message 
in the job log stating that the mail server connection failed.
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Email recipient security is determined by the mail server policies defined by your organization. You can enter 
any email address that the mail server supports as a recipient. For example, if company policy allows you to 
send emails only within the organization, you can enter any email address within the organization. You 
cannot send email to addresses at external mail servers.

Test JDBC Connectivity
The Test JDBC Connectivity job connects to a repository and maintains the connection for a specified time 
period. If your connection to a repository intermittently drops, run the Test JDBC Connectivity job to 
troubleshoot the connection.

Provide the following information to run this job:

• Connection Retention Time. The length of time the Test JDBC Connectivity job maintains a connection to 
the repository.

• Repository Name. Source or target database.

Test Scheduler
The Test Scheduler job checks whether the inbuilt scheduler is up and running. You can run this job at 
anytime.

Scheduling Jobs
To schedule a standalone job, select the type of job you want to run and enter the relevant parameters.

1. Click Jobs > Schedule a Job. 

2. Choose Projects or Standalone Programs and click Add Item. 

The Select Definitions window appears with a list of all available jobs.

3. Optionally, to filter the list of jobs, select Program Type and enter the name of a program in the adjacent 
text field. For example, type Data Vault in the text field to limit the list to Data Vault jobs. 

4. Select the job you want to run. Repeat this step to schedule more than one job. 

5. Enter the relevant job parameters. 

6. Schedule the job to run immediately or on a certain day and time. Choose a recurrence option if you want 
the job to repeat in the future. 

7. Enter an email address to receive notification when the job completes, terminates, or returns an error. 

8. Click Schedule. 

Job Logs
Data Archive creates job logs when you run a job. The log summarizes the actions the job performs and 
includes any warning or error messages.

You access the job log when you monitor the job status. For archive and retirement jobs, the jobs include a 
log for each step of the archive cycle. Expand the step to view the log. When you expand the step, you can 
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view a summary of the job log for that step. The summary includes the last few lines of the job log. You can 
open the full log in a separate window or download a PDF of the log.

Delete From Source Step Log
For archive jobs, the log for the delete from source step includes information on the tables the job deletes 
records from and how many rows the job deletes from the tables.

For Oracle sources, the job log includes a real-time status of record deletion. You can use the real-time status 
to monitor the job progress. For example, to determine the amount of time that the job needs to complete the 
record deletion.

The real-time status is available when the following conditions are true:

• The source is an Oracle database.

• The entity tables include primary key constraints.

• The source connection uses staging and uses the Oracle row ID for deletion.

• The source connection does not use Oracle parallel DML for deletion.

The log includes the number of parallel threads that the job creates and the total number of rows that the job 
needs to delete for each table. The log includes a real-time status of record deletion for each thread. The job 
writes a message to the log after each time a thread commits rows to the database. The log displays the 
thread number that issued the commit and the number of rows the thread deleted in the current commit. The 
log also displays the total number of rows the thread deleted in all commits and the number of rows that the 
thread must delete in total. The log shows when each thread starts, pauses, resumes, and completes.

Monitoring Jobs
Current jobs can be viewed from Jobs > Monitor Jobs and future jobs can be viewed from Jobs > Manage 
Jobs.

The Monitor Jobs page lists jobs with their ID, status, user, items to execute, start date and time, and 
completion date and time.

A job can have one of the following values for status:

• Completed

• Error

• Not Executed

• Not Started

• Paused

• Pending

• Running

• Terminated

• Terminating

• Validated

• Warning

Jobs can be displayed in detail through expand and collapse options.
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Click the job name, wherever an arrow button appears to the left of it, to display logging information of a 
particular job. The last few lines from the logging information are displayed inline. To change the number of 
lines for the display, select a value from the combo box, for “view lines.” Click the View Full Screen to display 
the entire log in a new window. View Log, Summary Report or Simulation Report displays relevant reports as 
PDF files.

Options are also available to resume and terminate a job. To terminate a job, click Terminate Job and to 
resume a job, click Resume Job. Jobs can be resumed if interrupted either by the user or due to external 
reasons like power failure. When a job corresponding to a Data Archive project errors out, you should 
terminate that Job before scheduling the same project.

To refresh the status of a job, select Auto Refresh Job Status.

Pausing Jobs
You can pause archive jobs during specific steps of the archive job. For example, you can pause the job at 
the delete from source step for Oracle sources. To pause the job from a specific step, open the status for the 
step. When you resume the job, the job starts at the point where it paused.

For SAP retirement projects, Data Archive extracts data from special SAP tables as packages. When you 
resume the job, the job resumes the data extraction process, starting from the point after the last package 
was successfully extracted.

Delete From Source Step
You can pause and resume an archive job when the job deletes records from Oracle sources.

You can pause and resume an archive job during the delete from source step when the following conditions 
are true:

• The source is an Oracle database.

• The entity tables include primary key constraints.

• The source connection uses staging and uses the Oracle row ID for deletion.

• The source connection does not use Oracle parallel DML for deletion.

You may want to pause a job during the delete from source step if you delete from a production system and 
you only have a limited amount of time that you can access the system. If the job does not complete within 
the access time, you can pause the job and resume it the next time you have access.

When the job pauses depends on the delete commit interval and the degree of parallelism configuration for 
the archive source. The pause occurs at the number of threads multiplied by the commit interval. When you 
pause the job, each thread completes the number of rows in the current commit and then pauses. The job 
pauses after all threads complete the current number of rows in the commit interval.

For example, if you configure the source to use a delete commit interval of 30,000 and two delete parallel 
threads, then the job pauses after the job deletes 60,000 rows. The job writes a message to the log that the 
threads are paused.

You can pause the job when you monitor the job status. When you expand the delete from source step, you 
can click on a link to pause the job. You can resume the job from the step level or at the job level. When you 
resume the job, the job continues at the point from which you paused the job. The log indicates when the 
threads pause and resume.
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Searching Jobs
To search jobs, you can conduct a quick search or an advanced search facility.

Quick Search
The generated results in quick search are filtered for the currently logged-in user.

The following table describes the quick search parameters:

Search Option Description

My Previous Error / Paused Job Last Job that raised an Error or was Paused.

All My Yesterday’s Jobs All Jobs that were scheduled for the previous day.

All my Error Jobs All Jobs that were terminated due to an Error.

All my Paused Jobs All Jobs that were Paused by the currently logged-in user.

Search For A drop down list is available here, to search Jobs by their Job ID, Job Name, 
or Project name.

Advanced Search
Advanced Search is available for the following parameters, each of which is accompanied by a drop down list 
containing “Equals” and “Does not Equal”, to include or exclude values specified for each parameter.

The following table describes the advanced search parameters:

Search Option Description

Submitted By Include or exclude a User who submitted a particular job.

Project/Program When you search for a project, you can also specify a stage in the data archive job 
execution, for example, Generate Candidates.

Start Date Include or exclude a Start Date for the Jobs.

Completion Date Include or exclude a Completion Date for the Jobs.

Status Include or exclude a particular Status for Jobs.

Troubleshooting Jobs
During application migration on the pre-production environment, the Export Informatica Data Vault Metadata job fails 
when Dynamic Data Masking is enabled in the respective target connection.

When you run the Export Informatica Data Vault Metadata job, change the target connection port and 
host to the Data Vault port and host details in the nucleus.ini file in the plugin path: webapp/
file_archive
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C h a p t e r  5

Viewing the Dashboard
This chapter includes the following topics:

• Viewing the Dashboard Overview, 49

• Scheduling a Job for DGA_DATA_COLLECTION, 50

Viewing the Dashboard Overview
The dashboard is a point of reference for repositories configured on Data Archive. This can be accessed from 
Administration > Dashboard.

All repositories are displayed in a list, with information such as the database size (in GB), and the date it was 
last analyzed.

After the DGA_DATA_COLLECTION job is complete, the dashboard reflects an entry for the respective 
database as shown in the following figure.

Click the Repository link to view the graphical representation of Modules, Tablespaces, and Modules Trend.

Note: To view information about a repository in the dashboard, you must run the DGA_DATA_COLLECTION 
standalone program from the Schedule Job page (against that repository).
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Scheduling a Job for DGA_DATA_COLLECTION
To run DGA_DATA_COLLECTION:

1. Click Jobs > Schedule a Job. 

The following page appears on the screen:

2. In the Projects/Programs to Execute area, select Standalone Programs. 

3. Click Add Items. 

The following pop-up window appears on the screen:
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4. Select DGA_DATA_COLLECTION, and click Select. 

The DGA_DATA_COLLECTION section appears on the page as shown in the following figure:

5. Select the Source Repository by clicking the LOV button to select from the LOVs. 

6. Specify schedule time as Immediate from the Schedule section. 

7. Setup notification information such as Email ID for messages on completion of certain events 
(Completed, Terminated, and Error). 

8. Click Schedule to run the DGA_DATA_COLLECTON job. 
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C h a p t e r  6

Creating Data Archive Projects
This chapter includes the following topics:

• Setting Up Data Archive Projects, 52

• Viewing and Editing Data Archive Projects, 60

• Running the Data Vault Loader Job, 60

• Troubleshooting Data Archive Projects, 62

Setting Up Data Archive Projects
Transaction data can be archived either to a database archive or the Data Vault. Data Archive relies on 
metadata to define Data Archive transactions.

An archive project contains the following information:

• Source and target repository for the data. If you archive to a database, the source database and the target 
database must be the same type.

• The project action, which specifies whether to retain the data in the source database after archiving.

The following table describes the project actions:

Action Description

Archive Only Data is extracted from the source repository and loaded into the target repository.

Purge Only Data is extracted from the source repository and removed from the source repository.

Archive and Purge Data is extracted from the source repository, loaded into the target repository, and data is 
removed from the source repository.

• Specification of entities from the source data and imposition of relevant retention policies defined earlier.

• Configuration of different phases in the archival process and reporting information.

To view archive projects, select Workbench > Manage Archive Projects. To create an archive project, click 
New Archive Project in the Manage Archive Projects page.

The following page appears:
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Specifying Project Basics
As a first step to archiving, the information to be specified is described in the following tables.

General Information

Field Description

Project Name A name for a Data Archive project is mandatory.

Description A description is desirable.

Action A mandatory value for Data Archive Action can be Archive Only, Purge Only, and 
Archive and Purge.

Source

Field Description

Connection name Source connection that you want to archive from. This field is mandatory.

Analyze Interim Oracle sources only. Determines when the interim table is analyzed for table structure 
and data insertion.
- After Insert. Analyzer runs after the interim table is populated.
- After Insert and Update. Analyzer runs after the interim table is populated and 

updated.
- After Update. Analyzer runs after the interim table is updated.
- None. Analyzer does not run at all.
Default is After Insert and Update. To optimize performance for best results, use the 
default value.
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Field Description

Delete Commit Interval Number of rows per thread that the archive job deletes before the job issues a commit 
to the database.
Default is 30,000. Performance is typically optimized within the range of 10,000 to 
30,000. Performance may be impacted if you change the default value. The value you 
configure depends on several variables such as the number of rows to delete and the 
table sizes.
Use the following rules and guidelines when you configure the commit interval:
- If you configure an Oracle source connection to use Oracle parallel DML for deletion, 

the archive job creates a staging table that contains the row IDs for each commit 
interval. The archive job truncates the table and reinserts rows for each commit 
interval. Populating the staging table multiple times can decrease performance. To 
increase performance, configure the commit interval to either zero or a very high 
amount, such as 1,000,000, to generate a single commit.

- If you pause the archive job when the job deletes from Oracle sources, the commit 
interval affects the amount of time that the job takes to pause. The job pauses after 
all threads commit the active transaction.

- As the commit interval decreases, the performance may decrease. The amount of 
messages that the job writes to the log increases. The amount of time that the 
archive job takes to pause decreases.

- As the commit interval increases, performance may increase. The amount of 
messages that the job writes to the log decreases. The amount of time that the 
archive job takes to pause increases.

Insert Commit Interval Number of database insert transactions after which a commit point should be created. 
Commit interval is applicable when the archive job uses JDBC for data movement.
If your source data contains the Decfloat data type, set the value to 1.

Delete Degree of Parallelism Number of concurrent threads that are available for parallel deletion. The number of 
rows to delete for each table is equally distributed across the threads.
Default is 1.

Insert Degree of Parallelism The number of concurrent threads for parallel insertions.
When the Oracle Degree of Parallelism for Insert is set to more than ‘1’, the java 
parallel insert of tables is not used.

Update Degree of 
Parallelism

The number of concurrent threads for parallel updates.

Reference Data Store 
Connection

Required when you use the history database as the source and you only want to purge 
from the history database.
Connection that contains the original source reference data for the records that you 
archived to the history database. The source includes reference data that may not 
exist in the history database. The archive job may need to access the reference data 
when the job purges from the history database.

Target
When you create an archive project, you choose the target connection and configure how the job archives 
data to the target. You can archive to the Data Vault or to another database.

Archive to the Data Vault to reduce storage requirements and to access the archived data from reporting 
tools, such as the Data Discovery portal. Archive to another database to provide seamless data access to the 
archived data from the original source application.
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For archive jobs that include archive only and archive and purge cycles, the system validates that the 
connections point to different databases. If you use the same database for the source and target 
connections, the source data may be duplicated or deleted.

The following table describes properties for Data Vault targets:

Property Description

Connection Name List of target connections. The target connection includes details on how the archive 
job connects to the target database and how the archive job processes data for the 
target.
Choose the Data Vault target that you want to archive data to. This field is mandatory.

Include Reference Data Select this option if you want the archive project to include transactional and reference 
data from ERP tables.

Reference Data Store 
Connection

Required when you use a history database as the source.
Connection that contains the original source reference data for the records that you 
archived to the history database. The source includes reference data that may not 
exist in the history database. The archive job may need to access the reference data 
when the job archives or purges from the history database.

Enable Data Encryption Select this option to enable data encryption on the compressed Data Vault files during 
load. If you select this option, you must also choose to use a random key generator 
provided by Informatica or your choice of a third-party key generator to create an 
encryption key. Data Archive stores the encrypted key in the ILM repository as a hidden 
table attribute. When you run the archive definition, the key is passed to Data Vault as 
a job parameter and is not stored in Data Vault or any log file. The encrypted key is 
unique to the archive definition and is generated only once for a definition. If you run 
an archive definition more than once, the same encryption key is used.
If you have enabled data encryption for both the selected target connection and the 
archive definition, Data Archive uses the archive definition encryption details. If you do 
not configure data encryption at the definition level, then the job uses the details 
provided at the target connection level.

Use Random Key Generator Option to use a random key generator provided by Informatica when data encryption is 
enabled. When you select this option, the encryption key is generated by a random key 
generator provided by Informatica (javax.crypto.KeyGenerator).

Use Third Party Option to use a third-party key generator when data encryption is enabled. If you select 
this option, you must configure the property "informia.encryptionkey.command" in the 
conf.properties file. Provide the command to run the third-party key generator.

The following table describes properties for database targets:

Property Description

Connection name List of target connections. The target connection includes details on how the archive 
job connects to the target database and how the archive job processes data for the 
target.
Choose the database target that you want to archive data to.

Seamless Access Required Select this option if you want to archive to a database repository at the same time as 
you archive to the Data Vault server.
Allows seamless access to both production and archived data.
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Property Description

Seamless Access Data 
Repository

Repository that stores the views that are required for enabling seamless data access.

Commit Interval (For Insert) Number of database insert transactions after which the archive job creates a commit 
point.

Parallelism Degree (Delete) Number of concurrent threads for parallel deletions.

Parallelism Degree (Insert) Number of concurrent threads for parallel insertions.

The available fields depend on the type of archive cycle you select. After you configure the target, you can 
continue to configure the project details or save the project.

Click Next to add entities to the project.

Click Save Draft to save a draft of the project. You can edit the project and complete the rest of the 
configuration at a later time.

Specifying Entities, Retention Policies, Roles, and Report Types
The Entities section allows you to specify entities and related information such as retention policies and 
roles when the target database is the Data Vault.

Note: If your source database is Oracle, you can archive tables that contain up to 998 columns.

Click Add Entity. A popup window displays available entities in the source database for selection.

On selecting the desired entity and clicking Select, a new entity is added to the Data Archive definition as 
shown in the following figure, based on the Data Archive action selected.
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Parameter Description

Candidate 
Generation 
Report Type

Determines the report that the project generates during the candidate generation step.
- Summary: The report lists counts of purgeable and non-purgeable records for each entity, and 

counts of non-purgeable records by exception type.
A record marked for archiving is considered as purgeable. An exception occurs when purging a record 
causes a business rule validation to fail.
- Detail: In addition to the summary report content, if records belong to related entities, this report 

contains information about each exception.
- Summary Exclude Non Exceptions: Similar to detail, the report contains detailed information where 

an exception did not occur.
- None: No report is generated.

Enabled Determines whether to exclude the entity from archiving. Disable to exclude the entity from archiving. 
Default is enabled.

Policy When the target is the Data Vault, displays a list of retention policies that you can select for the 
entity. You can select any retention policy that has general retention. You can select a retention 
policy with column level retention if the table and column exist within the entity. The retention policy 
list appends the table and column name to the names of retention policies with column level 
associations. If you do not select a retention policy, the records in the entity do not expire.
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Parameter Description

Role Data Vault access role for the archive project if the target is the Data Vault. The access role 
determines who can view data from Data Discovery searches.
If you assign an access role to an archive or retirement project, then access is restricted by the 
access role that is assigned to the project. Data Discovery does not enforce access from the access 
roles that are assigned to the entity within the project. Only users that have the Data Discovery role 
and the access role that is assigned to the project can access the archive data.
If you do not assign an access role to an archive or retirement project, then access is restricted by 
the access role that is assigned to the entity in the project. Only users that have the Data Discovery 
role and the access role that is assigned to the entity can access the archive data.

Operators 
and Values

Depending on the list of values that were specified for columns in tables belonging to the entity, a list 
of operators is displayed, whose values must be defined.

Configuring Data Archive Run
The last step in the Data Archive Project is to configure a Data Archive run. The following page appears on 
your screen:

Internally, during Data Archive job execution, data is not directly copied from data source to data target. 
Instead, a staging schema and interim (temporary) tables are used to ensure that archivable data and 
associated table structures are sufficiently validated during Archive and Purge.

The following steps are involved in the process:

• Generate Candidates. Generates interim tables based on entities and constraints specified in the previous 
step.

• Build Staging. Builds the table structure in the staging schema for archivable data.

• Copy to Staging. Copies the archivable rows from source to the staging tablespace.
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• Validate Destination (when project type demands data archive). Validates table structure and data in the 
target in order to generate DML for modifying table structure and/or adding rows of data.

• Copy to Destination (when project type demands data archive). Copies data to the target. If your target is 
the Data Vault, this step moves data to the staging directory. To move the data from the staging directory 
to the Data Vault, run the Data Vault Loader job after you publish the archive project.

• Delete from Source (when project type demands data purge). Deletes data from source.

Note: If the source is Informix and you set the Delete Wait Time property, Data Archive waits for the 
specified time period after deleting each batch in a table and after deleting each table.

• Purge Staging. Deletes interim tables from the staging schema.

Gaps in Execution of Steps
After each stage in the archival process, Data Archive provides the user with an ability to pause. Relevant 
check boxes (for that step) can be selected under the Pause After column.

Generating Row Count Reports
To generate ROWCOUNT reports for certain Steps in the Data Archive job execution, select relevant check 
boxes under the column Row Count Report.

This report gives information on affected ROWS for all selected stages in the process. ROWCOUNT(s) will be 
logged for the Steps: Generate Candidates and Copy to Staging for this Data Archive job execution.

Note: Whenever a Row Count Report is requested for the Generate Candidates stage in Data Archive job 
execution, a Simulation Report will also be generated, with information for table Size, Average Row Size and 
Disk Savings for that particular Data Archive job execution.

Running Scripts
You can also specify JavaScripts or Procedures to run Before or After a particular stage under the Run Before 
and Run After columns.

Notification Emails
After selecting a check box under the Notify column, a notification email with relevant status information is 
sent to the user when the Data Archive process is aborted due to an Error or Termination event.

Order of Execution for Step 5 and 6
Towards the bottom of the page there is a combo box to specify the order of execution for Steps 5 and 6.

One of the following options can be selected:

• Run Step 5 first

• Run Step 6 first

• Run Steps 5 and 6 simultaneously

Note: While adding a Data Source, if the Use Staging option is disabled, then the stages: “Build Staging” and 
“Copy to Staging” will not be included in the Data Archive job execution.

The Project is saved and the Schedule Job page is displayed, when Publish & Schedule is clicked.

On the other hand, the Project gets listed in the Manage Data Archive Projects page when either Publish or 
Save Draft is clicked. From a user’s perspective, the former indicates that the Project is ready for scheduling, 
the latter means modifications are still required.
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Viewing and Editing Data Archive Projects
On publishing a Data Archive Project, a message indicating successful completion of the same is displayed 
at the beginning of the Manage Data Archive Projects page. A list of projects created so far follow.

Edit and Delete options are available.

Running the Data Vault Loader Job
If you selected the Data Vault as your target connection in the archive project, you must run the Data Vault 
Loader job to complete the archive process.

When you publish an archive project to archive data to the Data Vault, Data Archive moves the data to the 
staging directory during the Copy to Destination step. You must run the Data Vault Loader standalone job to 
complete the move to the Data Vault. The Data Vault Loader job executes the following tasks:

• Creates tables in the Data Vault.

• Registers the Data Vault tables.

• Copies data from the staging directory to the Data Vault files.

• Registers the Data Vault files.

• Collects row counts if you enabled the row count report for the Copy to Destination step in the archive 
project.

• Deletes the staging files.

• Generates a row count report and a row count summary report accessible under the Job ID on the Monitor 
Jobs page. The row count report lists each entity loaded to the Data Vault by archive job ID, along with the 
tables for each entity and row counts in the source database and the Data Vault archive folder. The report 
also lists any discrepancies. The row count summary report is a summary of the Data Vault Loader job, 
and lists each table loaded to the Data Vault along with their source row count, Data Vault archive folder 
row count, and any discrepancies.

Note: Data Vault supports a maximum of 4093 columns in a table. If the Data Vault Loader tries to load a 
table with more than 4093 columns, the job fails.

Run the Data Vault Loader Job
Run the Data Vault Loader Job to complete the process of archiving data to the Data Vault.

You will need the archive project ID to run the Data Vault Loader job. To get the archive project ID, click 
Workbench > Manage Archive Projects. The archive project ID appears in parenthesis next to the archive 
project name.

1. Click Jobs > Schedule a Job. 

2. Choose Standalone Programs and click Add Item. 

The Select Definitions window appears with a list of all available jobs.

3. Select Data Vault Loader. 

4. Click Select. 

The Data Vault Loader job parameter appears on the Schedule a Job page.

5. Enter the Archive Job ID. 
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You can locate the archive job ID from the Monitor Job page.

6. Click Schedule. 

Troubleshooting Data Vault Loader
Problems can occur at each step of the Data Vault Loader job. In addition, the Data Vault Loader job may 
have performance problems. If you encounter a problem, follow the troubleshooting tips in this section.

Collect Row Count Step
I cannot see the row count report.

Verify that you enabled the row count report for the Copy to Destination step in the archive project.

Create Tables Step
The Data Vault loader job fails at the create tables step.

Verify that the tables in each schema have different names. If two tables in different schemas have the same 
name, the job will fail.

Performance
For retirement projects, the Data Vault Loader process runs for days.

When you build retirement entities, do not use one entity for all of the source tables. If an entity includes a 
large number of tables, the Data Vault Loader may have memory issues. Create one entity for every 200-300 
tables in the source application.

You can use a wizard to automatically generate entities. Or, you can manually create entities if you want the 
entities to have special groupings, such as by function or size.

When you create entities with smaller amounts of tables, you receive the following benefits:

• The Data Vault Loader job performance increases.

• Reduces staging space requirement as the retirement project uses less staging space.

• You can resolve code page configuration issues earlier.

• You can start to validate data earlier with the Data Validation Option.

• Overall, provides better utilization of resources.

The Data Vault Loader job fails when Dynamic Data Masking connection details are used in the target connection.

Before you run the loader, change the target connection port in the nucleus.ini file in the plugin path: 
webapp/file_archive

Running the Data Vault Loader Job       61



Troubleshooting Data Archive Projects
Extraction fails with various Oracle errors.

The archive job fails due to known limitations of the Oracle JDBC drivers. Or, the archive job succeeds, 
but produces unexpected results. The following scenarios are example scenarios that occur due to 
Oracle JDBC driver limitations:

• You receive a java.sql.SQLException protocol violation exception.

• You receive an exception that OALL8 is in an inconsistent state.

• When you run an archive cycle for an entity with a Run Procedure step, an exception occurs due to an 
incomplete import. The job did not import the CLOB column, even though the job log shows that the 
column was imported successfully. The applimation.log includes an exception that an SQL 
statement is empty or null.

• The connection to an Oracle database fails.

• The Copy to Destination step shows an exception that the year is out of range.

• The select and insert job fails with an ORA-600 exception.

• The residual tables job fails with an ORA-00942 exception that a table or view does not exist.

To resolve the errors, use a different Oracle JDBC driver version. You can find additional Oracle JDBC 
drivers in the following directory:

<Data Archive installation directory>/optional

For more information, see Knowledge Base article 109857.

Extraction fails with out of memory or heap errors.

You may receive an out of memory error if several tables include LOB datatypes.

To resolve the errors, perform the following tasks:

• Lower the JDBC fetch size in the source connection properties. Use a range between 100-500.

• Reduce the number of Java threads in the conf.properties file for the 
informia.maxActiveAMThreads property. A general guideline is to use 2-3 threads per core.

Archive job runs for days.

To improve the archive job performance, perform the following tasks:

• Check for timestamp updates in the host:port/jsp/tqm.jsp or the BCP directory.

• Check for updates in table AM_JOB_STEP_THREADS in the ILM repository (AMHOME).

• For UNIX operating systems, run the following UNIX commands to see input, output, and CPU activity:

- sar -u 1 100
- iostat-m 1
- top
- ps -fu 'whoami' -H

• Use multiple web tiers to distribute the extraction.
To use multiple web tiers, perform the following steps:

1. Create a copy of the web tier.

2. Change the port in the conf.properties file.
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3. Start the web tier.

When I use multiple web tiers, I receive an error that the archive job did not find any archive folders.

Run the Data Vault Loader and Update Retention jobs on the same web tier where you ran the Create 
Archive Folder job.

The archive job fails because the process did not complete within the maximum amount of time.

You may receive an error that the process did not complete if the archive job uses IBM DB2 Connect 
utilities for data movement. When the archive job uses IBM DB2 Connect utilities to load data, the job 
waits for a response from the utility for each table that the utility processes. The archive job fails if the 
job does not receive a response within 3 hours.

Use the IBM DB2 trace files to locate the error.

The archive job fails at the Copy to Staging step with the following error: Abnormal end unit of work condition occurred.

The archive job fails if the source database is IBM DB2 and the data contains the Decfloat data type.

To resolve this issue, perform the following tasks:

1. Go to Workbench > Manage Archive Projects.

2. Click the edit icon for the archive project.

3. Set the Insert Commit Interval value to 1.

4. Complete the remaining steps in the archive project to archive the data.

The archive job fails at the Build Staging or Validate Destination step.

If the source database is Oracle and a table contains more than 998 columns, the archive job fails.

This issue occurs because of an Oracle database limitation on column number. Oracle supports a 
maximum number of 1000 columns in a table. The archive job adds two extra columns during execution. 
If the table contains more than 998 columns on the source database, the archive job fails because it 
cannot add any more columns.
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C h a p t e r  7

Salesforce Archiving
This chapter includes the following topics:

• Salesforce Archiving Overview, 64

• Step 1. Install the Salesforce Accelerator, 65

• Step 2. Configure Salesforce Permissions, 65

• Step 3. Import Salesforce Metadata and Configure Entities, 65

• Step 4. Create a Salesforce Source Connection, 66

• Step 5. Create the Salesforce Archive Project, 66

• Refresh Schema for Salesforce Standalone Job, 67

• Salesforce Limitations, 67

Salesforce Archiving Overview
You can archive data from Salesforce.com with the Data Archive Salesforce accelerator. After you archive 
data from Salesforce, you can use standard Data Archive features like compliance features, Data Discovery, 
and Data Visualization on the Salesforce data. Salesforce archiving does not support the restore 
functionality.

The Salesforce accelerator is licensed separately from Data Archive and you must install the accelerator 
after you install or upgrade Data Archive. After you install the accelerator, you might have to configure the 
startApplimation.bat/startApplimation.sh file or the internet browser to connect to Salesforce, if the ILM 
application server or the Enterprise Data Manager client is running behind a proxy server. For more 
information about proxy server settings, see the chapter "Starting Data Archive" in the Data Archive 
Administrator Guide. You must also configure certain permissions in the Salesforce profiles, users, and 
objects in order to archive or purge the data.

You can then import metadata from Salesforce through the Enterprise Data Manager and if necessary create 
custom Salesforce entities for archiving. The accelerator includes two standard entities, the Task and Event 
entities, that contain standard Salesforce tables that you might want to archive.

When you have configured the Salesforce entities that you want to archive, create a source connection to 
Salesforce in Data Archive and a target connection where the archived data will reside. Then you can 
configure the archive job and define the parameters for each entity before scheduling the job to run. When 
you define the parameters for the entities, you designate the Salesforce data to be archived. For example, you 
can archive data that was created before a certain date or created by a certain Salesforce user.
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After the data is archived, you can use features like legal hold, tagging, and retention on the archived data. 
You can also search for the data in the Data Discovery Portal if it is archived to the Data Vault, or run reports 
on the data with the Data Visualization feature.

If you are an Informatica Cloud customer, you can view the archived Data Vault data from the Salesforce user 
interface. For more information about viewing data archived in the Data Vault through the Salesforce user 
interface, see the H2L "Viewing Data Vault Data in Salesforce with Informatica Cloud."

Salesforce Archiving Process

To archive Salesforce data, complete the following tasks:

1. Install the Data Archive Salesforce accelerator.

2. Configure the Salesforce permissions that are required to archive and purge data.

3. In the Enterprise Data Manager, connect to Salesforce to import metadata from Salesforce and configure 
the archive entities and business rules.

4. In the Data Archive user interface, create a Salesforce source connection.

5. Create the archive project, and define the parameters for the entities included in the project. Schedule 
the project to run.

Step 1. Install the Salesforce Accelerator
Before you can archive data from Salesforce, you must install the Salesforce accelerator. The accelerator has 
a standalone installer that you run after you install or upgrade Data Archive.

For more information about installing the Salesforce accelerator, see the chapter "Salesforce Accelerator 
Installation" in the Data Archive Installation Guide.

Step 2. Configure Salesforce Permissions
Before you can archive or purge data from Salesforce, you must configure permissions in Salesforce for 
certain profiles, users, and objects.

For more information on configuring Salesforce permissions, see the "Salesforce Archiving Administrator 
Tasks" in the Data Archive Administrator Guide.

Step 3. Import Salesforce Metadata and Configure 
Entities

Connect to Salesforce in the Enterprise Data Manager to import Salesforce metadata and configure archive 
entities.

By default, the Salesforce application and an application version called "Sales" are visible in the Enterprise 
Data Manager application hierarchy. You can use the Sales application version to import metadata from 
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standard and custom tables, or you can create a new application version. The Salesforce accelerator installs 
two entities called Event and Task. These entities contain standard Salesforce tables that you might want to 
archive. For more information on the tables in the Event and Task entities and their relationships, see the 
"Salesforce Accelerator" chapter of the Enterprise Data Manager Guide.

Before you can configure entities, you must connect to Salesforce to import metadata from Salesforce, just 
as you would for any ERP or custom application. You enter Salesforce connection details, such as the 
Salesforce username, password, security token, and host URL. You also provide the name and (optionally) the 
location of a database created by the JDBC driver for internal use. Next, you select the schema from which to 
import the metadata. There are special considerations for extracting and importing metadata from child 
tables in Salesforce entities, due to circular relationships between the tables that make automatic entity 
creation impossible. For more information about importing Salesforce metadata and configuring entities, see 
the "Salesforce Accelerator" chapter of the Enterprise Data Manager Guide.

Step 4. Create a Salesforce Source Connection
To archive Salesforce data, create a Salesforce source connection in Data Archive.

When you create a Salesforce connection in Data Archive, you configure connection details and decide 
whether or not to include records that are archived in Salesforce.

Salesforce has an internal archive functionality that archives eligible records from Salesforce objects. You 
can choose to include these records archived by Salesforce in your archive job by selecting the Include 
Salesforce Archived Records check box in the source connection. If you do not select this check box when 
you configure the source connection, any records that have been archived by Salesforce are not archived with 
the rest of the data.

This feature is enabled by default for both task and event objects in Salesforce. If you want to archive or 
purge the Task and Event entities, you must select this check box in the source connection.

When you select the Include Salesforce Archived Records check box in the source connection, the driver gets 
the records that are archived by Salesforce in addition to the soft-deleted records. If you use the same 
connection to archive data from any custom entities, it is your responsibility to filter out the soft-deleted 
records by appending "IsDeleted=false" in the entity's select, insert and delete query.

For more information about configuring a Salesforce source connection, see the "Source Connections" 
chapter in the Data Archive Administrator Guide.

Step 5. Create the Salesforce Archive Project
After you have configured the entities that you want to archive, created a source connection, and designated 
or created a target connection, you can create the archive project and schedule it to run.

The process of creating a Salesforce archive project is the same as the process for archiving other 
applications. You name the project; select whether you want to archive, purge, or archive and purge the data; 
and select the Salesforce source connection that you created as well as a target connection.

When you identify the entities that you want to include in the archive project, you provide values for the entity 
parameters to identify the data that you want to archive. For example, you can archive all the data created 
before a certain date, or all of the data created by a certain Salesforce user. For more information about the 
entity parameters, see the "Salesforce Accelerator" chapter in the Enterprise Data Manager Guide.
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After you configure the parameters for the entities that you want to archive, you can configure the steps of 
the archive project and schedule it to run.

Refresh Schema for Salesforce Standalone Job
If necessary, you can run the Refresh Schema for Salesforce standalone job. The standalone job refreshes 
the Salesforce metadata in the local driver database and is required if the Salesforce metadata has changed 
since the creation of the source connection.

When you configure the source connection initially, all of the configuration files are created in the local driver 
database. If any metadata in Salesforce has changed, run the Refresh Schema for Salesforce standalone job. 
For example, after you create a Salesforce connection, a new Salesforce object might be added into the 
Salesforce organization. To add the metadata for the new object into the local database, run the Refresh 
Schema for Salesforce job.

For more information on configuring the Refresh Schema for Salesforce standalone job, see the "Scheduling 
Jobs" chapter of the Data Archive User Guide.

Salesforce Limitations
Archiving from Salesforce has the following known limitations:

1. Salesforce marks the "querybale" attribute to "false" for some of the objects. This means that external 
applications cannot query the object, so the Enterprise Data Manager cannot import metadata from 
these objects. For more information about importing metadata from Salesforce, see the chapter 
"Salesforce Accelerator" in the Enterprise Data Manager Guide.

2. Salesforce marks the "deletable" attribute to "false" for some of the objects. This means that external 
applications cannot delete the records in the object, so Data Archive cannot delete records from these 
objects.
The FeedPollChoice and FeedPollVote tables that are a part of the standard accelerator Task and Event 
entities have this limitation. The Task or Event entity does not delete the records from these tables. 
However, because of the cascade delete functionality in Salesforce, Salesforce deletes the records in 
these tables when Data Archive deletes the records in the parent table.

For more information about the FeedPollChoice and FeedPollVote tables, see the chapter "Salesforce 
Accelerator" in the Enterprise Data Manager Guide.

3. Salesforce does not allow triggers on objects to be updated through an API. Because of this Data 
Archive cannot deactivate or activate a trigger.

Workaround: You can use the Force.com Migration Tool, the Salesforce user interface, or the Force.com 
IDE to activate or deactivate a trigger.

4. The "Bookmark" information of a Feed Item in Salesforce cannot be archived, because bookmark 
information is not exposed in any Salesforce object.
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5. Salesforce will not allow you to execute the select query "select * from <object _name>" on some 
objects, like "CollaborationGroupRecord." Because of this the row count report cannot be generated for 
the entities with tables that have this limitation. The archive job will throw the following error at steps for 
which the row count report is enabled: "MALFORMED_QUERY: Implementation restriction: <object_name> 
requires a filter by a single Id….."

Workaround: Terminate the job, edit the archive project definition, disable the row count report in the 
steps, and schedule the job.

Note: The "ContentDocumentLink" object also has this limitation, but the row count select query is 
modified, so you can enable the row count report for the Task and Event entities.
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C h a p t e r  8

SAP Application Retirement
This chapter includes the following topics:

• SAP Application Retirement Overview, 69

• SAP Application Retirement Process, 69

• SAP Smart Retirement, 71

• Retirement Job, 74

• Attachment Retirement, 75

• Data Visualization Reports , 77

• Troubleshooting SAP Application Retirement, 85

SAP Application Retirement Overview
You can use Data Archive to retire SAP applications to the Data Vault. When you retire an SAP application, 
Data Archive retires all standard and custom tables in all of the installed languages and SAP clients. Data 
Archive also retires all attachments that are stored within the SAP database and in an external file system or 
storage system.

In SAP applications, you can use the Archive Development Kit (ADK) to archive data. When you archive within 
SAP, the system creates ADK files and stores the files in an external file system. When you retire an SAP 
application, you also retire data stored in ADK files.

After you retire the application, you can use the Data Validation Option to validate the retired data. You can 
use the Data Discovery portal or other third-party query tools to access the retired data.

SAP Application Retirement Process
Before you retire an SAP application, you must verify the installation prerequisites and complete the setup 
activities.

To retire an SAP application, perform the following high-level steps:

1. Install and apply the SAP transports. For more information, see the "SAP Application Chapter" of the 
Informatica Data Archive Administrator Guide. 

2. Install and configure the SAP Java Connector. For more information, see the "SAP Application Chapter" 
of the Informatica Data Archive Administrator Guide. 
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3. Copy the sapjco3.jar file to the webapp\web-inf\lib directory in Data Archive. 

4. If the SAP application is installed on a Microsoft SQL Server database, enable the following property in 
the conf.properties file by setting the value to "Y": informia.sqlServerVarBinaryAsVarchar=Y 

5. Restart Data Archive. 

6. Create a customer-defined application version under the SAP application in the Enterprise Data Manager. 

7. Import metadata from the SAP application to the customer-defined application version. 

8. Optionally, run the SAP smart retirement standalone job. For more information, see the topic "SAP Smart 
Retirement" in this chapter. 

9. Create retirement entities. 

Use the generate retirement entity wizard in the Enterprise Data Manager to automatically generate the 
retirement entities. When you create the entities, you can specify a prefix or suffix that will help you 
identify the entities as retirement entities. If you ran the SAP smart retirement job, select "Group by SAP 
Module" when you configure the retirement entities.

10. Create a source connection. 

For the connection type, choose the database in which the SAP application is installed. Configure the 
SAP application login properties. You must correctly enter the SAP host name so that the SAP datatypes 
are correctly mapped to Data Vault datatypes during the retirement process.

11. Create a target connection to the Data Vault. 

12. Run the Create Archive Folder job to create archive folders in the Data Vault. 

13. If the SAP application is installed on a Microsoft SQL Server database, enable the following property in 
the conf.properties file by setting the value to "Y": informia.sqlServerVarBinaryAsVarchar=Y 

14. Create and run a retirement project. 

When you create the retirement project, add the retirement entities and the pre-packaged SAP entities. 
Add the attachment link entities as the last entities to process. Optionally, add the Load External 
Attachments job to the project if you want to move attachments to the Data Vault.

15. Create constraints for the imported source metadata in the ILM repository. 

Constraints are required for Data Discovery portal searches. You can create constraints manually or use 
one of the table relationship discovery tools to help identify relationships in the source database.

The SAP application retirement accelerator includes constraints for some tables in the SAP ERP system. 
You may need to define additional constraints for tables that are not included in the application 
accelerator.

16. Copy the entities from the pre-packaged SAP application version to the customer-defined application 
version. 

17. Create entities for Data Discovery portal searches. 

Use the multiple entity creation wizard to automatically create entities based on the defined constraints. 
For business objects that have attachments, add the attachment tables to the corresponding entities.

The SAP application retirement accelerator includes entities for some business objects in the SAP ERP 
system. You may need to create entities for business objects that are not included in the application 
accelerator.

18. Create stylesheets for Data Discovery portal searches. 

Stylesheets are required to view attachments and to view the XML transformation of SAP encoded data.

19. To access the SAP Archives, verify that your login user is assigned the SAP portal user role. 
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If you installed the SAP retirement accelerator, you can use pre-packaged data visualization reports to 
access retired data in the Data Vault. You can access the reports through the SAP Archives under the 
Data Visualization menu.

20. Optionally, validate the retired data. 

Use the Data Validation Option to validate the data that was archived to the Data Vault. Because SAP 
applications contain thousands of tables, you may want to validate a subset of the archived data. For 
example, validate the transactional tables that were most used in the source application.

After you retire the application, use the Data Discovery portal, SAP Archives, or third-party query tools to 
access the retired data.

SAP Smart Retirement
Before you create retirement entities, you can run the SAP smart retirement job. The job identifies the type of 
table and whether or not it contains data. This information can help you select which tables you want to 
retire.

When you run the SAP smart retirement standalone job, you provide the name of a source connection from 
the list of available connections. Based on the source connection properties, the job identifies the SAP 
application version as it appears in the Enterprise Data Manager. The job then updates the ILM repository 
with metadata from the SAP source connection. This metadata includes the type of table and whether or not 
the table contains data.

Note: The SAP smart retirement job updates the metadata for a single source connection imported in the 
Enterprise Data Manager. Do not export or import the pre-packaged accelerators entities from one 
environment to another, for example from a development to a production environment.

If you run the SAP smart retirement job and then generate the retirement entities in the Enterprise Data 
Manager, the resulting entities are grouped together by a common naming convention. The naming 
convention identifies the type of tables and whether or not the tables contains data.

When you configure the retirement entities, you can specify a prefix or suffix that will be appended to the 
entities when the Enterprise Data Manager creates them. The prefix or suffix can help you to identify the 
entity as a retirement entity. After you generate the retirement entities, the entities appear in the Enterprise 
Data Manager appended with the specified prefix or suffix. For example, the entity "V2_1CDOC_194" is a 
change documents entity that has the prefix "V2," which you specified when you created the entities.

The Enterprise Data Manager also groups the entities by the SAP module. The entity name reflects the 
module name as an abbreviation. For example, the entity "SD_001" is in the Sales and Distribution module, 
while the entity "FI_04" is in the Finance module. When you configure the entities, you specify the maximum 
amount of tables in the entity. The Enterprise Data Manager creates the required number of entities and 
names them according to the module. For example, if you have 1,000 Sales and Distribution tables and you 
specify a maximum of 200 tables per entity, the Enterprise Data Manager creates five different SD entities.
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For tables that do not belong to a standard SAP module, the Enterprise Data Manager uses the following 
naming conventions when it creates the entities:

Naming 
Convention

Description

1RFC RFC tables

1NODT Tables with no data

1CDOC Change document tables

1IDOC IDOC tables

1OFFA Office and attachment tables

1LOG Log tables

1WF Workflow tables

YYNM Tables with no module assigned in the SAP system

You can use this information to decide whether or not you want to retire the entity when you create the 
retirement project. If you want to reduce the number of tables in the retirement project, you can exclude 
certain types of tables, such as workflow tables, or tables that do not contain any data, as designated by the 
"1NODT" in the naming convention.

The Enterprise Data Manager groups special tables in their own entities. Special tables are identified by the 
suffix "_SAP."

Tables with archived data are identified by the suffix "_SAP_ADK."
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The following image shows an example of the entities created by the SAP smart retirement process in the 
Enterprise Data Manager. These entities were created with the prefix "UF2":
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Running the SAP Smart Retirement Standalone Job
Before you generate retirement entities, run the SAP smart retirement standalone job.

1. Click Jobs > Schedule a Job. 

The Schedule Job page appears.

2. Select Standalone Programs and then Add Item. 

The Select Definitions window appears.

3. From the list of programs, select SAP Smart Retirement. 

4. Select the source connection for the SAP application version that you want to retire. 

5. Click Submit. 

6. Schedule the job to run. 

You can monitor the job progress from the Monitor Jobs page. When the job completes, you can 
generate the retirement entities for the SAP application version in the Enterprise Data Manager. For more 
information about generating retirement entities, see the Informatica Data Archive Enterprise Data 
Manager Guide.

Retirement Job
The retirement job uses a combination of methods to access data from SAP applications. The job accesses 
data directly from the SAP database for normal physical tables. The job uses the SAP Java Connector to log 
in to the SAP application to access data in transparent HR and STXL tables, ADK files, and attachments.

When you run a retirement job, the job uses the source connection configured in the retirement project to 
connect to the source database and to log in to the SAP system. The job extracts data for the following 
objects:
Physical Tables

Physical tables store data in a readable format from the database layer. The retirement job extracts data 
directly from the database and creates BCP files. The job does not log in to the SAP application.

Transparent HR and STXL tables

Transparent HR PCL1-PCL5 and STXL tables store data that is only readable in the SAP application layer. 
The retirement job logs in to the SAP system. The job cannot read the data from the database because 
the data is encoded in an SAP format.

The job uses the source connection properties to connect to and log in to the SAP application. The job 
uses an ABAP import command to read the SAP encoded data. The job transforms the SAP encoded 
data into XML format and creates BCP files. The XML transformation is required to read the data after 
the data is retired. The XML transforms occurs during the data extraction.

ADK Files

ADK files store archived SAP data. The data is only readable in the SAP application layer. The retirement 
job uses the source connection properties to connect to and log in to the SAP application. The job calls a 
function module from the Archive Development Kit. The function module reads and extracts the archived 
ADK data and moves the data to the BCP staging area as compressed BCP files.
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Attachments

Attachments store data that is only readable in the SAP application layer. The retirement job uses the 
SAP Java Connector to log in to the SAP application and to call a function module. The function module 
reads, decodes, and extracts the attachments that are stored in the database. The job moves the 
attachments to the attachment staging area that you specify in the source connection. Depending on 
your configuration, the job may also move attachments that are stored in an external file system.

When the retirement job creates BCP files, the job compresses and moves the files to a BCP staging area. For 
physical tables, the job stores the BCP files in the staging directory that is configured in the Data Vault target 
connection. For transparent HR and STXL tables, ADK files, and attachments, the job uses an SAP function 
module to generate the BCP files. The SAP function module stores the BCP files in the staging directory that 
is configured in the source connection.

The job uses the BCP file separator properties in the conf.properties file to determine the row and column 
separators. The job uses the Data Vault target connection to determine the maximum amount of rows that 
the job inserts into the BCP files. After the job creates the BCP files, the Data Vault Loader moves the files 
from the BCP staging area to the Data Vault.

Attachment Retirement
You can archive CRM, ERP, SCM, SRM, and GOS (Generic Object Services) attachments. The attachments can 
exist in the SAP database and in an external file system. Data Archive retires any objects that are attached to 
the business object, such as notes, URLs and files.

By default, the retirement job archives all attachments that are stored in the SAP database and in an external 
file system or storage system. If attachments are in a storage system, then archive link must be available. 
The job creates a folder in the staging location for each business object ID that includes attachments. The 
folder stores all attachments for the business object ID. You specify the staging location in the source 
connection. The job uses the following naming convention to create the folders:

<SAP client number>_<business object ID>
The job downloads all attachments for the business objects to the corresponding business object ID folder. 
The job downloads the attachments in the original file format and uses a gzip utility to compress the 
attachments. The attachments are stored in .gz format.

For attachments that are stored in the SAP database, the retirement job uses an ABAP import command to 
decode the attachments before the job downloads the attachments. The SAP database stores attachments in 
an encoded SAP format that are only readable in the SAP application layer. The job uses the SAP application 
layer to decode the attachments so you can read the attachments after you retire the SAP application.

For attachments that are stored in a file system, the job downloads the attachments from the external file 
system or storage to the staging location. Optionally, you can configure the attachment entity to keep 
attachments in the original location.

After the job creates the folder for the business object ID, the job appends the business object number as a 
prefix to the attachment name. The prefix ensures that attachment has a unique identifier and can be 
associated with the correct business object.

The job uses the following naming convention for the downloaded attachment names:

<business object number>_<attachment name>.<file type>.gz
After you run the retirement job, you choose the final storage destination for the attachments. You can keep 
the attachments in the staging file system, move the attachments to another file system, or move the 
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attachments to the Data Vault. There is no further compression of the attachments regardless of the final 
storage destination.

Attachment Storage
Attachment storage options depend on the location of the attachments in the source application. You can 
keep the attachments in the original location or move the attachments to a different location. It is mandatory 
to move attachments that are stored in the SAP database to a different storage destination. It is optional to 
move attachments that are stored in an external file system.

You can archive attachments to any of the following destinations:
Original File System

You can keep attachments in the original storage for attachments that are stored in an external file 
system. By default, the retirement job moves all attachments to the file system that is configured in the 
source connection.

To keep the attachments in the original file system, configure the run procedure parameter for the 
attachment entity.

Staging File System

By default, the retirement job moves attachments that are stored in the SAP database and in an external 
file system to a staging file system. The staging file system is configured in the source connection.

After the retirement job moves attachments to the staging file system, you can keep the attachments in 
this location or you can move the attachments to another file system, such as Enterprise Vault, or move 
the attachments to the Data Vault. Store attachments in a file system to optimize attachment 
performance when users view attachments.

Data Vault

After the retirement job archives attachments to the staging file system, you can move the attachments 
to the Data Vault.

Note: The retirement job compresses the attachments. The Data Vault Service does not add significant 
compression. In addition, users may experience slow performance when viewing attachments. To 
optimize attachment performance, store attachments in a file system instead.

To move attachments to the Data Vault, run the Load External Attachments job after the retirement job 
completes. The Load External Attachments job moves the attachments from the staging file system to 
the Data Vault.

Attachment Viewing
After you archive the attachments, you can view the attachments in the Data Discovery portal or with a third-
party reporting tool. The ILM repository link table, ZINFA_ATTCH_LINK, includes information on the 
downloaded attachments. The table includes information to link business objects to the corresponding 
attachments. The link table is included in the pre-packaged SAP entities for business objects that have 
attachments.

To view attachments in the Data Discovery portal, you must configure entities for discovery. For any business 
object that may have attachments, you must add the attachment tables to the corresponding entity. If you 
store the attachments in a file system, add the ZINFA_ATTCH_LINK table to the entities. If you store the 
attachments in the Data Vault, add the ZINFA_ATTCH_LINK and AM_ATTACHMENTS tables to the entities.

To view attachments from the Data Discovery portal, you must create a stylesheet. In the stylesheet, build a 
hyperlink to the attachment location. Use the ZINFA_ATTCH_LINK table to build the path and file name. When 
users perform searches, business object attachments appear as hyperlinks. When users click a hyperlink, the 
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default browser opens the attachment. The attachments are compressed in gzip format. The client from 
which the user runs the Data Discovery portal searches must have a program that can open gzip files, such 
as 7zip.

Data Visualization Reports
The SAP application accelerator includes data visualization report templates. The reports include information 
that corresponds to key information in SAP ERP transactions. You can run the reports to access retired data 
in the Data Vault.

If you use the Reports and Dashboards window to access the reports, you must first copy the report 
templates to the folder that corresponds to the archive folder in the Data Vault target connection. The archive 
folder is equivalent to a Data Vault database. When you copy the reports, the system updates the report 
schemas based on the target connection configuration. Then you can run the reports.

If you use the SAP Archives to access the reports, all of the reports installed by the accelerator are copied to 
the corresponding SAP archive folder the first time that you launch the SAP Archives. If you plan to access 
the reports through the SAP Archives, you do not need to manually copy the reports to the archive folder, 
though you have the option to do so.

When you install the SAP application retirement accelerator, the installer publishes the reports to the data 
visualization server with the following properties:

Property Value

Folder name SAP

Catalog name SAP_Retirement

Catalog Path <Data Archive install directory>/webapp/visualization/reporthome/<system generated folders>/
SAP_Retirement.cat

Related Topics:
• “Copying Reports” on page 202

Customer List

The customer list report contains the following tables:

Table Name Table Type

KNA1 Transparent

KNB1 Transparent

T001 Transparent
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Customer Country Key

The customer country key report contains the following tables:

Table Name Table Type

KNA1 Transparent

KNB1 Transparent

T001 Transparent

Customer Line Item List

The customer line item list report contains the following tables:

Table Name Table Type

BSID Transparent

KNA1 Transparent

T001 Transparent

KNB1 Transparent

Customer Balances in Local Currency

The customer balances in local currency report contains the following tables:

Table Name Table Type

KNC1 Transparent

KNA1 Transparent

T001 Transparent
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Customer Master Record

The customer master record report contains the following tables:

Table Name Table Type

KNA1 Transparent

KNB1 Transparent

T001 Transparent

Vendor List

The vendor list report contains the following tables:

Table Name Table Type

LFA1 Transparent

LFB1 Transparent

T001 Transparent

Vendor Country Key

The vendor country key report contains the following tables:

Table Name Table Type

LFA1 Transparent

LFB1 Transparent

Vendor Line Item List

The vendor line item list contains the following tables:

Table Name Table Type

BSIK Transparent

LFA1 Transparent

T001 Transparent
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Table Name Table Type

SAP_EXT_ATTACHMENTS View - only for attachments

AM_ATTACHMENTS Transparent - only for attachments

Vendor Balance in Local Currency

The vendor balance in local currency report contains the following tables:

Table Name Table Type

LFC1 Transparent

LFA1 Transparent

Vendor Master Record

The vendor master record report contains the following tables:

Table Name Table Type

LFA1 Transparent

LFB1 Transparent

T001 Transparent

Asset List

The asset list report contains the following tables:

Table Name Table Type

ANLC Transparent

T001 Transparent

ANLA Transparent
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Posted Depreciation

The posted depreciation report contains the following tables:

Table Name Table Type

ANLP Transparent

ANLA Transparent

T001 Transparent

Asset Depreciation

The asset depreciation report contains the following tables:

Table Name Table Type

ANLB Transparent

ANLC Transparent

T001 Transparent

ANLA Transparent

Asset Transactions

The asset transactions report contains the following tables:

Table Name Table Type

ANLA Transparent

ANLZ Transparent

T001 Transparent
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Asset Master

The asset master report contains the following tables:

Table Name Table Type

ANLA Transparent

ANLZ Transparent

T001 Transparent

G/L Account List

The G/L account list report contains the following tables:

Table Name Table Type

SKA1 Transparent

SKB1 Transparent

T001 Transparent

G/L Account Line Item List

The G/L account line item list report contains the following tables:

Table Name Table Type

BSIS Transparent

SKA1 Transparent

T001 Transparent

G/L Account Balance

The G/L account balance report contains the following tables:

Table Name Table Type

GLT0 Transparent

T001 Transparent
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New G/L Account Balance

The new G/L account balance report contains the following tables:

Table Name Table Type

FAGLFLEXT Transparent

T001 Transparent

New G/L Account Balance Summary

The new G/L account balance summary report contains the following tables:

Table Name Table Type

FAGLFLEXT Transparent

FAGLFLEXP Transparent

FAGLFLEXA Transparent

T001 Transparent

SKAT Transparent

Display Financial Document

The display financial document report contains the following tables:

Table Name Table Type

BKPF Transparent

T001 Transparent

BSEG Special

BSET Special

SKAT Transparent
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Accounting Document Header

The accounting document header report contains the following tables:

Table Name Table Type

BKPF Transparent

T001 Transparent

Accounting Document Line Item

The accounting document line item report contains the following tables:

Table Name Table Type

BSEG Special

T001 Transparent

Business Partner

The business partner report contains the following tables:

Table Name Table Type

BUT000 Transparent

BUT020 Transparent

BUT0BK Transparent

ADRC Transparent

STXH Transparent

ZINFA_STXL Special

SAP Archives
If you have installed the SAP retirement accelerator, you can access the data visualization reports through 
the SAP Archives.

The SAP Archives contain all of the reports installed by the SAP application retirement accelerator. After you 
install the accelerator and launch the SAP Archives for the first time, Data Archive copies the report 
templates from the default folder to the archive folder where the application is retired.

If you have retired the SAP application to one archive folder, you can view all of the available reports when 
you launch the SAP Archives. If you have retired the SAP tables to more than one archive folder, you are given 
the option to select an archive folder when you launch the SAP Archives.
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To access the SAP Archives, you must have the SAP portal user role. The SAP portal user role only grants 
access to the portal. To run, copy, or delete reports, you must have the appropriate report permissions. For 
more information about assigning system-defined roles, see the "Security" chapter in the Informatica Data 
Archive Administrator Guide. For more information about Data Visualization report permissions, see the "Data 
Visualization" chapter in this guide.

Running Reports in the SAP Archives
To run reports, launch the SAP Archives from the Data Visualization menu.

1. Click Data Visualization > SAP Archives. 

2. If required, select the archive folder where the tables that you want to run a report on are retired. 

If you retired the SAP application to only one archive folder, you are not required to select a folder.

The list of available reports appears.

3. To run a report, click the name of the report. 

4. Enter the search criteria. 

5. Click Submit. 

Troubleshooting SAP Application Retirement
SAP application retirement messages contain message IDs that can help in troubleshooting or reporting 
issues that occur during the retirement process. This section explains message IDs and how to troubleshoot 
and resolve issues.

Message Format
Messages that are related to SAP application retirement convey information about a task that completed 
successfully, an error that occurred, a warning, or status updates.

Each message starts with a message ID. The message ID is a unique mix of numbers and letters that identify 
the type of message, type of component, and message number.

The following image shows a sample message ID:

1. Message type
2. Component code
3. Message number

The message ID has the following parts:

Message type

The first character in the message ID represents the type of message.

The message types are represented by the following letters:

• E - Error
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• I - Information

• S - Success

• W - Warning

Component code

The second, third, and fourth characters in the message ID represent the component code of the 
component that triggered the message.

The components are represented by the following codes:

• ADK - refers to the archive session.

• ATT - refers to attachments.

• FTP - refers to the FTP process.

• HR - refers to HR tables and attachments.

• JOB - refers to the Data Archive job.

• SPL - refers to special tables.

• STG - refers to the Staging folder.

• TXT - refers to data in text files.

Message number

The last two numbers in the message ID represent the message number.

Frequently Asked Questions
The following list explains how to troubleshoot and resolve issues that might occur during the SAP 
application retirement process.

When I run the retirement job, the job immediately completes with an error.

The job log includes the following message:

java.lang.NoClassDefFoundError: com/sap/mw/jco/IMetaData
The error occurs because the sapjaco.jar file is missing in the ILM application server. Verify that the SAP 
Java Connector installation is correct.

Perform the following steps to verify the SAP Java Connector installation:

1. From the command line, navigate to the following directory:

<Data Archive installation>/webapp/WEB-INF/lib
2. Enter the following command:

java –jar sapjco.jar
If the installation is correct, you see the path to the SAP Java Connector library file, such as C:\SAPJCO
\sapjcorfc.dll.

If the installation is not correct, you see a Library Not Found message in the path for to the SAP Java 
Connector library file.

If the installation is not correct, perform the following steps to resolve the error:

1. Verify that you installed the SAP Java Connector.
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2. Copy the sapjaco.jar file from the root directory of the SAP Java Connector installation and paste to 
the following directory:

<Data Archive installation>/webapp/WEB-INF/lib
3. Restart the ILM application server.

When I run the retirement job, I receive an error that the maximum value was exceeded for no results from the SAP 
system.

For every package of rows that the job processes, the job waits for a response from the SAP system. The job 
uses the response time configured in the conf.properties file and the package size specified in the job 
parameters. If the SAP system does not respond within the configured maximum response time, the job fails.

The SAP system may not respond for one or more of the following reasons:

• The maximum amount of SAP memory was exceeded. The SAP system terminated the process. The SAP 
system may run out of memory because the package size that is configured in the job is too high.

• The SAP system takes a long time to read the data from the database because of the configured package 
size.

• The network latency is high.

To resolve the error, in the SAP system, use transaction SM50 to verify if the process is still running. If the 
process is still running, then restart the job in Data Archive.

If the process is not running, perform one or more of the following tasks:

• Use SAP transactions SM37, ST22, and SM21 to analyze the logs.

• Decrease the package size in the job parameters.

• Increase the informia.MaxNoResultsIteration parameter in the conf.properties file.

The job log indicates that the Data Vault Loader received an exception due to an early end of buffer and the load was 
aborted.

The error may occur because the SAP application is hosted on Windows.

Perform the following steps to resolve the error:

1. Configure the informia.isSAPOnWindows property to Y in the conf.properties file.

2. Reboot the ILM application server.

3. Create a new retirement project.
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Creating Retirement Archive Projects Overview
A retirement archive project contains the following information:

• Identifying the application to retire.

• Defining the source and target for the retirement data and imposition of relevant policies defined earlier.

• Optionally, enabling integrated validation before you run the project. Integrated validation ensures the 
integrity of the data that you retire.

• Configuration of different phases in the retirement process, and reporting information.

Existing retirement archive projects can be viewed from Workbench > Manage Retirement Projects. A new 
project can be created by clicking the New Application button from the Manage Retirement Projects page. 
The process of creating a retirement archive project is described in detail in the following section.

Identifying Retirement Application
As a first step to application retirement, the information to be specified is described in the following table:

Application Detail Description

Application Name A name for an application is mandatory.

Application Vendor Name Vendor name of the selected application.

Application Owner Application owner of the legacy application selected.

Vendor Contact Contact information of the vendor.

Retirement Date A mandatory field to enter proposed retirement date.

Vendor Phone Vendor contact numbers.

Primary Contact Vendor's primary contact information.

Vendor Contract Number The signed contract number of the vendor.

Comments A section where additional information related to this particular retirement can 
be added.

The Add More Attributes button A facility to add any more attributes that you may want to include to the 
application details which would serve in the process of application retirement.

Use Integrated Validation Enables integrated validation for the project.
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Application Detail Description

Use Data Encryption Select this option to enable data encryption on the compressed Data Vault files 
during load. If you select this option, you must also choose to use a random key 
generator provided by Informatica or your choice of a third-party key generator to 
create an encryption key. Data Archive stores the encrypted key in the ILM 
repository as a hidden table attribute in case the job fails and must be resumed. 
When you run the retirement job, the key is passed to Data Vault as a job 
parameter and is not stored in Data Vault or any log file. If the retirement job is 
successful, the key is deleted from the ILM repository. The encrypted key is 
unique to the retirement definition and is generated only once for a definition.
If you have enabled data encryption for both the selected target connection and 
the retirement definition, Data Archive uses the retirement definition encryption 
details. If you do not configure data encryption at the definition level, then the 
job uses the details provided at the target connection level.

Use Random Key Generator Option to use a random key generator provided by Informatica when data 
encryption is enabled. When you select this option, the encryption key is 
generated by a random key generator provided by Informatica 
(javax.crypto.KeyGenerator).

Use Third Party Option to use a third-party key generator when data encryption is enabled. If you 
select this option, you must configure the property 
"informia.encryptionkey.command" in the conf.properties file. Provide the 
command to run the third-party key generator.

Clicking the Next button advances to the section on defining source and target repositories. The Save Draft 
button saves the project for future modifications and scheduling.

Defining a Source Connection
Create a source connection for the source database that you want to retire. The source database is the 
database that stores the transactional data that you want to archive. For example, the source can be an ERP 
application such as PeopleSoft. The source database is usually the production database or application 
database.

Define a connection to the application that you want to retire. Select the application version. Then, create or 
choose a source connection.

Important: 

• If the source connection is a Microsoft SQL Server, clear the Compile ILM Functions check box on the 
Create or Edit an Archive Source page before you start a retirement job. This ensures that the staging 
database user has read-only access and will not be able to modify the source application.

• Clear the Use Staging check box on the Create or Edit an Archive Source page before you start a 
retirement job.
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Defining a Target Repository
Define a target connection, which is the location where you want to archive data to. For a retirement project, 
the target is an optimized file archive, also called the Data Vault.

Select the application version. Then, create or choose a target connection.

Adding Entities
Add the entities from the application that you want to retire.

Defining Retention and Access
This section allows you to define the retention policies and associated access policies for an application.

The following table describes the fields in the Retention group:

Field Description

Policy Retention policy that determines the retention period for records in the entity. You can create a 
retention policy or select a policy. You can select any retention policy that has general retention. If 
you do not create or select a retention policy, the records in the entity do not expire.

Name Name of the retention policy. Required if you create a retention policy.

Description Optional description of the retention policy.

Retention 
Period

The retention period in years or months. Data Archive uses the retention period to determine the 
expiration date for records in the entity. If you select or create a policy with general retention, the 
expiration date equals the retirement archive job date plus the retention period.

The following table describes the fields in the Access Roles group:

Field Description

Access Roles Data Vault access role for the retirement archive project. You can create an access role or select a 
role. The access role determines who can view data from Data Discovery searches.

Role Name Specific responsibility of a user who initiates a retention policy.

Description Any intuitive description on the access roles.

Valid From Date when a role is assigned to a user.

Valid Until Optional date when a role assigned to a user expires.

When you click the Publish and Schedule button, the project is saved and the Schedule Job page appears.

When you click the Publish button or the Save Draft button, Data Archive lists the project in the Manage 
Retirement Projects page. Publishing the project indicates that the project is ready for scheduling. Saving a 
draft means that modifications are still required.

Clicking the Next button opens the Review and Approve page. The Save Draft button saves the project for 
future modifications and scheduling.
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Review and Approve
The Review and Approve page in the Data Archive for Application Retirement lets the user not only 
completely evaluate the configured source and target repositories, but also facilitates viewing and approving 
the selected application’s retrial.

The following table lists possible available fields:

Field Possible Values

Application Name Name of the legacy application which is being retired.

Retired Date The Date the application retirement is scheduled.

Retired Object Name Application module that is being retired/ selected by user.

Retention Retention period specified by user.

Access Role which is been provided while associating a policy.

Approved By Person who approves the retirement procedure.

Approved Date Date when retirement procedure is been approved.

Click the Application Info tab to view the detailed information of the selected application and click the Source 
& Target tab to view the configured Source and Target details. Detailed information is displayed by clicking 
each of the three sections.

Confirming Retirement Run
The last step in an Retirement project is to confirm a retirement run. Internally, during a retirement, data is 
not directly retired from data source to data target. Instead a staging schema and interim (temporary) tables 
are used to ensure that retirement data and associated table structures are sufficiently validated during the 
application retirement.

The following steps are involved in the process:

1. Generate Candidates. Generates Interim tables based on Entities and constraints specified in the 
previous step.

2. Validate Destination. Validates table structure and Data in the Target repository to generate DML for 
modifying Table structure and/or adding Rows of data.

3. Copy to Destination. Copies data to Data Destination.

4. Purge Staging. Deletes Interim tables from staging schema.

After the retirement project completes successfully, you cannot edit or re-run the project.

Gaps in Execution of Steps
After each stage in the retirement process, Data Archive for Application Retirement provides the user with an 
ability to pause. Relevant checkboxes (for that step) can be selected under the Pause After column.

Generating Row Count Reports
To generate ROWCOUNT reports for certain steps in the retirement cycle, select relevant checkboxes under 
the column Row Count Report.
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This report gives information on affected rows for all selected stages in the process. For example, 
ROWCOUNTs are logged for the steps Generate Candidates and Copy to Target for this archive job execution.

Running Scripts
One can also specify JavaScripts or Procedures to run before or after a particular stage under the Run Before 
and Run After columns.

Notification Emails
On selecting a check box under the Notify column, a notification email (with relevant status information) is 
sent to the user when the archive process is aborted due to an error or termination event.

When either Publish or Save Draft is clicked, the project gets listed in the Manage Retirement Projects page. 
From a user’s perspective, the former indicates that the project is ready for scheduling. The latter means 
modifications are still required.

Copying a Retirement Project
After a retirement project successfully completes, you cannot edit or rerun the project. If you need to edit or 
rerun the project, you can create a copy of the completed project and edit the copied project.

1. Click Workbench > Manage Retirement Projects. 

The Manage Retirement Projects window opens.

2. Select the Copy check box next to the retirement project that you want to copy. 

The Create or Edit a Retirement Project window opens. Data Archive pre-populates all of the project 
properties as they existed in the original project.

3. To edit the retirement project, change any properties and click Next to continue through the project. 

4. When you have made the required changes to the project, schedule the project to run or save the project 
to run at a later date. 

Application Migration
Use the application migration process to migrate an application that has been retired and validated from a 
non-production environment (referred to as a source environment in this document) to a production 
environment (referred to as a target environment).

After you have retired an application on a non-production environment, typically you would repeat the entire 
process, including application retirement, data validation, report creation, compliance, and sign-off, on the 
target (production) environment. If you have completed the entire process on a pre-production environment 
and the retired data is identical to what you must retire again on the production instance, the application 
migration process prevents you from having to repeat the entire process. Instead, you can migrate the 
relevant data from pre-production onto the production instance.

This saves time and effort as opposed to duplicating the pre-production work, as long as you have retired the 
entire application in the source instance. During the migration process, relevant application data and 
metadata is directly migrated from the source to target environment.
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Before you begin the application migration process, note the following requirements:

• The application version/product family version that you want to migrate does not already exist in the 
target Data Archive and Data Vault environments.

• The archive folder does not exist in the target Data Vault environment.

• The source and target environments must be on the same operating system.

• Both the source and target environments must have the same versions of Data Vault and Data Archive.

• The staging directory and data directory in the target Data Vault connection must be accessible (both read 
and write permissions) to both the target Data Vault and Data Archive systems.

Note the following limitations in the pre-production to production data migration process:

• You cannot view job steps in the production environment because the process does not migrate job step 
information.

• You cannot view the Integration Report of migrated jobs in the production environment.

• The process does not migrate job step logs to the production environment.

• You must enter passwords of migrated source and target connections in the production environment.

• You cannot migrate multiple application versions from a single Archive folder into Data Vault.

• You must not include whitespace characters in the export file directory name.

Application Migration Process
When you use the application migration process, you complete a set of tasks on both the source and target 
environments.

Complete the following tasks on the source (pre-production) environment:

1. Add the migration administrator role to the user performing the migration. The default administrator 
user, AMADMIN, is assigned the role by default.

2. Run the Export Informatica Data Vault Metadata standalone job.

3. Create a target connection to the ILM repository of the target Data Archive environment.

4. Run the Migrate Data Archive Metadata standalone job.

Complete the following tasks on the target (production) environment:

1. Add the migration administrator role to the user performing the migration. The default administrator 
user, AMADMIN, is assigned the role by default

2. Update the connections details to the target Data Vault.

3. Move the SCT data files to the export file directory specified in the Export Informatica Data Vault 
Metadata standalone job. Verify that the .tar file is accessible to the target Data Archive instance.

4. If necessary, update the ssa.ini file.

5. Run the Import Informatica Data Vault Metadata standalone job.

6. Recreate the Data Vault indexes.
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Source (Pre-Production) Environment Tasks
When you begin the application migration process, start by completing the following steps on the source 
(pre-production) Data Archive environment.

Step 1. Add the Migration Administrator Role
Add the migration administrator role to the user running the migration process. This role is required to run 
the standalone jobs that export the Data Vault metadata and migrate the Data Archive metadata. The 
AMADMIN user has the migration administrator role by default.

For more information about system-defined roles, see the "Security" chapter of the Data Archive Administrator 
Guide.

1. Click Administration > Manage Users. 

2. Click the Edit icon next to the user running the migration. 

The Edit User page opens.

3. Click Add Role, select Migration Administrator from the menu, and enter the validity dates of the role. 

4. Click Save. 

Step 2. Run the Export Informatica Data Vault Metadata Job
When you run the Export Informatica Data Vault Metadata job, the job generates metadata files necessary for 
migration, including a .tar file, in an export file directory that you designate. Optionally, you can also export 
materialized view statements.

1. Click Jobs > Schedule a Job. 

2. Select Standalone Programs and click Add Item. 

The Select Definitions window appears.

3. Select the Export Informatica Data Vault Metadata job and click Select. 

4. Enter the following job parameters: 

Parameter Description

Source IDV Folder 
Name

Required. Name of the source Data Vault archive folder that you want to migrate.

Target File Archive 
Data Directory

Required. Full path of the location in the target Data Vault system that stores the SCT data 
files. If the target file archive data directory is not the same directory that stores the SCT 
data files in the source system, provide the path to a different directory in this parameter. 
If the target file archive data directory is the same directory that stores the SCT data files 
in the source system, provide the path to that directory and select "Yes" for the Target to 
Use Same Storage as Source parameter.

Export File 
Directory

Required. Full path of the temporary directory on the source Data Archive system that 
stores the run-time files, the log file, and the .tar file. This directory must be accessible to 
the source Data Archive system.
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Parameter Description

Staging Directory 
for Target External 
Storage

Optional for a local file system. Required when the target SCT data file directory is an 
external storage directory. Full path of the location in the target external storage system 
that stores the SCT data files that you want to import to the external storage system.

Target to Use Same 
Storage as Source

Required. If you select yes, the job keeps the original SCT data file location between the 
source and target environments. If the target file archive data directory is the same 
directory that stores the SCT data files in the source system, you must select "Yes" for the 
Target to Use Same Storage as Source parameter. If the target file archive data directory 
is not the same as the source directory, select "No" in the Target to Use Same Storage as 
Source parameter and verify that you have given the directory path in the Target File 
Archive Data Directory parameter.

Copy Data Files to 
Export File 
Directory

Required. If you select yes, the SCT files are copied to the export file directory along with 
the run-time files, log file, and .tar file.

Export Materialized 
View Statements

Required. If you select yes, any materialized view statements on the source will be 
exported during the job run. When you run the Import Informatica Data Vault Metadata job 
later in the process, the materialized views will be created on the target.

5. Schedule the job to run immediately or on a certain day and time. 

6. Enter an email address to receive notification when the job completes, terminates, or returns an error. 

7. Click Schedule. 

Step 3. Create a Target Connection
Create a target connection to the ILM repository of the target Data Archive system. The apps schema name 
and application login name must link to the target ILM repository. The application version is irrelevant.

1. Click Administration > New Target Connection. 

The Create or Edit an Archive Target page appears.

2. Enter the connection properties. For example:
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3. Click Save. 

For more information about creating a target connection, see the chapter "Target Connections" in the 
Data Archive Administrator Guide.

Step 4. Run the Migrate Data Archive Metadata Job
Run the Migrate Data Archive Metadata standalone job. The job migrates the required metadata, including 
source connections, target Data Vault connections, roles, application and data model metadata, legal holds, 
tags, retention, and more to the ILM repository of the target Data Archive instance.

1. Click Jobs > Schedule a Job. 

2. Select Standalone Programs and click Add Item. 

The Select Definitions window appears.

3. Select the Migrate Data Archive Metadata job and click Select. 

4. Enter the following job parameters: 

Parameter Description

Target Metadata 
Repository

Required. The target ILM repository connection created in the previous step.

Product Family Version Required. The product family version/application version that you want to migrate.

Copy Users and Roles Required. If you select no, the job migrates only the retirement entity-related roles. If 
you select yes, the job migrates users related to the retirement entity-related roles, in 
addition to other roles related to the users.
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Parameter Description

Migrate Export 
Migration Status Table 
Only

Required. If you select yes, the job migrates only the export migration status table. If 
you select No, the job migrates all of the corresponding meta tables.

5. Schedule the job to run immediately or on a certain day and time. 

6. Enter an email address to receive notification when the job completes, terminates, or returns an error. 

7. Click Schedule. 

Note: If the application version that you want to migrate has more than one Data Vault archive folder in 
the source environment, you have two options. Informatica suggests that you run the Export Informatica 
Data Vault metadata job for both Data Vault folders, complete the Migrate Data Archive Metadata job for 
the application version, and then run the Import Informatica Data Vault Metadata job for both folders. 
Alternatively, you can run all three jobs to complete the migration process for the first Data Vault folder. 
When you migrate the second folder, select the "Yes" option for the "Migrate export migration status 
table only" parameter in the Migrate Data Archive Metadata job, and then run the Import Informatica Data 
Vault Metadata job. 

Target (Production) Environment Tasks
After you complete the tasks on the source (pre-production) system, complete the following steps on the 
target (production) Data Archive environment.

Prerequisites
If you have enabled SSL authentication in the production environment but not in the pre-production 
environment, you must first update the Data Vault nucleus.ini file with the SSL authentication details.

1. Navigate to /<Data Archive installation>/webapp/file_archive. 

2. Update the nucleus.ini file with the SSL details relevant to the connection. 

3. Save and close the file. 

Step 1. Add the Migration Administrator Role
To view the migration process jobs, the login user must have the migration administrator role. The AMADMIN 
user has the migration administrator role by default. If you did not select "Copy Users" in the Migrate Data 
Archive Metadata job, add the entity access role to the user as well.

1. Click Administration > Manage Users. 

2. Click the Edit icon next to the user running the migration. 

The Edit User page opens.

3. Click Add Role, select Migration Administrator from the menu, and enter the validity dates of the role. 

4. Click Save. 

For more information about adding entity access roles to the user, see the "Security" chapter of the Data 
Archive Administrator Guide.
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Step 2. Update the Data Vault Connection
Update the necessary connection details for the target Data Vault connection. Specifically, make sure to 
update the file achive data directory to the same target file archive data directory given in the Export 
Informatica Data Vault Metadata Job in the source environment. You must also update the file archive host 
and port, and the file archive user name and password.

1. Click Administration > Manage Connections. 

The Manage Connections page opens.

2. Click the Target tab. 

3. Click the Edit icon next to the target Data Vault connection. 

The Create or Edit an Archive Target page opens.

4. Update the necessary connection details. 

5. Click Save. 

Step 3. Move the .Tar and SCT Data Files
You must manually move the SCT data files and the .tar file generated by the Export Informatica Data Vault 
Metadata job from the source Data Vault environment to the target Data Vault environment.

1. From the export file directory that you specified in the Export Informatica Data Vault Metadata 
standalone job, open the idvmeta_sctlist.txt file. 

2. Follow the instructions in the file to move the SCT data files to the target Data Vault environment. The 
file contains a list of the SCT data files that you must copy to the target file archive data directory. 

3. Move the .tar file in the export file directory to a folder accessible to the target Data Archive instance. 

Step 4. Update the ssa.ini File
If you moved the SCT data files to an external storage system, or if you want to re-create the source 
materialized views in the target Data Vault system, update the ssa.ini file.

1. If you chose to use an external storage system for the SCT data files, update the ssa.ini file in both the 
file_archive and installation folders. Follow the format of the ssa.ini file in the source environment. For 
example: 

[HCP_CONNECTION IDV_FILEOUT4]
HCP_AUTH_TOKEN = hcp-ns-auth=dHTuMnVzZXI=:489825A0951C3CF1F22E27B61CEE6143

2. If you exported materialized view statements from the source Data Vault system and want to migrate 
them to the target system, add the MVIEWDIR parameter in both the [QUERY] and [SERVER] sections of 
the ssa.ini file of the target Data Vault. For example: 

[QUERY]
………………
MVIEWDIR=/data/mviewdir
[SERVER]
…………….
MVIEWDIR=/data/mviewdir

3. After you add the entries, restart Data Vault. 
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Step 5. Run the Import Informatica Data Vault Metadata Job
Run the Import Informatica Data Vault Metadata standalone job. The job imports metadata to the target Data 
Vault instance and registers the SCT data files.

1. Click Jobs > Schedule a Job. 

2. Select Standalone Programs and click Add Item. 

The Select Definitions window appears.

3. Select the Import Informatica Data Vault Metadata job and click Select. 

4. Enter the following job parameters: 

Parameter Description

Target IDV Connection Required. The connection that links to the target Data Vault instance.

Export IDV Metadata Job ID 
and IDV Folder Name

The Export Data Vault Metadata job ID (from the source Data Archive environment) 
and the Data Vault folder name that you want to migrate to the target Data Vault.

TAR Archive File Directory Required. The directory of the .tar file exported by the Export Informatica Data 
Vault Metadata job. This directory must be accessible from the target Data Archive 
instance.

Note: If the target file archive data directory in the Export Informatica Data Vault Metadata job is an 
external storage directory, and you have manually transferred the SCT data files to the directory defined 
as the "staging directory for target external storage" in the export job, the import job automatically 
transfers the SCT data files to the target external storage.

Step 6. Recreate Indexes
If a keyword search index exists in the source Data Vault environment, you must create it in the target 
environment. You must also create in the target environment any indexes that exist in the source Data Vault 
environment. For more information about creating Data Vault indexes, see the "Scheduling Jobs" chapter.

Report Migration
In addition to an application, you can also migrate Data Visualization reports created on one environment, for 
example a pre-production environment, to another environment, for example a production environment.

There are two types of resources (reports and catalogs) that you can migrate:

Published Resources

Published resources are managed entirely in the JReport Server and support all of the actions available 
on the server. You can delete published resources from Data Archive and also the Jinfonet user 
interface. Custom reports created with Data Visualization Designer or from the Data Archive user 
interface are examples of published resources.

Real Path Resources

Real path resources are managed in both the server and OS. In the server, when you access a resource 
node which is linked with a real path, the local resources in the real path are loaded to the node and 
displayed together with other server resources, including the published resources, in the node. You 
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cannot delete the real path resources directly from the Data Archive or Jinfonet user interface, but you 
can remove the resources from the local disk. SAP reports and reports within the Application Retirement 
for Healthcare accelerator are examples of real path resources.

Depending on whether the reports you want to migrate are real path resources or published resources, 
complete the following tasks to migrate the reports:

Migrating Published Resources

1. Download the reports and catalog from the source environment.

2. Edit the catalog connection details in the downloaded catalog.

3. Edit the catalog table section.

4. Edit the schema name in any "Imported SQLs."

5. Rename the existing catalog.

6. Create a report folder and publish the resource in the target JReport server.

7. Run a migrated report from Data Archive.

Migrating Real Path Resources

1. Download the reports and catalog from the source environment.

2. Edit the catalog connection details in the downloaded catalog.

3. Create a report folder and publish the resource in the target JReport server.

4. Create a report folder in the target file system.

5. Copy the reports and catalog from the source to the target file system.

6. Map the folder deployed on the JReports server to the target file system.

7. Select the migrated target connection in the Patient Archives.

Migrating Published Resources
To migrate published resources from one environment to another, complete the following tasks:

Step 1. Download the Reports and Catalog from the 
Source

In JReport Designer, download the reports and catalog that you want to migrate. When you download the 
resources, maintain the same directory hierarchy that exists on the JReport server.

1. In JReport Designer, select File > Publish and Download > Download from Server > Download Report 
from Server. 

The Connect to JReport Server window appears.

2. Enter the connection details to connect to the JReport server and click Connect. 

3. Select the directory that contains the reports that you want to download. You can only select one 
directory at a time. 

4. Click OK. 
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5. Select the check box next to the catalog and each report that you want to download for migration. 

6. As a best practice, save the reports and catalog to a directory in the Data Archive installation with the 
same name as the directory that you are downloading from. 

For example, if the directory that contains the reports you want to download is called "REPORT_FOLDER," 
append "REPORT_FOLDER" to the Download Resource To path.
 

 

7. Click OK. 

8. If you receive a warning that says the path does not exist and asks you if you want to create it, click Yes. 

9. If you receive a Confirm File Replace message, click Yes to All. 

10. When the download is complete, you receive a message asking if you want to download any additional 
resources. 
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11. Verify that the resources you downloaded exist in the path that you provided as the Download Resource 
To location.
 

 

Step 2. Edit the Catalog Connection Details
Configure JReport Designer to enable inline editing of the catalog. Then, edit the catalog connection details 
according to the target environment connection details.

1. In JReport Designer, click File > Options. 

The Options window appears.

2. Select the Catalog category and deselect the Forbid editing data object properties check box. 

3. Click OK. 

4. Click File > Catalog Management > Open Catalog. 

The Open Catalog File window appears.

5. Navigate to the report folder and select the catalog. 
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6. Click Open. 

The Catalog Browser window appears.

7. Right-click the JDBC connection name and select Edit Connection. 

8. Edit the connection details to match the target connection details. 

 

 
You must modify the following details:

• Description

• Name

• URL
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• User

• Password

Step 3. Edit the Catalog Table Section
Modify the table metadata according to the target. This step is not required if the source environment and 
target environment metadata is exactly the same.

1. Click File > Catalog Management > Open Catalog. 

The Open Catalog File window appears.

2. Navigate to the report folder and select the catalog. 

3. Click Open. 

The Catalog Browser window appears.

4. Select a table underneath the JDBC connection and edit the table properties in accordance with the 
target connection. Verify that you give the correct qualifier and schema name, as they exist in the target 
connection. 

 

 

5. Repeat for all of the necessary tables. 

Step 4. Edit the Schema Name in Imported SQLs
If the catalog contains any imported SQLs, edit the imported SQL properties.

1. Click File > Catalog Management > Open Catalog. 

The Open Catalog File window appears.

2. Navigate to the report folder and select the catalog. 
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3. Click Open. 

The Catalog Browser window appears.

4. Select an imported SQL and edit the SQL properties in accordance with the target connection. Verify that 
you give the correct qualifier and name, as they exist in the target connection. 

 

 

5. Repeat for all of the necessary imported SQLs. 
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Step 5. Rename the Existing Catalog
As a best practice, rename the catalog as the target connection repository ID and target connection 
application version/product family version ID.

When you create a report from the Reports and Dashboards menu in Data Archive, the system creates a 
catalog name automatically. The system-created catalog naming convention is 
<TARGET_REPOSITORY_ID><HYPHEN><TARGET_CONNECTION_PFVID>.

For consistency, rename catalog name as the target connection repository ID and target connection 
application version/product family version ID. The sequence ID can be copied from the target ILM repository 
database.

When you create reports from JReport Designer, you have the option to choose the catalog name. In this case 
you can maintain the same name in the target as well.

Step 6. Create a Report Folder and Publish
Create a report folder and then publish the reports and catalog to the target JReport server.

1. In JReport Designer, click File > Publish and Download > Publish to Server > Publish Report to Server. 

The Connect to JReport Server window appears.

2. Enter the connection details for the target JReport server and click Connect. 
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The Publish to JReport Server window appears.

3. Select the catalog and all of the reports in the folder. 

4. Click Browse next to Publish Resource From and navigate to the folder that you previously downloaded. 

5. Click Browse next to Publish Resource To. 

The Select Folder window appears.

6. Click New Folder and give the new folder the same name as the folder you downloaded. 

7. Select the folder you created and click OK. 

 

 

8. Review the configuration and click OK. 

The Publish Font and Style and Geographic Information window appears.

9. Review the font and style information and click OK to proceed. 
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10. In the Publish to JReport Server window, click OK. 

When the resources have published successfully, you will be able to view the reports from the Reports and 
Dashboards menu of Data Archive.

Step 6. Create a Report Folder and Publish       109



Step 7. Run a Migrated Report from Data Archive
To test that the reports and catalog have been successfully published to the server, run a test report from 
Data Archive.

1. From Data Archive, select Data Visualization > Reports and Dashboards. 

The Reports and Dashboards window appears.
 

 

2. Select one of the reports within the folder that you migrated and then select Actions > Run Report. 

If the migration was successful, the report appears in view mode.

Migrating Real Path Resources
To migrate real path resources from one environment to another, complete the following tasks:

Step 1. Download the Reports and Catalog
In JReport Designer, download the reports and catalog that you want to migrate. When you download the 
resources, maintain the same directory hierarchy that exists on the JReport server.

1. In JReport Designer, select File > Publish and Download > Download from Server > Download Report 
from Server. 

The Connect to JReport Server window appears.

2. Enter the connection details to connect to the JReport server and click Connect. 

3. Select the directory that contains the reports that you want to download. You can only select one 
directory at a time. 
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4. Click OK. 

5. Select the check box next to the catalog and each report that you want to download for migration. 

6. As a best practice, save the reports and catalog to a directory in the Data Archive installation with the 
same name as the directory that you are downloading from. 

For example, if the directory that contains the reports you want to download is called 
"HEALTHCARE201," append "HEALTHCARE201" to the Download Resource To path.
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7. Click OK. 

8. If you receive a warning that says the path does not exist and asks you if you want to create it, click Yes. 

9. If you receive a Confirm File Replace message, click Yes to All. 

10. When the download is complete, you receive a message asking if you want to download any additional 
resources. 
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11. Verify that the resources you downloaded exist in the path that you provided as the Download Resource 
To location. 

 

 

Step 2. Edit the Catalog Connection Details
Configure JReport Designer to enable inline editing of the catalog. Then, edit the catalog connection details 
according to the target environment connection details.

1. In JReport Designer, click File > Options. 

The Options window appears.

2. Select the Catalog category and deselect the Forbid editing data object properties check box. 

3. Click OK. 

4. Click File > Catalog Management > Open Catalog. 

The Open Catalog File window appears.

5. Navigate to the report folder and select the catalog. 
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6. Click Open. 

The Catalog Browser window appears.

7. Right-click the JDBC connection name and select Edit Connection. 

8. Edit the connection details to match the target connection details. 
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You must modify the following details:

• Name (replace the value but do not alter the syntax)

• URL (replace the value but do not alter the syntax)

• User

• Password

• Included Schema

Step 3. Create a Report Folder and Publish
Create a report folder and then publish the reports and catalog to the target JReport server.

1. In JReport Designer, click File > Publish and Download > Publish to Server > Publish Report to Server. 

The Connect to JReport Server window appears.

2. Enter the connection details for the target JReport server and click Connect. 

 

 

The Publish to JReport Server window appears.

3. Verify that the Publish Resource From box points to the path from which you want to publish the 
resources to the JReport Server. 
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4. Click Browse next to Publish Resource To. 

The Select Folder window appears.

5. Click New Folder and rename the folder with the same name as the target connection 
ARCHIVE_FOLDER_NAME. The names must match exactly, including the case. 
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6. Select the folder you created and click OK. 

7. Deselect all of the reports and leave only the catalog selected. 
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8. Click OK to publish the catalog to the JReport server. 

When the catalog publishes successfully, you receive a message asking if you want to publish additional 
resources. Click No.
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Step 4. Create a Report Folder in the Target File 
System

Create a new directory in the target application file system with the same name that you used to create the 
directory in the JReport server, which also matches the target connection ARCHIVE_FOLDER_NAME. In this 
example you would use the name "HEALTHCARE201."

1. Navigate to <DATA_ARCHIVE>\webapp\visualization\ILM_HEALTHCARE. 

2. Within ILM_HEALTHCARE, create a new directory with the same name as the directory in JReport server/
target connection ARCHIVE_FOLDER_NAME. 

 

 

Step 5. Copy the Reports and Catalog from the 
Source to Target Systems

Copy all the files downloaded from source environment to the newly created folder in the following location: 
{DATA_ARCHIVE}\webapp\visualization\ILM_HEALTHCARE\
{TARGET_CONNECTION_ARCHIVE_FOLDER_NAME}.

Step 6. Map the Folder to the Target File System
In the Data Archive user interface, map the folder you created to the target file system.

1. In Data Archive, click Data Visualization > Advanced Reporting. 

2. Click Public Reports. 
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The report folder that you created in Step 3. should appear within the Public Reports folder. Only the 
published catalog is present inside the report folder. The reports must be manually mapped.

3. Return to Public Reports, hover over the report folder that you created, and click on Properties. 

 

 

The Properties window appears.
 

 

4. Enter the path of the folder that you created in Step 4. for the Resource Real Path and select the "Enable 
Resources from Real Paths" check box. 
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5. Return to Public Reports and click on the folder that you created in Step 4. 

If the mapping is successful, you can view all of the resources present on the file system in the JReport 
server without publishing them.
 

 
The resources that are present in the file system are recognized by the JReport server and the server can 
display the resources in the JReport user interface without publishing. Each resource contains the 
description "report from real path." When resources are published to Jinfonet Server, the description field 
is blank. If the resources are loaded with the real path concept, then Jinfonet adds the "report from real 
path" description. You can use this to identify whether resources are loaded from the file system or 
managed by the JReport server.
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Step 7. Select the Migrated Target Connection in the 
Patient Archives

Validate the migrated reports through the Data Archive user interface.

1. Log in to Data Archive as a user who has permission to access the Patient Archives. 

2. Click Data Visualization > Patient Archives. 

The Select Application window appears. If the mapping was successful, you are able to view the 
application folder that you created.
 

 

Troubleshooting Retirement Archive Projects
The archive job fails at the Copy to Staging step with the following error: Abnormal end unit of work condition occurred.

The archive job fails if the source database is IBM DB2 and the data contains the Decfloat data type.

To resolve this issue, perform the following tasks:

1. Go to Workbench > Manage Retirement Projects.

2. Click the edit icon for the retirement project.

3. Set the Insert Commit Interval value to 1.
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4. Complete the remaining steps in the retirement project to retire the data.
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C h a p t e r  1 0

Integrated Validation for Archive 
and Retirement Projects

This chapter includes the following topics:

• Integrated Validation Overview, 124

• Integrated Validation Process, 125

• Row Checksum, 125

• Column Checksum, 126

• Validation Review, 126

• Enabling Integrated Validation for a Retirement Project, 129

• Enabling Integrated Validation for an Archive Project, 129

• Reviewing the Validation, 130

• Running the Validation Report, 133

• Integrated Validation Standalone Job, 134

Integrated Validation Overview
When you archive or retire an application to the Data Vault, you can enable integrated validation to ensure the 
integrity of the data that you archived or retired. Integrated validation helps you to identify data that might 
have been deleted, truncated, or otherwise changed during the retirement or live archive process.

You can enable integrated validation when you create an archive or retirement project, before you schedule it 
to run. Before the job copies the tables to Data Vault, the integrated validation process uses an algorithm to 
calculate a checksum value for each row and column in the table in the entity. After the job copies the tables 
to Data Vault, the validation process calculates another checksum value for the rows and columns in Data 
Vault. The process then compares the original checksum value of each row and column, to the checksum 
value of each corresponding row and column in Data Vault.

When the comparison is complete, you can review the details of the validation. If a deviation occurs in the 
number of rows, the value of a row, or the value of a column, between the original checksum value and the 
archived or retired checksum value, you can review the details of the deviation. You can select a status for 
each deviated table in the archive job or retirement project. You must provide a justification for the status 
that you select.
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After you review the validation, you can generate a validation report that includes the details of each 
deviation. The validation report also contains a record of any status that you selected when you reviewed the 
deviation, and any justifications that you entered.

You can enable integrated validation for live archive projects that have an Oracle source connection.

You can enable integrated validation for retirement projects that have the following types of source 
connections:

• Oracle

• IBM DB2 for Linux, UNIX, and Windows

• IBM DB2 for z/OS

• Microsoft SQL Server

• IBM AS/400 (System i)

• Informatica PowerExchange

Integrated validation lengthens the retirement process by 40% to 60%.

Integrated Validation Process
1. When you define the application for an archive, archive and purge, or retirement project, enable the 

Integrated Validation option. You must enable the option to run the validation with the archive or 
retirement project.

2. Complete the remainder of the steps required to run an archive job or retirement project, and then 
schedule the project to run. For more information, see the Retiring an Application to Data Vault with On-
Premise Data Archive H2L or Archiving Data from a Custom Application to the Informatica Data Vault H2L.

3. Review the details of the validation for any deviations.

4. After you review the validation, you can optionally generate a validation report.

Row Checksum
During the copy to destination step of the archive or retirement project, the validation process calculates a 
checksum value for each row in every table in the entity.

The process writes the row checksum values to a BCP file that appends the values to the end of each row. 
The process appends the checksum values as a metadata column that is copied to the Data Vault along with 
the table. When the Data Vault loader is finished, Data Vault calculates a second checksum value for each 
row in the archived or retired tables.

The validation process then compares the checksum value written to the BCP file to the checksum value 
calculated by Data Vault. When the checksum comparison is complete, review the validation for any 
deviations that occur between the two checksum values for each row.
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Column Checksum
During the copy to destination step, the validation process calculates a checksum value for each column in 
every table in an entity.

The validation process stores the column checksum values in the ILM repository. When the Data Vault loader 
is finished, Data Vault calculates another checksum value for each column and compares it to the checksum 
value stored in the ILM repository. You can then review the validation for any deviations that occur between 
the two checksum values for each column.

Validation Review
Review the validation process for details of any deviations.

When the checksum comparison for a live archive or retirement project is complete, you can review the 
validation process for details of any deviations that occur. You can select a status for any deviated table and 
provide a justification for the status. If you select rejected for a deviated table, the job remains in a paused 
state. You can also place a deviated table on hold.

When you run a live archive project with integrated validation enabled, you may have to review any deviations 
that occur before the job is complete. If deviations are found during the integrated validation step of a live 
archive project, the integrated validation job step enters a "warning" state and Data Archive pauses the job 
before the delete from source step or purge staging step. Before you can resume the job to continue to the 
delete from source step or purge staging step, you must review the validation and select the accepted status 
for any deviations that exist. If you try to resume the project without accepting the deviations, the job errors 
out.

When you select a status of accepted or rejected for a deviated table, it does not change the data in either 
the source database or the Data Vault. Statuses and justifications are a method of reviewing and 
commenting on deviations that occur. You can also edit a status or justification to change it, for example 
from rejected to accepted.

To review the validation, you must have the Operator role. To select a status for a deviated table, you must 
have the Administrator role. For more information on system-defined roles, see the Informatica Data Archive 
Administrator Guide.

Note: For any validated table, if a difference exists between the number of rows in the source and target, you 
cannot review the table for deviations.

Validation Review User Interface
You can review the validation from the Monitor Jobs page after the archive or retirement job is complete.

The following image shows the Validation Review window:
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At the top of the window, the source connection and target Data Vault folder are listed. For an archive project, 
the job name (generally the definition name plus the entity name) is also listed. For a retirement project, the 
retirement definition is listed.

1. Pie chart that shows the number of tables in the retirement project that passed validation, in addition to 
the number of tables that failed validation.

2. Pie chart that shows the specific actions that you took on the deviated tables. Tables that you have not 
yet taken an action on appear as "pending review."

3. Filter box. Enter the entire filter or part of the filter value in the filter box above the appropriate column 
heading, and then click the filter icon.

4. Filter icon and clear filter icon. After you specify filter criteria in the fields above the column names, click 
the filter icon to display the deviated tables. To clear any filter settings, click the clear filter icon.

5. List of deviated tables. Select the check box on the left side of the row that contains the table you want 
to review.

6. Review button. After you have selected a table to review, click the review button.

The following image shows the Review window:
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1. Validation details, such as the source connection name, target connection name, and table name.

2. Filter box. Enter the entire filter or part of the filter value in the filter box above the appropriate column 
heading, and then click the filter icon.

3. Filter icon and clear filter icon. After you specify filter criteria in the fields above the column names, click 
the filter icon to display the deviated tables. To clear any filter settings, click the clear filter icon.

4. List of deviated rows.

5. Radio buttons that assign a status to the table. Select Accept, Reject, or Hold for Clarifications.

For a deviated table, the Review window lists a maximum of the first 100 deviated rows in Data Vault and the 
first 10 corresponding rows in the source database. For each deviated table, the Review window displays a 
maximum of 10 columns, with a maximum of eight deviated columns and two non-deviated columns.

If all of the columns in a table are deviated, source connection rows are not displayed.

Validation Report Elements
The validation report contains the following elements:

Summary of results

For a retirement project, the summary of results section displays the application name, retirement job ID, 
source database name, and Data Vault archive folder name. For an archive project, the summary of 
results section displays the job name, job ID, source database name, and Data Vault archive folder name. 
The summary of results also displays the login name of the user who ran the archive or retirement 
project, and the date and time that the user performed the validation. If the job contained any deviations, 
the summary of results lists the review result as “failed.” If the job did not contain any deviated tables, 
the review result appears as “passed.”
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Summary of deviations

The summary of deviations section displays pie charts that illustrate the number of deviated tables in 
the archive or retirement job and the type of status that you selected. The section also contains a list of 
the deviated tables, along with details about the tables, for example the row count in the source 
database and in Data Vault.

Detail deviations

The detail deviations section displays details about the deviations that occur in each table included in 
the archive or retirement job. For example, the detail deviations section displays the number of row 
deviations, number of column deviations, and names of the deviated columns on each table. The section 
also displays the number of rows in both the source database and Data Vault, along with any row count 
difference.

Appendix

The appendix section contains a list of the tables in the archive or retirement entity that the validation 
process verified.

Enabling Integrated Validation for a Retirement 
Project

You can enable integrated validation when you create a retirement project. Enable integrated validation if you 
want to run the validation independent of the retirement process, at a later time. You cannot use integrated 
validation on a retirement project that has already been run.

1. Click Workbench > Manage Retirement Projects. 

2. Click New Retirement Project. 

The Create or Edit a Retirement Project window appears.

3. Enter the application details and select the check box next to Use Integrated Validation. 

4. Complete the remainder of the steps required to run a retirement project, then schedule the project to 
run. For more information, see the chapter "Creating Retirement Archive Projects" or the 
Retiring an Application to Data Vault with On-Premise Data Archive H2L. 

5. Click Jobs > Monitor Jobs to monitor the retirement job status and review the validation after the 
process is complete. 

Enabling Integrated Validation for an Archive Project
You can enable integrated validation when you create an archive project.

1. Click Workbench > Manage Archive Projects. 

2. Click New Archive Project. 

The Create or Edit an Archive Project window appears.

3. Enter the application details. For Action, select either Archive or Archive and Purge. Source must be an 
Oracle database and Target must be a Data Vault archive folder. 

4. Select the check box next to Use Integrated Validation and click Next. 
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5. Complete the remainder of the steps required to run an archive project. For more information, see the 
chapter "Creating Data Archive Projects" or the 
Archiving to the Informatica Data Vault for Custom Applications H2L. 

Note: In the Manage Execution window, certain job steps such as the "archive crawler" and "integrated 
validation" job steps appear by default in the archive job steps when integrated validation is enabled. The 
exact steps that appear depend on whether you have selected an archive job or an archive and purge job, 
and whether or not you are using staging. You do not need to schedule any of these steps separately. 
Data Archive runs them as part of the archive process when integrated validation is enabled. You cannot 
run integrated validation as a standalone job for an archive cycle.

 The 
menu that typically allows you to select the order of steps five and six is disabled. When integrated 
validation is enabled, Data Archive runs step five first.

6. Schedule the job to run. 

7. Click Jobs > Monitor Jobs to monitor the archive job status and review the validation after the process is 
complete. If the validation process returns any deviations during an archive and purge job, the job 
pauses and you must review and accept any deviations before you can resume the job and continue to 
the delete from source job step. When you have reviewed and accepted the deviations and resumed the 
job, the job will be in a "Warning" state even after successful completion. You can still use compliance 
features, Data Discovery, and Data Visualization as the data has been successfully archived. 

Reviewing the Validation
You can review the validation from the Monitor Jobs page. If a "Warning" status appears next to the 
integrated validation step of the archive or retirement job, at least one deviation has occurred. If no 
deviations have occurred, the job step displays the "Completed" status. If any deviations occurred during an 
archive and purge job, first review and accept the deviations and then resume the paused job to continue to 
the delete from source step.

1. Click Jobs > Monitor Jobs. 

2. Click the arrow next to the integrated validation job for a retirement project, or the name of the live 
archive project.
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The job step details appear.

3. To expand the job details, click the arrow next to the integrated validation program name.
 

 

4. Click the Review Validation link.
 

 

The Review Validation window opens.

5. To review the deviations for each table, click the check box to the left of the table name and then click 
Review.
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The Review window appears.
 

 

6. To select a status for the deviated table, select the Accept, Reject, or Hold for Clarification option. 

7. Enter a justification for the action in the text box. 

8. Click Apply. 

Note: You can select more than one table at a time and click Review to select the same status for all of 
the selected tables. However, if you select multiple tables you cannot review the deviations for each 
table.
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Running the Validation Report
You can run the validation report from the Monitor Jobs page.

1. Click Jobs > Monitor Jobs. 

2. Click the arrow next to the integrated validation job for a retirement project, or the name of the live 
archive project.
 

 

The job step details appear.

3. To expand the job details, click the arrow next to the integrated validation program name.
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4. Click the View Validation Report link.
 

 

The validation report opens as a PDF file. You can print or save the validation report.

Integrated Validation Standalone Job
If you enable the integrated validation option when you create the retirement project, you can remove the 
integrated validation job from the retirement job flow and run the validation at a later date.

To run the integrated validation independent of the retirement flow, delete the integrated validation job step 
from the retirement project flow before you schedule the retirement project to run. Before you run the job, 
ensure that the source connection is online. Then, when you are ready to run the validation, run the integrated 
validation standalone job.

You can run the integrated validation job only once on a retirement definition.

Running the Integrated Validation Standalone Job
To run the integrated validation standalone job for a retirement project, select the retirement definition and 
schedule the job. You cannot run integrated validation as a standalone job for an archive cycle.

1. Click Jobs > Schedule a Job. 

2. Select Standalone Programs and then click Add Item. 

3. Select the Integrated Validation job and click Select. 

4. Click the list of values button to select the name of the retirement definition. Only retirement projects 
that have not already run the integrated validation are displayed. 

5. Schedule the job to run. 
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C h a p t e r  1 1

Retention Management
This chapter includes the following topics:

• Retention Management Overview, 135

• Retention Management Process, 136

• Retention Management Example, 136

• Retention Policies, 142

• Retention Policy Changes, 148

• Purge Expired Records Job, 152

• Retention Management Reports, 154

• Retention Management when Archiving to EMC Centera, 155

Retention Management Overview
Retention management refers to the process of storing records in the Data Vault and deleting records from 
the Data Vault. The retention management process allows you to create retention policies for records. You 
can create retention policies for records as part of a data archive project or a retirement archive project.

A retention policy is a set of rules that determine the retention period for records in an entity. The retention 
period specifies how long the records must remain in the Data Vault before you can delete them. The 
retention period can be definite or indefinite. Records with definite retention periods have expiration dates. 
You can run the Purge Expired Records job to remove expired records from the Data Vault. Records with 
indefinite retention periods do not expire. You cannot delete them from the Data Vault.

Your organization might require that you enforce different retention rules for different records. For example, 
you might need to retain insurance policy records for five years after the insurance policy termination date. If 
messages exist against the insurance policy, you must retain records for five years after the most recent 
message date in different tables.

Data Archive allows you to create and implement different retention rules for different records. You can 
create a retention policy to addresses all of these needs.
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Retention Management Process
You can create and change retention policies if you have the retention administrator role. You can create 
retention policies in the workbench and when you create a retirement archive project.

If you create retention policies in the workbench, you can use them in data archive projects that archive data 
to the Data Vault. You can also use the policies in retirement archive projects. If you create retention policies 
when you create a retirement archive project, Data Archive saves the policies so that you can use them in 
other archive projects

After you create retention policies, you can use them in archive projects. When you run the archive job, Data 
Archive assigns the retention policies to entities and updates the expiration dates for records. You can 
change the retention periods for archived records through Data Discovery. Change the retention period when 
a corporate retention policy changes, or when you need to update the expiration date for a subset of records. 
For example, an archive job sets the expiration date for records in the ORDERS table to five years after the 
order date. If an order record originates from a particular customer, the record must expire five years after 
the order date or the last shipment date, whichever is greatest.

To use an entity in a retention policy, ensure that the following conditions are met:

• The entity must have a driving table.

• The driving table must have at least one physical or logical primary key defined.

To create and apply retention policies, you might complete the following tasks:

1. Create one or more retention policies in the workbench that include a retention period.

2. If you want to base the retention period for records on a column date or an expression, associate the 
policies to entities.

3. Create an archive project and select the entities and retention policies. You can associate one retention 
policy to each entity.

4. Run the archive job.

Data Archive assigns the retention policies to entities in the archive project. It sets the expiration date 
for all records in the project.

5. Optionally, change the retention policy for specific archived records through Data Discovery and run the 
Update Retention Policy job.

Data Archive updates the expiration date for the archived records.

6. Run the Purge Expired Records job.

Data Archive purges expired records from the Data Vault.

Note: If you have the retention viewer role, you cannot create, edit, or assign retention policies. You can 
perform Data Discovery searches based on retention policy and retention expiration date, and you can view 
the policy details and the table data. For more information on the differences between the retention 
administrator and the retention viewer roles, see the Data Archive Administrator Guide.

Retention Management Example
You can use Data Archive to enforce different retention rules for different records.

For example, a large insurance organization acquires a small automobile insurance organization. The small 
organization uses custom ERP applications to monitor policies and claims. The large organization requires 
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that the small organization retire the custom applications and use its ERP applications instead. After 
acquisition, records managers use Data Archive to create retirement projects for the custom applications.

The large organization must retain records from the small organization according to the following rules:

• By default, the organization must retain records for five years after the insurance policy termination date.

• If messages exist against the insurance policy, the organization must retain records for five years after 
the most recent message date in the policy, messages, or claims table.

• If the organization made a bodily injury payment, it must retain records for 10 years after the policy 
termination date or the claim resolution date, whichever is greatest.

• If a record contains a message and a bodily injury payment, the organization must retain the record 
according to the bodily injury rule.

The small organization stores policy information in the following tables in the AUTO_POLICIES entity:

POLICY Table

Column Description

POLICY_NO Automobile insurance policy number (primary key column)

TERM_DATE Policy termination date

LAST_TRANS Date of last message for the policy

... …

MESSAGES Table

Column Description

MSG_ID Message ID (primary key column)

POLICY_NO Policy number related to the message (foreign key column)

LAST_TRANS_DATE Message date

... …

CLAIMS Table

Column Description

CLAIM_NO Claim number (primary key column)

POLICY_NO Policy number related to the claim (foreign key column)

LAST_DATE Date of last message for the claim

RESOLVE_DATE Claim resolution date

CLAIM_TYPE Claim type: property (1) or bodily injury (2)
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Column Description

CLAIM_AMT Claim damage amount

... …

As a retention administrator for the merged organization, you must create and apply these rules. To create 
and apply the retention management rules, you complete multiple tasks.

Task 1. Create Retention Policies in the Workbench
Create retention policies that you can select when you create the retirement project. Create two retention 
policies. One retention policy has a five year retention period and the other retention policy has a 10 year 
retention period.

1. Select Workbench > Manage Retention Policies. 

The Manage Retention Policies window appears.

2. Click New Retention Policy. 

The New/Edit Retention Policy window appears.

3. Enter the following information: 

Policy Name 5-Year Policy

Retention Period 5 years

4. Click Save. 

Data Archive saves retention policy "5-Year Policy." You can view the retention policy in the Manage 
Retention Policies window.
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5. Repeat steps 2 through 4 and create the following retention policy: 

Policy Name 10-Year Policy

Retention Period 10 years

Data Archive saves retention policy "10-Year Policy." You can view the retention policy in the Manage 
Retention Policies window.

Task 2. Associate the Policies to Entities
The default retention rule for insurance policies specifies that the organization must retain records for five 
years after the insurance policy termination date. To implement this rule, you must associate 5-Year Policy 
with the column that contains the insurance policy termination date.

1. Select Workbench > Manage Retention Policies. 

The Manage Retention Policies window appears.

2. Click Associate to Entity next to retention policy "5-Year Policy." 

The Associate Retention Policy to Entity window appears.

3. Click Add Entity. 

4. Select the custom application and the AUTO_POLICIES entity. 

5. Select the entity table "POLICY" and column "TERM_DATE." 

6. Click Save. 

Data Archive creates a column level association for 5-Year Policy. To indicate that column level retention 
is associated with 5-Year Policy, Data Archive appends the table and column name to the policy name in 
selection lists.

Task 3. Create the Retirement Archive Project
When you create the retirement archive project, select 5-Year Policy for the AUTO_POLICIES entity.

1. Select Workbench > Manage Retirement Projects. 

The Manage Retirement Projects window appears.

2. Click New Retirement Project. 

The New/Edit Retirement Project wizard appears.

3. Enter the custom application name and the retirement date, and then click Next. 

The wizard prompts you for source and target information.

4. Select the application version, the source repository, and the target repository, and then click Next. 
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The wizard prompts you for the entities to include in the project.

5. Click Add Entity. 

The Entity window appears.

6. Select the AUTO_POLICIES entity and click Select. 

The wizard lists the entity that you select.

7. Click Next. 

The wizard prompts you for a retention policy and an access role for the entity.

8. Select retention policy "5-Year Policy POLICY TERM_DATE" for the AUTO_POLICIES entity. 

The wizard displays details about the retention policy. The details include the column and table on which 
to base the retention period.

9. Click Next. 

The wizard prompts you for approval information for the retirement project.

10. Optionally, enter approval information for the project, and then click Next. 

The wizard displays the steps in the retirement archive job.

11. Click Publish. 

Data Archive saves the retirement project. You can view the project in the Manage Retirement Projects 
window.

Task 4. Run the Archive Job
Run the retirement archive job to set the expiration date for all records in the AUTO_POLICIES entity. When 
the job completes, Data Archive sets the expiration date for all records in the entity to five years after the 
date in the POLICY.TERM_DATE column.

1. Select Jobs > Schedule a Job. 

The Schedule Job window appears.

2. In the Projects/Programs to Run area, select Projects, and then click Add Item. 

The Program window appears.

3. Select the retirement archive job, and then click Select. 

Data Archive adds the retirement job to the list of scheduled projects.

4. In the Schedule area, select Immediately. 

5. Click Schedule. 

Data Archive starts the retirement job.
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Task 5. Change the Retention Policy for Specific Archived Records
The retirement archive job sets the expiration date for all records in the AUTO_POLICIES entity to five years 
after the insurance policy termination date. To implement the message and the bodily injury rules, you must 
change the retention policy for records that have messages or bodily injury payments.

1. Select Data Discovery > Manage Retention. 

The Manage Retention window appears.

2. Click the Entities tab. 

3. Click Actions next to entity "AUTO_POLICIES." 

The Associate Retention Policy to Entity window appears.

4. Click Modify Assigned Retention Policy next to retention policy "5-Year Policy." 

The Modify Assigned Retention Policy window appears. It displays the archive folder, existing retention 
policy, and entity name.

5. To select records with messages, enter the following condition: 

MSG_ID Not Null
6. In the New Retention Policy list, select new retention policy "5-Year Policy." 

7. In the Base Retention Period On area, click Add Row and add a row for each of the following columns: 

Entity Table Retention Column

POLICY LAST_TRANS

MESSAGES LAST_TRANS_DATE

CLAIMS LAST_DATE

8. In the Comments field, enter comments about the retention policy changes. 

9. To view the records affected by your changes, click View. 

A list of records that the retention policy changes affect appears. Data Archive lists the current 
expiration date for each record.

10. To submit the changes, click Submit. 

The Schedule Job window appears.

11. Schedule the Update Retention Policy job to run immediately. 

12. Click Schedule. 

Data Archive runs the Update Retention Policy job. For records with messages, it sets the expiration date 
to five years after the last transaction date across the POLICY, MESSAGES, and CLAIMS tables.

13. Repeat steps 1 through 4 so that you can implement the bodily injury rule. 

The Modify Assigned Retention Policy window appears.

14. To select records with bodily injury payments, click Add Row and add a row for each of the following 
conditions: 

• CLAIM_TYPE Equals 2 AND
• CLAIM_AMT Greater Than 0

15. In the New Retention Policy list, select new retention policy "10-Year Policy." 
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16. In the Base Retention Period On area, click Add Row and add a row for each of the following columns: 

Entity Table Retention Column

POLICY TERM_DATE

CLAIMS RESOLVE_DATE

17. Repeat steps 8 through 12 to update the expiration date for records with bodily injury payments. 

Data Archive sets the expiration date to 10 years after the policy termination date or the claim resolution 
date, whichever is greatest.

Note: If a record has a message and a bodily injury payment, Data Archive sets the expiration date according 
to the bodily injury rule. It uses the bodily injury rule because you ran the Update Retention Policy job for this 
rule after you ran the Update Retention Policy job for the message rule.

Task 6. Run the Purge Expired Records Job
To delete expired records from the Data Vault, run the Purge Expired Records job.

1. Select Jobs > Schedule a Job. 

The Schedule Job window appears.

2. In the Projects/Programs to Run area, select Standalone Programs and click Add Item. 

The Program window appears.

3. Select Purge Expired Records and click Select. 

The PURGE_EXPIRED_RECORDS area appears.

4. Enter the Purge Expired Records job parameters. 

5. In the Schedule area, select Immediately. 

6. Optionally, enter notification information. 

7. Click Schedule. 

Data Archive purges expired records from the Data Vault.

Retention Policies
Retention policies consist of retention periods and optional entity associations that determine which date 
Data Archive uses to calculate the expiration date for records. You can create different retention policies to 
address different retention management needs.

Each retention policy must include a retention period in months or years. Data Archive uses the retention 
period to calculate the expiration date for records to which the policy applies. A record expires on its 
expiration date at 12:00:00 a.m. The time is local to the machine that hosts the Data Vault Service. The 
retention period can be indefinite, which means that the records do not expire from the Data Vault.

After you create a retention policy, you can edit it or delete it. You can edit or delete a retention policy if the 
retention policy is not assigned to an archived record or to an archive job that is running or completed. Data 
Archive assigns retention policies to records when you run the archive job.
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To change the retention period for a subset of records after you run the archive job, you can change the 
retention period for the records through Data Discovery.

Entity Association
When you create a retention policy, you can associate it to one or more entities. Entity association identifies 
the records to which the retention policy applies and specifies the rules that Data Archive uses to calculate 
the expiration date for a record.

When you associate a retention policy to an entity, the policy applies to all records in the entity, but not to 
reference tables, if you have not selected the checkbox to update the retention to reference tables. For 
example, you associate a 10 year retention policy with records in the EMPLOYEE entity so that employee 
records expire 10 years after the employee termination date. Each employee record references the DEPT 
table in another entity. The retention policy does not apply to records in the DEPT table reference tables.

For entities with unrelated tables, you can only use an absolute-date based retention policy.

Entities used in a retention policy must have a driving table with at least one physical or logical primary key 
defined.

When you associate a retention policy to an entity, you can configure the following types of rules that Data 
Archive uses to calculate expiration dates:

General Retention

Bases the retention period for records on the archive job date. The expiration date for each record in the 
entity equals the retention period plus the archive job date. For example, records in an entity expire five 
years after the archive job date.

Column Level Retention

Bases the retention period for records on a column in an entity table. The expiration date for each record 
in the entity equals the retention period plus the date in a column. For example, records in the 
EMPLOYEE entity expire 10 years after the date stored in the EMP.TERMINATION_DATE column.

Expression-Based Retention

Bases the retention period for records on a date value that an expression returns. The expiration date for 
each record in the entity equals the retention period plus the date value from the expression. For 
example, records in the CUSTOMER table expire five years after the last order date, which is stored as an 
integer.

General Retention
Configure general retention when you want to base the retention period for records in an entity on the data 
archive job date or on the retirement archive job date. The expiration date for each record in the entity equals 
the retention period plus the archive job date.

When you configure general retention, you can select an indefinite retention period. When you select an 
indefinite retention period, the records do not expire from the Data Vault.

When you configure general retention, all records in the entity to which you associate the policy have the 
same expiration date. For example, you create a retention policy with a five year retention period. In a 
retirement archive project, you select this policy for an entity. You run the archive job on January 1, 2011. 
Data Archive sets the expiration date for the archived records in the entity to January 1, 2016.

You can configure general retention when you select entities in a data archive project or a retirement archive 
project. Select the entity, and then select the retention policy.
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Column Level Retention
Configure column level retention when you want to base the retention period for records in an entity on a date 
column in an entity table. The expiration date for each record in the entity equals the retention period plus the 
date in the column.

When you configure column level retention, each record in an entity has a unique expiration date. For 
example, you create a retention policy with a 10 year retention period and associate it to entity EMPLOYEE, 
table EMP, and column TERM_DATE. In a data archive project, you select this policy for the EMPLOYEE entity. 
Each record in the EMPLOYEE entity expires 10 years after the date in the EMP.TERM_DATE column.

You can configure column level retention in the workbench when you manage retention policies or when you 
change retention policies for archived records in Data Discovery. You can also configure column level 
retention when you select entities in a data archive project or a retirement archive project. Select the entity, 
and then select the retention policy. The retention policy list appends the table and column name to the 
names of retention policies with column level associations. You cannot configure column level retention for 
retention policies with indefinite retention periods.

Expression-Based Retention
Configure expression-based retention when you want to base the retention period for records in an entity on 
an expression date. The expiration date for each record in the entity equals the retention period plus the date 
that the expression returns.

The expression must include statements that evaluate to a column date or to a single date value in DATE 
datatype. It can include all SQL statements that the Data Vault Service supports. The expression can include 
up to 4000 characters. If the expression does not return a date or if the expression syntax is not valid, the 
Update Retention Policy job fails. To prevent the Update Retention Policy job from failing, provide null-
handling functions such as IFNULL or COALESCE in your expressions. This ensures that a suitable default 
value will be applied to records when the expression evaluates to a null or empty value.

The Update Retention Policy job includes the expression in the select statement that the job generates. The 
job selects the records from the Data Vault. It uses the date that the expression returns to update the 
retention expiration date for the selected records. When you monitor the Update Retention Policy job status, 
you can view the expression in the job parameters and in the job log. The job parameter displays up to 250 
characters of the expression. The job log displays the full expression.

Use expressions to evaluate any of the following types of table data:

Dates in integer format

Use the DATE function to evaluate columns that store dates as integers. The function converts the 
integer datatype format to the date datatype format so that the Update Retention Policy job can 
calculate the retention period based on the converted date. The DATE function selects from the entity 
driving table.

To select a column from another table in the entity, use the full SQL select statement. For example, you 
want to set the retention policy to expire records 10 years after the employee termination date. The 
entity driving table, EMPLOYEE, includes the TERM_DATE column which stores the termination date as 
an integer, for example, 13052006. Create a retention policy, and set the retention period to 10 years. 
Add the following expression to the retention policy:

DATE(TERM_DATE,'ddmmyyyy')

When the Update Retention Policy job runs, the job converts 13052006 to 05-13-2006 and sets the 
expiration date to 05-13-2016.
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Dates or other values in tags

Add tags to archived records to capture dates or other values that might not be stored or available in the 
Data Vault. Use an expression to evaluate the tag and set the retention period based on the tag value.

For example, you retired a source application that contained products and manufacturing dates. You 
want to set the expiration date for product records to 10 years after the last manufacturing date. When 
you retired the application, some products were still in production and did not have a last manufactured 
date. To add a date to records that were archived without a last manufacturing date, you can add a tag 
column with dates. Then, define a retention policy and use an expression to evaluate the date tag.

For more information on how to use a tag to set the retention period, see “Using a Tag Column to Set the 
Retention Period ” on page 145.

Data from all tables in the Data Vault archive folder

Use an expression to evaluate table columns across all entities in the Data Vault archive folder. You can 
use a simple SQL statement to evaluate data from one column, or you can use complex SQL statements 
to evaluate data from multiple columns.

For example, you retired an application that contained car insurance policies. An insurance policy might 
have related messages and claims. You want to set the expiration date for insurance policy records to 
five years after the latest transaction date from the POLICY, MESSAGES, or CLAIMS tables. If the 
insurance policy has a medical or property damage claim over $100,000, you want to set the expiration 
date to 10 years.

Note: If you enter a complex SQL statement that evaluates column dates across high-volume tables, you 
might be able to increase query performance by changing the retention policy for specific records. 
Change the retention policy for records and then run the Update Retention Policy job instead of entering 
an expression to evaluate date columns across tables. Data Archive can generate SQL queries which run 
more quickly than user-entered queries that perform unions of large tables and contain complex 
grouping.

You can configure expression-based retention in the workbench when you manage retention policies or when 
you change retention policies for archived records in Data Discovery. The retention policy list in Data 
Discovery appends "(Expression)" to the names of retention policies with expression-based associations. You 
cannot configure expression-based retention for retention policies with indefinite retention periods.

Using a Tag Column to Set the Retention Period
You can set the retention period for records based on the value in a tag column. You use a tag column if you 
archived records without a value, such as a date, that you can base the retention period on.

The following task flow explains how to use a tag column to set an expression-based retention period.

1. Add a tag column to the table that holds the transaction key. 

a. Specify the Date data type for the tag. 

b. Enter a date for the tag value. 

For more information about adding a tag, see “Adding Tags” on page 181.

2. Determine the database name of the tag. 

a. Select Data Discovery > Browse Data. 

b. Move all the ilm_metafield# columns from the Available Columns list to the Display Columns list. 

c. Click Search. 

d. Browse the results to determine the name of the tag column that contains the value you entered. For 
example, the name of the tag column is ilm_metafield1. 
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3. Create a retention policy. 

For more information about creating a retention policy, see “Creating Retention Policies” on page 147.

4. Associate the retention policy to the entity. 

a. Select the entity table with the date tag. 

b. Enter an expression such as the following sample expression in the Expression dialog box: 

IFNULL(<name of the date column>, IFNULL(<name of the date tag column>, TODAY()))
For example, you set the retention policy to 10 years. You want to base the retention period on the 
last manufacturing date. If a record does not have the last manufacturing date, you want to base 
your retention period on the tag date. If a record does not have a tag date, you want to use today's 
date. Use the following expression:

IFNULL(LAST_MANUFACTURING_DATE, IFNULL(ILM_METAFIELD1,TODAY()))
In this example, the retention expiration date is set to 10 years after the last manufacturing date. If 
the record has a null value instead of a date in the last manufacturing date field, then the retention 
expiration date is set to 10 years after the date in the date tag column. If the record has a null value 
in the date tag column, the retention expiration date is set to 10 years after today's date.

For more information about associating a retention policy to an entity, see “Associating Retention 
Policies to Entities” on page 147.

Retention Policy Properties
Enter retention policy properties when you create a retention policy in the workbench.

The following table describes the retention policy properties:

Property Description

Policy name Name of the retention policy. Enter a name of 1 through 30 characters.
The name cannot contain the following special characters:
, < >

Description Optional description for the retention policy.
The description cannot contain the following special characters:
, < >

Retention period The retention period in months or years. Enter a retention period or enable the Retain 
indefinitely option.

Retain indefinitely If enabled, the records to which the retention property applies do not expire from the Data Vault. 
Enter a retention period or enable the Retain indefinitely option.

Records 
management ID

Optional string you can enter to associate the retention policy with the policy ID from a records 
management system. You can use the records management ID to filter the list of retention 
policies in Data Discovery. You can enter any special character except the greater than 
character (>), the less than character (<), or the comma character ( ,).
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Creating Retention Policies
Create retention policies from the workbench. You can also create retention policies when you create a 
retirement archive project.

1. Select Workbench > Manage Retention Policies. 

The Manage Retention Policies window appears.

2. Click New Retention Policy. 

The New/Edit Retention Policy window appears.

3. Enter the retention policy properties. 

4. Click Save. 

Data Archive lists the retention policy in the Manage Retention Policies window.

Associating Retention Policies to Entities
Associate retention policies to entities to configure column-level or expression-based retention. You can 
associate a retention policy to multiple entities, columns, and expressions. You cannot associate a retention 
policy with an indefinite retention period to an entity.

Note: If you select column-level retention, you must select a table in the entity and a column that contains 
date values. If you select expression-based retention, you must select a table in the entity and enter an 
expression.

1. Select Workbench > Manage Retention Policies. 

The Manage Retention Policies window appears.

2. Click Associate to Entity next to the retention policy you want to associate. 

The Associate Retention Policy to Entity window appears.

3. Click Add Entity. 

4. Select an application from the Application Module list of values. 

5. Select the entity from the Entity Name list of values. 

6. To configure column-level retention, you must select an entity table and a column that contains date 
values. 

a. Select a table from the Entity Table list of values. 

b. Select a column that contains date values from the Retention Column list of values. 

The Retention Column list displays date columns that are not null.

c. Click Save. 

Repeat step 6 to associate the retention policy with another column.

7. To configure expression-based retention, you must select an entity table and enter an expression. 

a. Select a table from the Entity Table list of values. 

b. Click the icon in the Expression column. 

c. Enter the expression in the Expression dialog box. 

The Expression icon turns green to indicate that expression-based retention is configured for the 
entity association.

d. Click Save. 

Repeat step 7 to associate the retention policy with another expression.
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If the expression needs to evaluate a tag value, you must use the name of the tag column as it appears 
in the database. The following steps shows how you can determine the name of the tag column:

a. Select Data Discovery > Browse Data. 

b. Select the archive folder, schema, and table. 

c. Select all the tag columns, ilm_metafield1 to ilm_metafield9, from the Data Columns section and 
move them to the Display Columns section using the > arrow. Click Search. 

d. In the Results section, note the name of the tag column that contains the appropriate tag values. 

Retention Policy Changes
You can change the retention policy assigned to specific records in an entity after you run a data archive job 
or a retirement archive job. Change the retention policy when you want to update the expiration date for any 
record in the entity.

For example, you assign a five-year retention policy to automobile insurance policies in a retirement archive 
job so that the records expire five years after the policy termination date. However, if messages exist against 
the insurance policy, you must retain records for five years after the most recent message date in the policy, 
claims, or client message table.

You change the assigned retention policy through Data Discovery. You cannot edit or delete retention policies 
in the workbench if the policies are assigned to archived records or to archive jobs that are running or 
completed.

Before you change a retention policy for any record, you might want to view the records assigned to the 
archive job. When you view records, you can check the current expiration date for each record.

To change the retention policy for records, you must select the records you want to update and define the 
new retention period. After you change the retention policy, schedule the Update Retention Policy job to 
update the expiration date for the records in the Data Vault.

Record Selection for Retention Policy Changes
When you change the retention policy assigned to records in an entity, you must select the records you want 
to update. Select the records to update when you modify the assigned retention policy in Data Discovery.

To select records to update, you must specify the conditions to which the new retention policy applies. Enter 
each condition in the format "<Column><Operator><Value>." The Is Null and Not Null operators do not use 
the <Value> field.

For example, to select insurance records in an entity that have messages, you might enter the following 
condition:

MSG_ID Not Null

You can specify multiple conditions and group them logically. For example, you want to apply a retention 
policy to records that meet the following criteria:

JOB_ID > 0 AND (CLAIM_TYPE = 1 OR CLAIM_NO > 1000 OR COMPANY_ID = 1007)

Enter the following conditions:

JOB_ID Greater Than 0 AND 
( CLAIM_TYPE Equals 1 OR 
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CLAIM_NO Greater Than 1000 OR 
COMPANY_ID Equals 1007 ) 

Use the following guidelines when you specify the conditions for record selection:

Enclose string and varchar values in single quotes.

For example, to select insurance records with policy numbers that begin with "AU-," enter the following 
condition:

POLICY_NO Starts With 'AU-'

Specify case-sensitivity for string comparisons.

By default, Data Archive performs case-sensitive string comparisons. To ignore case, enable the Case 
Insensitive option.

You can specify that a condition is within a range of values.

Use the In operator to specify that a condition is within a range of comma-separated values, for example, 
CLAIM_CLASS IN BD1, BD2. Do not enclose the list of values in parentheses.

You can specify multiple conditions.

Use the Add Row button to add additional conditions.

You can group conditions.

If you specify multiple conditions, you can group them with multiple levels of nesting, for example, "(A 
AND (B OR C)) OR D." Use the Add Parenthesis and Remove Parenthesis buttons to add and remove 
opening and closing parentheses. The number of opening parentheses must equal the number of closing 
parentheses.

Retention Period Definition for Retention Policy Changes
When you change the retention policy assigned to records in an entity, you must define a new retention 
period for the records you want to update. Define the new retention period when you modify the assigned 
retention policy in Data Discovery.

To define the new retention period, select the new retention policy and enter rules that determine which date 
Data Archive uses to calculate the expiration date for records. The expiration date for records equals the 
retention period plus the date value that is determined by the rules you enter.

You can enter the following types of rules:

Relative Date Rule

Bases the retention period for records on a fixed date. For example, you select a retention policy that has 
a 10 year retention period. You enter January 1, 2011, as the relative date. The new expiration date is 
January 1, 2021.

Column Level Rule

Bases the retention period for records on a column date. For example, you select a retention policy that 
has a five year retention period. You base the retention period on the CLAIM_DATE column. Records 
expire five years after the claim date.

Expression-Based Rule

Bases the retention period for records on the date returned by an expression. For example, you select a 
retention policy that has a five year retention period. You want to base the retention period on dates in 
the CLAIM_DATE column, but the column contains integer values. You enter the expression 
TO_DATE(CLAIM_DATE,'ddmmyyyy'). Records expire five years after the claim date.
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The rules you enter must evaluate to a single date value or to a column date. If you enter multiple rules, you 
cannot select a relative date. You must select the maximum date or the minimum date across all rules.

For example, you have a five-year retention policy for insurance records that retires records five years after 
the last transaction date. You want to select the last transaction date from three tables and apply the new 
retention policy using that date.

The following entity tables contain the last transaction date:

• Policy.LAST_TRANS

• Messages.LAST_TRANS_DATE

• Claims.LAST_DATE

To select the last transaction date across tables, complete the following tasks:

1. Select the five-year retention policy as the new retention policy.

2. In the Base Retention Period On area, add a row for each column:

Entity Table Retention Column

Policy LAST_TRANS

Messages LAST_TRANS_DATE

Claims LAST_DATE

3. In the By evaluating the list, select Maximum.

When you update the retention policy, you can select a checkbox to generate a retention modification report 
that is accessible from the Monitor Jobs page. You can also select a checkbox to include the reference 
tables in the retention update.

Update Retention Policy Job
The Update Retention Policy job updates the expiration date for records in the Data Vault. Schedule the 
Update Retention Policy job after you change the retention policy for specific records in Data Discovery.

The Update Retention Policy job selects records from the Data Vault based on the conditions you specify 
when you change the retention policy. It uses the date value determined by the rules you enter to update the 
retention expiration date for the selected records. If you change the retention policy for a record using an 
expression-based date, the Update Retention Policy job includes the expression in the SELECT statement that 
the job generates.

When you run the Update Retention Policy job, you can monitor the job status in the Monitor Job window. You 
can view the WHERE clause that Data Archive uses to select the records to update. You can also view the old 
and new retention policies. If you change the retention policy for a record using an expression-based date, 
you can view the expression in the job parameters and in the job log. The job parameter displays up to 250 
characters of the expression. The job log displays the full expression.

When you monitor the Update Retention Policy job status, you can also generate the Retention Modification 
Report to display the old and new expiration date for each affected record. The report is created with the Arial 
Unicode MS font. To generate the report, you must have the font file ARIALUNI.TTF saved in the <Data 
Archive installation>\webapp\WEB-INF\classes directory. To view the report, you must have the retention 
administrator role and permission to view the entities that contain the updated records.

To schedule the Update Retention Policy job, click Submit in the Modify Assigned Retention Policy window. 
The Schedule Job window appears. You schedule the job from this window.
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Viewing Records Assigned to an Archive Job
After you run an archive job, you can view the archived records. You can view all records associated with the 
archive job. Data Archive displays the current expiration date for each record.

1. Select Data Discovery > Manage Retention. 

The Manage Retention window appears.

2. Click the Retention Policies tab or the Entities tab. 

3. Click Actions next to the retention policy name or the entity name. 

The Assigned Entities window or the Assigned Retention Policy window appears.

4. Click the open button (>) next to the entity name or the retention policy name. 

The list of jobs associated with the retention policy and the entity appears.

5. To view archive criteria for the job, click Archive Criteria next to the job name. 

The archive criteria window lists the archive criteria for the job. Click Close to close the window.

6. To view records assigned to the job, click View Records next to the job name. 

Data Archive displays the list of records with the current expiration dates.

Changing Retention Policies for Archived Records
After you run an archive job, you can change the retention policy for any archived record. Change the 
assigned retention policy through Data Discovery. You cannot change the assigned retention policy in the 
workbench if the policy is assigned to archived records or to archive jobs that are running or completed.

1. Select Data Discovery > Manage Retention. 

The Manage Retention window appears.

2. Click the Retention Policies tab or the Entities tab. 

3. Click Actions next to the retention policy name or the entity name. 

The Assigned Entities window or the Assigned Retention Policy window appears.

4. To change the retention policy for records that a specific job archived, click the open button (>) next to 
the entity name or the retention policy name. 

The list of jobs associated with the retention policy and the entity appears.

5. Click Modify Retention Policy next to the retention policy, entity, or job name. 

The Modify Assigned Retention Policy window appears. It displays the archive folder, existing retention 
policy, and entity name.

6. To select the records that you want to update, enter the conditions to which the new retention policy 
applies. 

7. Select the new retention policy and enter the rules that define the new retention period: 

• To add a relative date rule, select a date from the Relative to field.

• To add a column level rule, add a row in the Base Retention Period On area, and select the table and 
column.

• To add an expression-based rule, add a row in the Base Retention Period On area. Click the 
Expression icon in the row, enter the expression in the Expression dialog box, and click Save. The 
Expression icon turns green to indicate that an expression is configured.

8. If you enter multiple rules, select the maximum date or minimum date in the By evaluating the list. 

9. Enter comments about the retention policy changes. 
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10. To view the records affected by your changes, click View. 

A list of records that the retention policy changes affect appears. Data Archive lists the current 
expiration date for each record.

11. To submit the changes, click Submit. 

The Schedule Job window appears.

12. Schedule the Update Retention Policy job and select the notification options. 

13. Click Schedule. 

Data Archive starts the job according to the schedule.

14. To view the Retention Expiration report, click Jobs > Monitor Jobs, select the Update Retention Policy 
job, and click Retention Expiration Report. 

Purge Expired Records Job
The Purge Expired Records job purges records that are eligible for purge from the Data Vault. A record is 
eligible for purge when the retention policy associated with the record has expired and the record is not under 
legal hold. Create and assign retention policies before you run the Purge Expired Records job.

Run the Purge Expired Records job to perform one of the following tasks:

• Generate the Retention Expiration report. The report shows the number of records that are eligible for 
purge in each table. When you schedule the purge expired records job, you can configure the job to 
generate the retention expiration report, but not purge the expired records.

• Generate the Retention Expiration report and purge the expired records. When you schedule the purge 
expired records job, you can configure the job to pause after the report is generated. You can review the 
expiration report. Then, you can resume the job to purge the eligible records.

When you run the Purge Expired Records job, by default, the job searches all entities in the Data Vault archive 
folder for records that are eligible for purge. To narrow the scope of the search, you can specify a single 
entity. The Purge Expired Records job searches for records in the specified entity alone, which potentially 
decreases the amount of time in the search stage of the purge process.

To determine the number of rows in each table that are eligible for purge, generate the detailed or summary 
version of the Retention Expiration report. To generate the report, select a date for Data Archive to base the 
report on. If you select a past date or the current date, Data Archive generates a list of tables with the number 
of records that are eligible for purge on that date. You can pause the job to review the report and then 
schedule the job to purge the records. If you resume the job and continue to the delete step, the job deletes 
all expired records up to the purge expiration date that you used to generate the report. If you provide a future 
date, Data Archive generates a list of tables with the number of records that will be eligible for purge by the 
future date. The job stops after it generates the report.

You can choose to generate one of the following types of reports:
Retention Expiration Detail Report

Lists the tables in the archive folder or, if you specified an entity, the entity. Shows the total number of 
rows in each table, the number of records with an expired retention policy, the number of records on 
legal hold, and the name of the legal hold group. The report lists tables by retention policy.

Retention Expiration Summary Report

Lists the tables in the archive folder or, if you specified an entity, the entity. Shows the total number of 
rows in each table, the number of records with an expired retention policy, the number of records on 
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legal hold, and the name of the legal hold group. The report does not categorize the list by retention 
policy.

The reports are created with the Arial Unicode MS font. To generate the reports, you must have the font file 
ARIALUNI.TTF saved in the <Data Archive installation>\webapp\WEB-INF\classes directory.

To purge records, you must enable the purge step through the Purge Deleted Records parameter. You must 
also provide the name of the person who authorized the purge.

Note: Before you purge records, use the Search Within an Entity in Data Vault search option to review the 
records that the job will purge. Records that have an expired retention policy and are not on legal hold are 
eligible for purge.

When you run the Purge Expired Records job to purge records, Data Archive reorganizes the database 
partitions in the Data Vault, exports the data that it retains from each partition, and rebuilds the partitions. 
Based on the number of records, this process can increase the amount of time it takes for the Purge Expired 
Records job to run. After the Purge Expired Records job completes, you can no longer access or restore the 
records that the job purged.

Note: If you purge records, the Purge Expired Records job requires staging space in the Data Vault that is 
equal to the size of the largest table in the archive folder, or, if you specified an entity, the entity.

Purge Expired Records Job Parameters
The following table describes the parameters for the Purge Expired Records job:

Parameter Description Required or 
Optional

Archive Store The name of the archive folder in the Data Vault that contains the records that 
you want to delete.
Select a folder from the list.

Required.

Purge Expiry 
Date

The date that Data Archive uses to generate a list of records that are or will be 
eligible for delete.
Select a past, the current, or a future date.
If you select a past date or the current date, Data Archive generates a report 
with a list of all records eligible for delete on the selected date. You can pause 
the job to review the report and then schedule the job to purge the records. If 
you resume the job and continue to the delete step, the job deletes all expired 
records up to the selected date.
If you select a future date, Data Archive generates a report with a list of 
records that will be eligible for delete by the selected date. However, Data 
Archive does not give you the option to delete the records.

Required.

Report Type The type of report to generate when the job starts.
Select one of the following options:
- Detail. Generates the Retention Expiration Detail report.
- None. Does not generate a report.
- Summary. Generates the Retention Expiration Summary report.

Required.

Pause After 
Report

Determines whether the job pauses after Data Archive creates the report. If you 
pause the job, you must resume it to delete the eligible records.
Select Yes or No from the list.

Required.
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Parameter Description Required or 
Optional

Entity The name of the entity with related or unrelated tables in the Data Vault archive 
folder.
To narrow the scope of the search, select a single entity.

Optional.

Purge Deleted 
Records

Determines whether to delete the eligible records from the Data Vault.
Select Yes or No from the list.

Required.

Email ID for 
Report

Email address to which to send the report. Optional.

Purge Approved 
By

The name of the person who authorized the purge. Required if you 
select a past 
date or the 
current date for 
Purge Expiry 
Date.

Running the Purge Expired Records Job
To purge records in the Data Vault that are eligible for purge, run the Purge Expired Records job.

1. Select Jobs > Schedule a Job. 

The Schedule Job window appears.

2. In the Projects/Programs to Run area, select Standalone Programs and click Add Item. 

The Program window appears.

3. Select Purge Expired Records and click Select. 

The PURGE_EXPIRED_RECORDS area appears.

4. Enter the Purge Expired Records job parameters. 

5. In the Schedule area, select the appropriate options. 

6. Optionally, enter notification information. 

7. Click Schedule. 

Data Archive deletes the expired records from the Data Vault.

Retention Management Reports
You can generate retention management reports when you run the Update Retention Policy job or the Purge 
Expired Records job. To view retention management reports, you must have the retention administrator role 
and permission to view the entities.

Note: The reports are created with the Arial Unicode MS font. To generate the reports, you must have the font 
file ARIALUNI.TTF saved in the <Data Archive installation>\webapp\WEB-INF\classes directory.

You can generate the following reports:
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Retention Modification Report

The Retention Modification Report displays information about records affected by retention policy 
changes. The report displays the old and new retention policies, the rules that determine the expiration 
date for records, and the number of affected records. The report also lists each record affected by the 
retention policy change.

Generate a Retention Modification report from the Monitor Jobs window when you run the Update 
Retention Policy job.

Retention Expiration Summary Report

The Retention Expiration Summary Report displays information about expired records. The report 
displays the total number of expired records and the number of records on legal hold within a retention 
policy. It also displays the number of expired records and the number of records on legal hold for each 
entity.

Generate a Retention Expiration Summary report from the Monitor Jobs window when you run the Purge 
Expired Records job.

Retention Expiration Detail Report

If your records belong to related entities, the Retention Expiration Detail report lists expired records so 
you can verify them before you purge expired records. The report displays the total number of expired 
records and the number of records on legal hold within a retention policy. For each expired record, the 
report shows either the original expiration date or the updated expiration date. It shows the updated 
expiration date if you change the retention policy after Data Archive assigns the policy to records.

If your records belong to unrelated entities, the Retention Expiration Detail report displays the total 
number of expired records and the number of records on legal hold within a retention policy. It does not 
list individual records.

Generate a Retention Expiration Detail report from the Monitor Jobs window when you run the Purge 
Expired Records job.

Retention Management when Archiving to EMC 
Centera

Use the informia.defaultArchiveAreaRetention property in the conf.properties file to set the default 
retention period for an archive area. Retention policies are enforced at the record or the transaction level.

You might need to change the default retention period for an archive area for certain Centera versions, such 
as Compliance Edition Plus. Some Centera versions do not allow you to delete a file if it is within an archive 
area that has indefinite retention. You cannot delete the file even if all records are eligible for expiration.

You can choose immediate expiration or indefinite retention. Specify the retention period in days, months, or 
years. The retention period determines when the files are eligible for deletion. The default retention period 
applies to any archive area that you create after you configure the property. When you create an archive area, 
the Data Vault Service uses the retention period that you configure in the properties file. The Data Vault 
Service enforces the record level policy based on the entity retention policy that you configure in Data 
Archive.

Retention Management when Archiving to EMC Centera       155



C h a p t e r  1 2

External Attachments
This chapter includes the following topics:

• External Attachments Overview, 156

• Archive External Attachments to a Database, 156

• Archive or Retire External Attachments to the Data Vault, 157

External Attachments Overview
External attachments are transaction-related attachments that are stored in the production database. You 
can archive encrypted or unencrypted external attachments to the target database or the Data Vault. External 
attachments can be archived with the data you want to archive or retire, or independent of their associated 
data.

If you want to archive or retire encrypted external attachments, such as Siebel attachments, to the Data Vault, 
you can use the Data Vault Service for External Attachments (FASA) to convert encrypted attachments from 
the proprietary format. You can then access the decrypted external attachments through the Data Discovery 
portal.

Archive External Attachments to a Database
To archive external attachments, you must first configure properties in the source connection. You can then 
archive the attachments with the associated data or after you have archived the associated data.

You can move external attachments to the target database synchronously or asynchronously. If you archive 
external attachments synchronously, the ILM Engine archives the external attachments with the associated 
data when you run an archive job. If you have already archived the associated data, you can move the 
external attachments asynchronously from source to target with the Move External Attachments job.

You can archive either encrypted or unencrypted attachments to a database. When you archive encrypted 
external attachments, FASA is not required because the files are stored in tables.

Before you run an archive job or a Move External Attachments job, configure the following properties in the 
source connection to archive external attachments:

Source/Staging Attachment location

Source location of the external attachments. Enter the directory where the attachments are stored on the 
production server. You must have read access on the directory.
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Target Attachment location

Target location for the external attachments. Enter the folder where you want to archive the external 
attachments. You must have write access on the directory.

Move Attachments in Synchronous Mode

Moves the attachments synchronously with the archive job. If you want to archive the external 
attachments with the associated data when you run an archive job, select this checkbox.

Archive Job Id

Include the Job Id of the archive or restore job to move external attachments asynchronously.

Archive or Retire External Attachments to the Data 
Vault

You can archive or retire external attachments to the Data Vault. To archive external attachments to the Data 
Vault, you must also archive the associated data. You can access external attachments through the Data 
Discovery Portal after you archive or retire them.

To archive external attachments to the Data Vault, the attachment locations must be available to both the 
ILM Engine and the Data Vault Service. If the external attachments are encrypted, such as Siebel 
attachments, you must configure FASA to decrypt the attachments. Before you run the archive or retirement 
job, configure the source and target connections.

If your environment is configured for live archiving, you must also create and configure an interim table in the 
Enterprise Data Manager for the attachments.

If you plan to retire all of the external attachments in the directory, you do not need to configure an interim 
table in the EDM. If you want to retire only some of the external attachments in the directory, you must 
configure an interim table in the EDM and add a procedure to the Run Procedure in Generate Candidates step 
of the archive job.

If you configured the source connection to move the attachments synchronously with the archive or 
retirement job, run the Load External Attachments job after the archive job finishes. The Load External 
Attachments job loads the attachments to the Data Vault.

If you did not move the attachments synchronously with the archive job, run the Move External Attachments 
standalone job after you run the archive job. The Move External Attachments job moves the attachments to 
the interim attachment table. You can then load the attachments to the Data Vault with the Load External 
Attachments job.

After you archive the external attachments, you can view the attachments in the Data Discovery Portal. To 
view the archived external attachments, search the Data Vault for the entity that contains the attachments. 
You cannot search the contents of the external attachments.

Step 1. Configure Data Vault Service for External Attachments
If you want to archive encrypted external attachments to the Data Vault, configure the Data Vault Service for 
External Attachments (FASA) on the production server.

1. Install File_Archive_service_for_attachments.zip on the production server where the source ERP is 
running.

2. Open the configurations.properties file in the installation directory.
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3. Configure the following properties:

• ZIP.UTILITY. Zip utility name and location.

For example, \\siebsrvr\\BIN\\ssezipXX.exe where XX is the utility version.

• UNZIP.UTILITY. Unzip utility name and location.

For example, \\siebsrvr\\BIN\\sseunzipXX.exe where XX is the utility version.

• PROD.FILE.LOCATION. Production file system location.

• ARCHIVE.FILE.LOCATION. Archive file system location.

• TEMP.FOLDER.LOCATION. Temporary folder location that is required for storing the .bat and .sh 
files in the decryption script.

4. Change the port number in the conf.properties file and start FASA.

5. To verify that FASA is running, enter the port number in a browser window. If the FASA server is running, 
you will receive a confirmation message.

Step 2. Configure the Source Connection
Before you archive or retire external attachments, configure source connection properties.

1. Create or update the source connection. 

• To create a connection, click Administration > New Source Connection.

• To update a connection, click Administration > Manage Connections.

2. In the source connection, configure the following properties: 

• Source/Staging Attachment Location. Source location of the external attachments. Enter the 
directory where the attachments are stored on the production server. You must have read access on 
the directory.

• Target Attachment Location. Target location for the external attachments. Enter the archive folder 
where you want to archive the external attachments. You must have write access on the directory.

3. If the attachments are encrypted, enter the location of the temporary folder you designated for the 
decryption script in the Staging Script Location field. 

4. If you want to move the attachments to the interim attachment table during the archive or retirement job 
run, select Move Attachments in Synchronous Mode. 

Step 3. Configure the Target Connection
If the attachments are encrypted, configure the target connection for decryption.

1. Create or update the target connection. 

• To create a connection, click Administration > New Target Connection.

• To update a connection, click Administration > Manage Connections.

2. In the Add On URL field, enter the FASA URL. 
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Step 4. Configure the Entity in the Enterprise Data Manager
To perform a live archive, or retire only some of the attachments in the directory, configure the attachment 
entity in the EDM. Skip this step if you plan to retire all of the attachments in the directory.

Create an interim table with additional columns to archive external attachments. Then modify the entity steps 
to move the attachments. The archive job moves the attachments during the Generate Candidates step.

1. To launch the EDM, click Accelerators > Enterprise Data Manager. 

2. Right-click the entity that contains the external attachments you want to archive. 

3. Select New Interim Table. 

4. Enter a description for the interim table and click Finish. 

5. On the Default Columns tab of the interim table, add the following columns: 

• ATTACHMENT_NAME. In the Select clause column, enter the following string:
'S_ORDER_ATT' || '_' || Z.ROW_ID || '_' || Z.FILE_REV_NUM || '.' || Z.FILE_EXT

• ZIPPED_FILE_EXT. In the Select clause column, enter "SAF".

Interim table configuration is complete.

6. Select the entity that contains the external attachments you want to archive. 

7. To retire only some of the files in the directory, locate the attachments interim table on the Steps tab and 
select the step called Run Procedure in Generate Candidates. 

8. Enter the following text in the Procedure column: java://
com.applimation.archive.dao.impl.MoveFileDAOImpl 

Step 5. Archive or Retire External Attachments
To archive or retire the attachments synchronously, run the archive job and then load the external 
attachments to the Data Vault. To archive the attachments asynchronously, run the archive or retirement job 
and then move the attachments to the interim attachment table before you archive or retire them.

Archiving or Retiring External Attachments Synchronously
1. Run the archive or retirement job. 

The attachments will be moved from the source directory to the interim attachment table during the job 
run.
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2. Run a Load External Attachments job to archive the attachments to the Data Vault. When you schedule 
the Load External Attachments job, configure the following parameters: 

Directory 

The source location of the attachments. If the attachments are not encrypted, this directory must be 
accessible to both the ILM Engine and the Data Vault Service.

Attachment Entity Name 

The name of the attachment entity.

Target Archive Store 

The target connection used to archive the application data. The Target Archive Store parameter ensures 
that the attachments are archived to the same Data Vault archive folder as the application data.

Purge After Load 

If you want the job to delete the attachments you are loading to the Data Vault, select Yes. The job 
deletes the contents of the directory that you specified in the Directory parameter.

Archiving or Retiring External Attachments Asynchronously
1. Run the archive or retirement job. 

2. Run a Move External Attachments standalone job. To move external attachments asynchronously, 
configure the following parameters: 

Add on URL 

FASA URL.

Archive Job Id 

Job ID of the completed archive or retirement job.

The Move External Attachments job moves the attachments from the source directory to the interim 
directory in the attachment entity.

3. To move the attachments to the Data Vault, run a Load External Attachments job. 

Step 6. View Attachments in the Data Discovery Portal
To confirm the attachments were retired, view them in the Data Discovery Portal.

1. Click Data Discovery > Search Data Vault. 

2. In the Entity field, select the entity containing the attachments you retired and click View. 

The Results table appears.

3. Click the icon beneath View Archived Data. 
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C h a p t e r  1 3

Data Archive Restore
This chapter includes the following topics:

• Data Archive Restore Overview, 161

• Restore Methods, 161

• Data Vault Restore, 162

• Data Vault Restore to an Empty Database or Database Archive, 162

• Data Vault Restore to an Existing Production Database, 163

• Database Archive Restore, 165

• External Attachments Restore, 167

Data Archive Restore Overview
If you need to modify an archived transaction, or if a cycle was archived in error, you can restore the data 
from the archive. When you restore data, Data Archive reverses the actions that it used to archive the data.

You can restore data from the Data Vault or a database archive. You can restore data from the Data Vault to 
an empty or existing production database or to a database archive. You can restore data from a database 
archive to an empty or existing database, including the original source.

You can also restore external attachments that have been archived to a database archive or the Data Vault. 
Data Archive restores external attachments as part of a restore job from either a database or the Data Vault.

By default, when you restore data from a database archive or the Data Vault, Data Archive deletes the data 
from the archive location. If you restore a cycle or transaction, you can choose to keep the restored data at 
the archive location.

Restore Methods
You can run a transaction or cycle restore from either the Data Vault or a database archive. You can only 
perform a full restore from a database archive.

You can perform a restore job using the following methods:
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Full restore

A full restore job restores the entire contents of a database archive. You might perform a full restore if 
you archived an entire database that must be returned to production. For optimal performance, conduct 
a full restore to an empty database. Performance is slow if you run a full restore to the original database.

Data Archive deletes the restored data from the database archive as part of the full restore job.

Cycle restore

A cycle restore job restores an archive cycle. You might restore an archive cycle if a cycle was archived 
in error, or if you must change numerous transactions in a cycle. To restore a cycle you must know the 
cycle ID. A cycle restore can also restore a specific table. To restore a specific table, use the Enterprise 
Data Manager to create an entity containing the table you want to restore.

By default, Data Archive deletes the restored data from the database archive or the Data Vault as part of 
the cycle restore job. If you do not want the restore job to delete the data from the archive location, you 
can specify that the restore job skip the delete step.

Transaction restore

A transaction restore job restores a single transaction, such as a purchase order or invoice. To restore a 
transaction, you must search for it by the entity name and selection criteria. If your search returns 
multiple transactions, you can select multiple transactions to restore at the same time.

By default, Data Archive deletes the restored data from the database archive or the Data Vault as part of 
the transaction restore job. If you do not want the restore job to delete the data from the archive 
location, you can specify that the restore job skip the delete step.

Data Vault Restore
You can restore data from the Data Vault to a database archive or a production database. A production 
database can be either empty or existing. Data can be restored as either an archive cycle, a single 
transaction, or multiple transactions. You can also restore a specific table with the cycle restore feature.

You cannot restore archive only cycles from the Data Vault. Only archive and purge cycles can be restored 
from the Data Vault.

When you restore from the Data Vault, determine the type of target for the restore job:

• Restore to an empty production database or database archive.

• Restore to an existing production database without schema differences.

• Restore to an existing production database with schema differences.

Data Vault Restore to an Empty Database or 
Database Archive

Before you restore data to an empty production database or database archive, you must run the metadata 
DDL on the target database. You can then run either a cycle or transaction restore.
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Restoring to an Empty Database or Database Archive
Verify that a target connection exists and that you have access to the connection.

If you restore to an empty database, you must first export the metadata associated with the records to be 
restored and run the metadata DDL on the database.

1. In the Data Discovery Portal, search for the records that you want to restore. 

2. Export the metadata associated with the records. 

3. Run the metadata DDL on the target database. 

4. Run the transaction or cycle restore job from the Data Vault to the target database. 

Data Vault Restore to an Existing Production 
Database

When you restore data to an existing production database, you must determine whether the schema on the 
original production database has been updated since the data was archived.

If the production database schema has been updated, you must synchronize schemas between the existing 
database and the Data Vault. You can then run either a cycle or transaction restore.

Note: When you restore archived data and the records exist in the target database, the restore job will fail if 
key target constraints are enabled. If target constraints are disabled, the operation might result in duplicate 
records.

Restoring to an Existing Database Without Schema Differences
If the Data Vault schema is identical to the existing database schema, you can search for the transaction 
records and then run the restore job.

Verify that the target connection exists and that you have access to the connection.

1. In the Data Discovery Portal, search for the records that you want to restore. 

2. Run the restore job from the Data Vault to the target database. 

Schema Synchronization
When you restore data from the Data Vault to an existing database, you might need to synchronize schema 
differences between the Data Vault and the existing database.

To synchronize schemas, you can generate metadata in the Enterprise Data Manager and run the Data Vault 
Loader to update the Data Vault schema, or you can use a staging database.

Update the Data Vault schema with the Data Vault Loader when changes to the target table are additive, 
including extended field sizes or new columns with a null default value. New columns with a non-null default 
value require manually running an ALTER TABLE SQL command. If you removed columns or reduced the size 
of columns on the target table, you must synchronize through a staging database.
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Synchronizing Directly to the Target Database
When you restore data from the Data Vault to an existing database with a different schema, you must first 
generate new metadata. Then run the Data Vault Loader standalone job to update the Data Vault schema.

Verify that the target connection exists and that you have access to the connection.

1. Define and run an archive job that generates metadata for the new schema, but does not archive any 
records. 

2. From the Schedule Jobs page, run a Data Vault Loader job to load the metadata and update the schema. 

3. Verify that the job was successful on the Monitor Jobs page. 

4. Run the restore job from the Data Vault to the target database. 

Synchronizing through a Staging Database
If you are unable to update the Data Vault by running the Data Vault Loader, you can use a staging database 
on which you run the updated metadata. You can then manually conduct the restore from the staging 
database to the existing database.

Verify that the target connection exists and that you have access to the connection.

1. In the Data Discovery Portal, search for the records that you want to restore. 

2. Export the metadata associated with the records. 

3. Run the metadata DDL on the staging database. 

4. Run the restore job from the Data Vault to the staging database. 

5. Alter the table in staging to synchronize with the target database schema. 

6. Using dlink and SQL scripts, manually restore the records from the staging database to the target 
database. 

Running a Cycle or Transaction Restore Job
Once schemas are synchronized, you can run a cycle or transaction restore from the Data Vault.

Verify that a target connection exists and that you have access to the connection.

1. Click Workbench > Restore File Archive. 

2. Select the Cycle Restore or Transaction Restore tab. 

• To restore an archive cycle, select the cycle ID.

• To restore a transaction, enter the entity name and selection criteria.

3. Click Next. 

The Manage Restore Steps page appears.

4. Select the actions you want the restore job to complete after each step in the restore process. 
To prevent the restore job from deleting the restored data in the Data Vault, enable the Skip check box 
for the Delete from Archive step.

5. Click Schedule to schedule the job. 

6. Monitor the restore job from the Jobs > Monitor Jobs page. 
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Configuring Data Vault Restore Steps
When you restore data from the Data Vault, Data Archive performs a series of steps similar to an archive 
cycle. After each step in the restore process you can choose to pause the job or receive a notification.

1. Generate Candidates. Generates a row count report for the data being restored.

2. Validate Destination. Validates the destination by checking table structures.

3. Copy to Destination. Restores the data from the Data Vault to the target. You have the option of 
generating a row count report after this step.

4. Delete from Archive. Deletes the restored data from the Data Vault if it is not on legal hold. This step is 
optional.

Restoring a Specific Table
To restore a specific table, you must create a new entity and run a cycle restore.

1. In the Enterprise Data Manager, create a new entity containing the specific table you want to restore. 

2. Run a cycle restore and specify the entity you created. 

Database Archive Restore
You can restore data that you have archived to a database archive. When you restore data from a database 
archive, Data Archive performs the same steps in the same sequence as an archive cycle.

When you restore data from the database archive, the history application user functions like the production 
application user during an archive cycle. The history application user requires the SELECT ANY TABLE 
privilege to run a restore job.

You can conduct a full, cycle, or transaction restore from a database archive. If you are restoring data from a 
database archive that was previously restored from the Data Vault to a database archive, you can only run a 
cycle restore. You can only run a cycle restore because the restore job ID is not populated in the interim 
tables during the initial archive cycle.

The target database for a database archive restore job can be either an empty or existing production 
database.

When you run a full restore, the system validates that the source and target connections point to different 
databases. If you use the same database for the source and target connections, the source data may be 
deleted.

Prerequisites
Verify that the target connection for the restore exists and that you have access to the connection.

If you are running a restore job from an IBM DB2 database back to another IBM DB2 database, an ILM 
Administrator may have to complete prerequisite steps for you. Prerequisite steps are required when your 
organization's policies do not allow external applications to create objects in IBM DB2 databases. The 
prerequisite steps include running a script on the staging schema of the restore source connection.

Note: When you restore archived data and the records exist in the target database, the restore job will fail if 
key target constraints are enabled. If target constraints are disabled, the operation might result in duplicate 
records.
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Running the Create Cycle Index Job
Before you conduct a restore from a database archive, run the Create Cycle Index job to increase restore job 
performance. The Create Cycle Index job creates database indexes based on Job IDs to optimize 
performance during the restore.

1. Click Jobs > Schedule a Job. 

2. Choose Standalone Programs and click Add Item. 

The Select Definitions window appears.

3. Select the Create Cycle Index job. 

4. Select the target repository and the entity where indexes need to be created. 

5. Schedule the job to run immediately or on a certain day and time. 

6. Enter an email address to receive a notification when the completes, terminates, or returns an error. 

7. Click Schedule. 

Schema Synchronization
When you restore from a database archive to an existing database, the Validate Destination step in the 
restore cycle will synchronize schema differences when the changes are additive, such as extending field 
sizes or adding new columns. If changes are not additive, you must create and run a SQL script on the 
database archive to manually synchronize with the production database.

Restoring from a Database Archive
You can run a cycle, full, or transaction restore job from a database archive.

1. Click Workbench > Restore Database Archive. 

2. Select the Cycle Restore, Full Restore, or Transaction Restore tab. 

• To restore an archive cycle, select the cycle ID.

• To restore a full database archive, select the source and target connections.

• To restore a transaction, enter the entity name and selection criteria.

3. Click Next. 

The Manage Restore Steps page appears.

4. Select the actions you want the restore job to complete after each step in the restore process. 
To prevent the restore job from deleting the restored data in the database archive, enable the Skip check 
box for the Delete from Source step.

5. Click Schedule to schedule the job. 

6. Monitor the restore job from the Jobs > Monitor Jobs page. 

Configuring Database Archive Restore Steps
When you restore data from a database archive, Data Archive performs a series of steps similar to an archive 
cycle. After each step in the restore process you can choose to pause the job or receive a notification.

1. Generate Candidates. Generates interim tables and a row count report for the data being restored.

2. Build Staging. Builds the staging table structures for the data you want to restore.

3. Copy to Staging. Copies the data from the database archive to your staging tablespace. You have the 
option of generating a row count report after this step.
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4. Validate Destination. Validates the destination by checking table structures.

5. Copy to Destination. Restores the data from the database archive to the target. You have the option of 
generating a row count report after this step.

6. Delete from Source. Deletes the restored data from the database archive. This step is optional.

7. Purge staging. Deletes interim tables from the staging schema.

Restoring a Specific Table
To restore a specific table, you must create a new entity and run a cycle restore.

1. In the Enterprise Data Manager, create a new entity containing the specific table you want to restore. 

2. Run a cycle restore and specify the entity you created. 

External Attachments Restore
External attachments are restored as part of a regular Data Vault or database archive restore job. 
Attachments restored from a database archive are identified in interim tables. Attachments restored from the 
Data Vault are identified in the attachments.properties file.

External Attachments from the Data Vault
When you run a restore job from the Data Vault, the ILM engine retrieves unencrypted attachments through 
the Data Vault Service and places the attachments in a staging attachment directory.

For encrypted attachments, when you run a restore job the ILM engine generates an encryption script in the 
staging attachment directory. The engine invokes the Data Vault Service for External Attachments (FASA) to 
create an encryption utility that reencrypts the attachments in the staging directory and then restores them to 
the target directory.

The following table lists the directories that FASA and the ILM engine need to access:

Format Scripts Directory Decrypted Directory BCP Directory/Attachment 
Target Directory

Regular Not required ILM engine ILM engine

Encrypted FASA and ILM engine (shared 
mount)

FASA and ILM engine (shared 
mount)

FASA

External Attachments from a Database Archive
The following table lists the directories that the ILM engine needs to access:

Format Attachment Source 
Directory

Scripts Directory Attachment Target Directory

Regular/Encrypted ILM engine (mount point) ILM engine (local) ILM engine (mount point)
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C h a p t e r  1 4

Data Discovery Portal
This chapter includes the following topics:

• Data Discovery Portal Overview, 168

• Search Data Vault, 169

• Search Within an Entity in Data Vault, 171

• Browse Data, 176

• Legal Hold, 178

• Tags, 181

• Troubleshooting the Data Discovery Portal, 184

Data Discovery Portal Overview
Use the Data Discovery portal to search data that is archived to the Data Vault. The Data Discovery portal 
includes the following search tools:
Search Data Vault

Use a keyword, term, or specific string to search for records across applications in Data Vault. Records 
that match the keyword appear in the search results. A keyword or string search searches both 
structured and unstructured data files, for example .docx, .pdf or .xml files. You can narrow the search 
results by filtering by application, entity, and table. After you search the Data Vault, you can export the 
search results to a .pdf file.

Search Within an Entity

Use Search Within an Entity to search and examine application data from specific entities in the Data 
Vault. The Data Discovery portal uses the search criteria that you specify and generates a SQL query to 
access data from the Data Vault. After you search the Data Vault, you can export the search results to a 
CSV or PDF file.

Browse Data

Use Browse Data to search and examine application data from specific tables in the Data Vault. The 
Data Discovery portal uses the search criteria that you specify and generates a SQL query to access data 
from the Data Vault. After you search the Data Vault, you can export the search results to a .csv or .pdf 
file.

You can also use the Data Discovery portal to apply retention policies, legal holds, and tags to archived 
records. If data-masking is enabled, then sensitive information is masked or withheld from the search results.
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Search Data Vault
You can enter a keyword or set of words, add wildcards or boolean operators to search for records in Data 
Vault.

Data Archive searches across applications in Data Vault for records that match your search criteria. You can 
narrow your search results by filtering by application, entity, and table. Then export your results to a PDF file.

You access Search Data Vault from the Data Discovery menu.

The following figure shows the Search Data Vault page:

Records that match your search query display on the Results page. The following figure shows the Results 
page.

1. The Filters panel contains sections for Application, Entities, and Tables filters. Clear the appropriate filter 
boxes to narrow your search results.

2. The Search Results panel displays records that match your search criteria. Click the record header to 
view technical details. Click the record summary to view the record's details in the Details panel.

3. The Actions menu contains options to export results to a PDF file. You can export all results or results 
from the current page.

4. The Details panel displays a record's column names and values.

Examples of Search Queries
You can search for records archived to the Data Vault in a variety of ways to make your search results more 
relevant. You can use a word or phrase, add boolean operators or wildcard characters, or specify a range of 
values.

The following list describes some of the search queries you can use:
Single Word

Enter a single word in the search field. For example, enter Anita. Records with the word Anita appear in 
the results.
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Phrase

Enter a phrase surrounded by double quotes. For example, enter "exceeding quota". Records with the 
term exceeding quota appear in the results.

Replace Characters

Use ? and * as wildcard characters to replace letters in a single word search. You cannot use wildcards if 
your search query has more than one word. You cannot replace the first character of the word with a 
wildcard character.

To replace a single character in a word, use ?. For example, enter te?t. Records with the word tent, test, 
or text appear in the results.

To replace multiple characters in a word, use *. For example, enter te**. Records with the word teak, 
teal, team, tear, teen, tent, tern, test, or text appear in the results.

Similar Spelling

Use the ~ character to search for a word with a similar spelling. For example, enter roam~. Records with 
the word foam or roams appear in the results.

Range Searches

You can search for records with a range of values. Use a range search for numbers or words.

Enter the high and low value of a range separated by TO. The TO must be in uppercase.

To search by range, use the following formats:

• To include the high and low values, surround the range with square brackets:

<column name>: [<high> TO <low>]
                  

For example, enter name: [Anita TO Ella]
Records with the word Anita, Ella, and words listed alphabetically between Anita and Ella in the name 
column, appear in the results.

• To exclude the high and low values, surround the range with curly brackets:

 <column name>: {<high> TO <low>} 
                  

For example, enter name: {Anita TO Ella}
Records with the words listed alphabetically between Anita and Ella in the name column appear in the 
results. Records with the word Anita or Ella do not appear in the results.

• To search for a date range, use the format yyyymmdd. Use square brackets to include the high and 
low values. Use curly brackets to exclude the high and low values.

 <column name>: [<yyyymmdd> TO <yyyymmdd>] 
                  

For example, enter hire_date: [20040423 TO 20121231]
Records with dates from April 23, 2004 to December 31, 2012 in the hire_date column appear in the 
results.

AND Operator

To search for records that contain all the terms in the search query, use AND between terms. The AND 
must be in uppercase. You can replace AND with the characters &&.

For example, enter "Santa Clara CA" AND Platinum. Records with the phrase Santa Clara CA and the 
word Platinum appear in the results.
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+ Operator

To specify that a term in the search query must exist in the results, enter the + character before the term. 
For example, enter +semiconductor automobile. Records with the word semiconductor appear in the 
results. These records may or may not contain the word automobile.

NOT Operator

To search for records that exclude a term in the search query, enter NOT before the term. You can 
replace NOT with either the ! or - character.

For example, enter Member NOT Bronze. Records that contain the word Member but not the word Bronze 
appear in the results.

Searching Across Applications in Data Vault
Search for records across applications in Data Vault. Enter a search criteria and specify the applications to 
search from. Narrow your search results by application, entity, and table. Then export results to a PDF file.

1. Click Data Discovery > Search Data Vault. 

The Search Data Vault Using Keywords page appears.

2. Click the Choose an Application list and select one or more applications. 

3. Enter a search query and click Search. 

Records that match your search criteria display on the Search Data Vault Results page.

4. On the Filters panel, check the appropriate application, entity or tables to filter your results. 

5. On the Search Results panel, click on a record. 

The column names and values appear on the Details panel.

6. On the Search Results panel, click the record header. 

The technical view appears with the details and referential data details of the record.

7. To export results, click Actions. 

• To export results from the current page, click Export Current Page as PDF.

• To export all results, click Export All Results as PDF.

A PDF file with the results appear.

Search Within an Entity in Data Vault
The Search Within an Entity enables you to use the Data Discovery portal to search and examine application 
data from specific entities in the Data Vault. The Data Discovery portal uses the search criteria that you 
specify and generates an SQL query to access data from the Data Vault. After you search the Data Vault, you 
can export the search results to a file.

When you search the Data Vault, you specify the archive folder and the entity that you want to search in. If the 
archive folder includes multiple schemas, the query uses the mined schema in the Enterprise Data Manager 
for the corresponding entity. The search only returns records from the corresponding schema and table 
combination. If the archive folder only includes one schema, the query uses the dbo schema.

Use table columns to specify additional search criteria to limit the amount of records in the search results. 
The columns that you can search on depend on what columns are configured as searchable in the Data 
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Discovery portal search options. Based on your system-defined role, you can also search the Data Vault 
based on tags, legal hold groups, retention expiration date, and effective retention policy.

You can add multiple search conditions. Use AND or OR statements to specify how the search handles the 
conditions. You can also specify the maximum number of records you wish to see in the results. You have 
the option to order the search results based on a specific column in the entity driving table and to sort them 
in ascending or descending order.

You can save the search criteria that you configure. Saved criteria is useful when you configure multiple 
search conditions and want to search using the same conditions in the future. You can edit and delete the 
saved criteria, and you can designate whether the criteria is available for use by all users or only you.

Search Within an Entity Parameters
Specify the search parameters when you search the Data Vault by entity.

Search Within an Entity includes the following search parameters:
Archive Folder

Archive folder that contains the entity of the archived data that you want to search. The archive folder 
limits the amount of entities shown in the list of values.

The archive folder list of values shows archive folders that include at least one entity that you have 
access to. You have access to an entity if your user is assigned to the same role that is assigned to the 
entity.

Entity

Entity that contains the table that you want to view archived data from.

The entity list of values shows all entities that you have access to within the application version of the 
related archive folder.

Saved Criteria

Search conditions that have been configured and saved from a previous search.

The list of values displays all of the sets of saved criteria that are accessible to you.

Maximum Number of Records in Results

The maximum number of records that you want to view in the search results.

This parameter does not affect the export functionality. When you export results, Data Archive exports all 
records that meet the search criteria regardless of the value you specify in the Maximum Number of 
Records in Results parameter.

Enter a number greater than zero.

Order By

Entity driving table column that you want to sort the order of the search results by.

The list of values contains the entity driving table columns that you can order the search results by.

Sort Order

Order that you want to sort the search results by.

Choose ascending or descending.

The order by and sort order parameters apply to all of the search results returned across multiple pages.
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Saved Criteria
You can save the search conditions that you configure when you search within an entity in Data Vault.

When you configure the search criteria for an entity, you add search conditions to create a targeted search. 
For example, you can add a condition to search on a date column for a specific date. You can add multiple 
search conditions to a single search. You can also include the order by and sort order functions as part of the 
saved criteria.

You can save the search conditions that you create to be used in future searches. When you save the search 
conditions, you give the conditions a name that is unique within the entity. The name can have a maximum of 
250 characters, though names that exceed 50 characters are displayed in the user interface with the first 45 
characters followed by an ellipsis. Before you save the criteria, you also designate whether the search criteria 
will be accessible to all users for searching, or if the criteria will only be visible and accessible to you.

Saved criteria can be edited or deleted only by the creator, who is the owner, and the Data Archive 
Administrator. If the owner of the criteria designates that the criteria is accessible to all users, any user can 
run a search using the criteria but cannot edit or delete the criteria. Users who do not own the criteria can 
save the criteria under a different name and then edit it.

The number of saved criteria that you can create for a single entity is determined by a parameter in the 
system profile. If you try to create new saved criteria and receive an error message that the criteria limit has 
been exceeded for the entity, you can adjust the limit of allowed criteria in the system profile. To adjust the 
maximum number of saved criteria that the system allows, click Administrator > System Profile > Data 
Discovery Portal and enter a value for the Default Number of Saved Criteria per Entity parameter.

To delete saved criteria, select the entity and then the saved criteria name from the menu. Then click Delete 
and OK in the confirmation window. Only the creator of the criteria and the Data Archive Administrator can 
delete the saved criteria.

Searching Within an Entity
Use the Data Discovery portal to search and examine application data from the Data Vault. When you search 
the Data Vault, you search archived data from one entity.

1. Click Data Discovery > Search Within an Entity in Data Vault. 

2. Select the archive folder and entity. 

After you choose the entity, the system displays the search elements that are defined for the entity.

If you want to filter the search by metadata columns such as Legal Hold, Effective Retention Policy, and 
up to nine tag columns, contact the Data Archive administrator for permissions.

3. Optionally, specify the maximum number of records you wish to view in the search results. 

4. Enter a condition for at least one of the search elements, or the name of a saved criteria from the Saved 
Criteria drop-down menu. 

Use the Add (+) or Remove (-) icons to add or remove multiple search conditions.

Use % as a wildcard to replace one or more characters for the Starts With, Does Not Start With, Ends 
With, Does Not End With, Contains, and Does Not Contain search options.

Note: If you selected saved criteria and you are not the creator of the criteria or the Administrator, you 
cannot edit the saved criteria and save it with the existing criteria name. Click Save As to save a copy of 
the edited criteria and enter a different name.

If you select saved criteria that contains tagging, legal holds, or retention on the columns, you must have 
the corresponding system access role. For example, tag viewer, tag administrator, or retention 
administrator.

Search Within an Entity in Data Vault       173



5. If you have not selected any saved search criteria, you can optionally save the search conditions that you 
configured in Step 4. To save the conditions, click Save underneath the conditions. 

The Save Criteria window appears.

6. Enter a unique name for the saved criteria. 

7. To allow other users to use the conditions in their own searches, click the Make Criteria Accessible to 
All Users check box. 

8. Optionally, select an entity driving table column from the Order By menu if you want to order the search 
results based on the chosen column. 

9. From the Sort Order menu, select whether you want to view the search results in ascending or 
descending order. 

10. Click View. 

Search Within an Entity Results
When you search the Data Vault by entity, the Data Discovery portal generates two patterns of search results:

• Transaction View. The transaction view displays basic transaction details of the entity.

• Technical View. The technical view displays transaction details along with referential data details of the 
entity.

Search Within an Entity Export Results
When you search the Data Vault by entity, you can export the search results to a file. The Data Discovery 
portal search options determine which columns are exported.

The export file includes columns that are defined as display columns. The export file does not include the 
legal hold, tagging, or effective retention policy columns. The export file does not contain the retention 
expiration date column if you export selected records.

You can export the search results to one of the following file types:

• XML file

• PDF file

• Delimited text file

Based on the file type that you download to, you can choose one of the following download options:

• Individual files. If multiple transactions are selected, each transaction has a separate file.

• Compressed file. All the selected transactions are downloaded in a compressed file.

You determine which records from the search results are included in the export file. Before you export, you 
can select individual records, select all records on the current page, or select all records from all pages.

When you export the search results, the job exports the data and creates the PDF file in the temporary 
directory of the ILM application server. The job uses the following naming convention to create the file:

<table>_<number>.pdf
The job creates a hyperlink to the file that is stored in the temporary directory. Use the link to view or save the 
PDF file when you view the job status. By default, the files are stored in the temporary directory for one day.

If you select the XML (Compressed) export file type and run the job, you can use the View Exported Data link 
in the Monitor Jobs page to download and save the ZIP file. Extract the ZIP file to view the files. Clob and 
Blob data types are saved as separate LOB files. The other data types are saved to an XML file.
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Delimited Text Files
When you export to a delimited text file, the system exports data to a .csv or .txt file.

When you export to a delimited text file, specify the following parameters:

Column and Row Separators

When you search the Data Vault by entity and select delimited text file as the export file type, the 
separators include default values. The following table describes the default values for the separators:

Separator Default Value

Column Separator ,

Row Separator \n

The values for the column and row separator parameters determine the type of delimited text file the 
system exports to. If you use the default values for the column and row separator parameters, then the 
system exports data to a .csv file. If you use values other than the default values, then the system 
exports data to a .txt file.

Put Values in Quotes

The Put Values in Quotes parameter is for .csv export. Enable the parameter if the source data includes 
new line characters. The parameter determines whether the system puts the source values in quotes 
internally when the system creates the .csv file. The quotes ensure that source data with new line 
characters is inserted into one column as compared to multiple columns.

For example, the source data contains the following information:

Name Address

John Doe 555 Main Street
Apartment 10

The address column contains a new line character to separate the street and the apartment number. If 
you enable the parameter, the exported file includes the address data in one column. If you disable the 
parameter, the exported file splits the address data into two columns.

Only use this parameter if you use the default values for the separators. If you enable this parameter and 
use values other than the default values for the separators, then the system puts the values in quotes in 
the exported data.

Exporting Selected Records from the Search Within an Entity Results
After you run a search, you can export selected records to a file.

1. From the search results, select the rows that you want to export. 

Tip: You can manually select the rows or use the column header checkbox to select all records on the 
page.

2. Click Export Data. 

The Export Transaction Data dialog box appears.

3. Select the export data file type. 
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Note: User authorizations control whether you can choose the file type to export to. Depending on your 
user role assignment, the system may automatically export to a .pdf file.

4. If you select Delimited Text File, enter the additional parameters. 

5. Select the download option. 

6. Click Fetch Data. 

The Files to Download dialog box appears.

7. View or save the file. 

• To view the file, click the hyperlink.

• To save the file, right-click the hyperlink, specify the file location, and save.

Browse Data
Browse Data enables you to use the Data Discovery portal to search and examine application data from 
specific tables in the Data Vault. The Data Discovery portal uses the search criteria that you specify and 
generates a SQL query to access data from the Data Vault. After you search the Data Vault, you can export 
the search results to a CSV or PDF file.

When you specify the search criteria, you choose which table columns to display in the search results. You 
can display all records in the table or use a where by clause to limit the search results. You can also specify 
the sort order of the search results. Before you run the search, you can preview the SQL statement that the 
Data Discovery portal uses to access the data.

You can also use Browse Data to view external attachments for entities that do not have a stylesheet. You 
can view external attachments after the Load External Attachments job loads the attachments to the Data 
Vault. You cannot search the contents of the external attachments.

When you search for external attachments, enter the entity that the attachments are associated to. The 
search results show all attachments from the AM_ATTACHMENTS table. The table includes all attachments 
that you archived from the main directory and also from any subfolders in that main directory. The search 
results show a hyperlink to open the attachment, the original attachment directory location, and the 
attachment file name. To view the attachment, click the hyperlink in the corresponding ATTACHMENT_DATA 
column. When you click the link, a dialog box appears that prompts you to either open or save the file.

Browse Data Search Parameters
Specify the search parameters when you browse data from the Data Vault.

The Browse Data search includes the following search parameters:
Archive Folder

Archive folder that contains the entity of the archived data that you want to search.

The archive folder list of values shows archive folders that include at least one entity that you have 
access to. You have access to an entity if your user is assigned to the same role that is assigned to the 
entity.

You must select an archive folder to limit the amount of tables shown in the list of values.

Entity

Entity that contains the table that you want to view archived data from.
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The entity list of values shows all entities that you have access to within the application version of the 
related archive folder.

The entity is optional. Use the entity to limit the amount of tables shown in the list of values.

Schema

Schema that contains the table that you want to view. Required if the target connection for the archive 
folder is enabled to maintain the source schema structure. You must enter the schema because the 
archive folder may include multiple schemas with the same table name.

Table

Table that includes the archived data that you want to view.

For Browse Data, the table list of values shows all tables that you have access to within the application 
version of the related archive folder.

No. of Rows

Maximum amount of rows in the search results. Default is 100.

Searching with Browse Data
Use the Browse Data search tool to search data from the Data Vault.

1. Click Data Discovery > Browse Data. 

2. Specify the search parameters. 

If you want to filter the search by metadata columns such as Hold, Effective Retention Policy, and up to 
nine tag columns, contact the Data Archive administrator for permissions.

Tag columns are named ilm_metafield1 through ilm_metafield9.

If you want to browse materialized views, do not select Entity. Materialized views are not part of the 
Entity search parameter.

After you select the table, the system populates the Available Columns list.

• If you are browsing SAP special table data, Data Archive displays the column descriptions for the SAP 
special table.

• If you are browsing data in a materialized view, Data Archive displays alias names.

3. Use the arrows to move the columns that you want to display to the Display Columns list. 

4. Optionally, specify the Where Clause and Order By to further filter and sort the search results. 

5. Click Preview SQL to view the generated SQL query. 

6. Click Search. 

The records that match the search criteria appear. A Click to View link appears if the data in a record 
contains more than 25 characters or the record has an attached file.

Export Data
You can export the search results to a .csv or a .pdf file. System-defined role assignments determine which 
file type users can export data to. The exported file includes the columns that you selected as the display 
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columns for the browse data search. Note that the exported file does not include the legal hold and tagging 
columns.

When you export the search results, you schedule the Browse Data Export job. The job exports the data and 
creates a .pdf file in the temporary directory of the ILM application server. The job uses the following naming 
convention to create the file:

<table>_<number>.pdf
The job creates a hyperlink to the file that is stored in the temporary directory. Use the hyperlink to view or 
save the .pdf file when you view the job status.

Exporting from Browse Data
After you run a search, you can export the search results. You can export all columns except for columns that 
include large datatype objects such as BLOB or CLOB datatypes.

1. After the search results appear, select CSV or PDF and click Export Data. 

If you export data from a table that includes a large datatype object, a message appears. The message 
indicates which columns contain the large object datatypes and asks if you want to continue to export 
the data. If you continue, all of columns except for the columns with the large datatypes are exported.

Note: User authorizations control whether you can choose the file type to export to. Depending on your 
user role assignment, the system may automatically export to a .pdf file.

The Schedule Jobs screen appears.

2. Schedule the Browse Data Export job. 

3. Access Jobs > Monitor Jobs. 

The Monitor Jobs screen appears if you schedule the job to run immediately.

4. Once the job completes, expand the Job ID. 

5. Expand the BROWSE_DATA_EXPORT_SERVICE job. 

6. Click View Export Data. 

The File Download dialog box appears.

7. Open or save the file. 

Legal Hold
You can put records from related entities on legal hold to ensure that records cannot be deleted or purged 
from the Data Vault. You can also put a database schema or an entire application on legal hold. A record, 
schema, or application can include more than one legal hold.

Records from related entities, when put on legal hold, are still available in Data Vault search results. Legal 
hold at the application or schema does not depend on the relationship between tables.

You can apply a legal hold at the schema level to one or more schemas within an archive folder. A schema 
might include an entity that contains tables that are also a part of a different schema. If you try to apply a 
legal hold on a schema that contains tables that have a relationship to another schema, you receive a 
warning message. The warning includes the name of the schema that contains the related tables.

You can continue to apply the legal hold on the selected schemas, or you can cancel to return to the selection 
page and add the schema that contains the related tables. If you do not include the schema that contains the 
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related tables, orphan data is created in the related tables when you purge the tables that you placed on legal 
hold.

A legal hold overrides any retention policy. You cannot purge records on legal hold. However, you can still 
update the retention policy for records on legal hold. When you remove the legal hold, you can purge the 
records that expired while they were flagged on legal hold. After you remove the legal hold, run the Purge 
Expired Records job to delete the expired records from the Data Vault.

To apply a legal hold, you must have one of the following system-defined roles:

• Administrator

• Legal Hold User

Legal Hold Groups and Assignments
You create and delete legal hold groups and apply legal hold assignments from the Manage Legal Hold 
Groups menu.

When you access the menu, you see a results list of all legal hold groups. The results list includes the legal 
hold group name and description. You can use the legal hold name or description to filter the list. From the 
results list, you can select a legal hold group and apply the legal hold to records or an application as a whole 
in the Data Vault. You can delete a legal hold group to remove the legal hold from records or an entire 
application in the Data Vault.

Expand the legal hold group to view all records that are assigned to the legal hold group. The details section 
includes the following information:
Archive Folder and Entities

Records that are on legal hold within the legal hold group are grouped by the archive folders and entities. 
The archive folder is the target archive area that the entity was archived to. User privileges restrict the 
entities shown.

Comments

Use the comments hyperlink to display the legal hold comments. The comments provide a long text 
description to capture information related to the legal hold group, such as the reason why you put the 
records on hold. You add comments when you apply a legal hold for the legal hold group.

View Icon

You can view the list of records that are on legal hold for each entity within the group. When you view the 
records in an entity, the Data Discovery portal search results page appears. You can view each record 
individually. Or, you can export the records to an XML file or a delimited text file. You must manually 
select the records that you want to export. You can export up to 100 records at a time.

Print Icon

You can create a PDF report that lists all the records that are on legal hold for each entity within a legal 
hold group. Each entity within the legal hold group has a print PDF icon. When you click the icon, a PDF 
report opens in a new window. The PDF report displays the entity, the legal hold name, and all of the 
columns defined in the search options for the entity. You can download or print the report.

Creating Legal Hold Groups
You must create a legal hold group before you can apply a legal hold to records in the Data Vault. Legal hold 
groups are stored in the ILM repository.

1. Click Data Discovery > Manage Legal Hold Groups. 
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2. Click New Legal Hold Group. 

The New Legal Hold Group dialog box appears.

3. Enter the legal hold group name and description. 

The description can be up to 200 characters.

Apply the legal hold group to records in the Data Vault.

Applying a Legal Hold
When you apply a legal hold, you search the Data Vault for records or an entire application that you want to 
apply the legal hold to. Then, you schedule the Add Legal Hold job. After you run the job, the system adds the 
legal hold to the selected records.

1. Click Data Discovery > Manage Legal Hold Groups. 

2. Click the apply legal hold icon from the corresponding legal hold group. 

3. Choose the archive folder. 

4. To apply legal hold on all the tables in an application check All Tables and skip to step 11. 

5. To apply a legal hold to a schema, select Schema and then the schema name from the menu. To apply 
the legal hold to all available schemas within the archive folder, select All. Then skip to step 11. 

Note: If you do not have access to a table or tables in a schema, that schema does not appear in the list 
of schemas. If you select the All option, only schemas to which you have access are selected.

6. To apply legal hold on a selected group of records, select the entity from the list of values. 

The system displays the search elements that are defined for the entity.

7. Enter a condition for at least one of the search elements. 

Use the Add (+) or Remove (-) icons to add or remove multiple search conditions.

8. Click View. 

The search results appear.

9. Select records from the search results in one of the following ways: 

• Select individual records.

• Enable the select-all box to select all records. Click the drop-down icon and select All Records for all 
records or Visible Records for records on the current page.

10. Optionally, click Export to export the selected records. You can export to an XML, PDF, or delimited text 
file. 

11. Click Apply Legal Hold. 

The Apply Legal Hold screen appears.

12. In the comments field, enter a description that you can use for audit purposes. The description can 
include alphanumeric, hyphen (-), and underscore (_) characters. Any other special characters are not 
supported. 

For example, enter why you are adding the legal hold. The comments appear in the job summary when 
you monitor the Apply Legal Hold job.

13. Click Apply Legal Hold. 

The Schedule Job screen appears.

14. Schedule when you want to run the Apply Legal Hold job. 

When the job runs, the system applies the legal hold to all tables in an application or all records that you 
selected in the search results.
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Deleting Legal Hold Groups
When you delete a legal hold group, the system navigates you to schedule the Remove Legal Hold job. The 
job removes the legal hold from all records that are associated to the legal hold group across all archive 
folders. Then, the system deletes the legal hold group.

To delete a legal hold group, you must have access to at least one entity that includes records that have the 
legal hold group assignment. You have access to an entity if your user has the same Data Vault access role 
as the entity. After you delete a legal hold group, you must run the Purge Expired Records job to delete any 
expired records from the Data Vault.

1. Click Data Discovery > Manage Legal Hold Groups. 

2. Click the delete icon from the corresponding legal hold group. 

The Remove Legal Hold dialog box appears.

3. In the comments field, enter a description that you can use for audit purposes. 

For example, enter why you are removing the legal hold. The comments appear in the job summary when 
you monitor the Remove Legal Hold job.

4. Click Delete Legal Hold. 

The Schedule Job screen appears.

5. Schedule when you want to run the Remove Legal Hold job. 

When the job runs, the system removes the legal hold from all records that are associated to the legal 
hold group and deletes the legal hold group.

Tags
You can tag a set of records in the Data Vault with a user-defined value and later retrieve the records based 
on the tag name. You can also base a retention policy on a tag value. A single record in the Data Vault can be 
part of more than one tag. A tag can be of date, numeric, or string datatype.

You can define a maximum of four date datatype tags, a maximum of four numeric datatype tags, and one 
string datatype tag in the Data Vault. You can use a maximum of 4056 characters for the string datatype tag. 
A single tag can have different tag values for different records. When you tag a record, you specify a value 
based on the datatype of the tag. You can update the value of a tag and remove the tags.

Adding Tags
Use the Data Discovery portal to add tags to your records.

1. Click Data Discovery > Manage Tags. 

2. Select the archive folder and entity. 

The system displays the search elements that are defined for the entity.

3. Enter a condition for at least one of the search elements. 

Use the Add (+) or Remove (-) icons to add or remove multiple search conditions.

4. Click View. 

The records that match the search criteria appear.

5. Use the checkbox on the left to select the records you want to tag. 
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6. Click Add Tag. 

7. Select a tag or choose to create one. 

• To select an existing tag, choose a name from the Tag Name drop-down list and enter a tag value.

• To create a tag, enter a tag name, select the datatype, and enter a tag value.

8. Click Add Tag. 

The Schedule Job page for the Add_Tagging_Records job appears.

9. Select the appropriate schedule options and click Schedule. 

The Monitor Jobs page appears.
After the Add Tagging Records job completes, you can click the expand option to view log details.

Updating Tags
Use the Data Discovery portal to update the tag value of a record.

1. Click Data Discovery > Manage Tags. 

2. Select the archive folder and entity. 

The system displays the search elements that are defined for the entity.

3. Enter a condition for at least one of the search elements. 

Use the Add (+) or Remove (-) icons to add or remove multiple search conditions.

4. Click View. 

The records that match the search criteria appear.

5. Use the checkbox on the left to select one or more records with the tag you want to update. 

6. Click Update Tag. 

7. Select a tag from the Tag Name drop-down list. 

8. Enter a value. 

9. Click Update Tag. 

The Schedule Job page for the Update_Tagging_Records job appears.

10. Select the appropriate schedule options and click Schedule. 

The Monitor Jobs page appears.
After the Update Tagging Records job completes, you can click the expand option to view log details.

Removing Tags
Use the Data Discovery portal to remove a tag from a record.

1. Click Data Discovery > Manage Tags. 

2. Select the archive folder and entity. 

The system displays the search elements that are defined for the entity.

3. Enter a condition for at least one of the search elements. 

Use the Add (+) or Remove (-) icons to add or remove multiple search conditions.

4. Click View. 

The records that match the search criteria appear.

5. Use the checkbox on the left to select one or more records with the tag you want to remove. 
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6. Click Remove Tag. 

7. Select a tag from Tag Name drop-down list. 

8. Click Remove Tag. 

The Schedule Job page for the Remove_Tagging_Records job appears.

9. Select the appropriate schedule options and click Schedule. 

The Monitor Jobs page appears.
After the Remove Tagging Records job completes, you can click the expand option to view log details.

Searching Data Vault Using Tags
Use tag values as filter options when you search for records from the Data Vault.

1. Click Data Discovery > Search Data Vault. 

The Search Data Vault page appears.

2. Select the archive folder and entity. 

The system displays the search elements that are defined for the entity.

3. Select a tag element from the drop-down list of search elements and enter a condition. 

If you do not see tag columns in the drop-down list of search elements, contact the Data Archive 
administrator for permissions.

Use the Add (+) or Remove (-) icons to add or remove multiple search conditions.

4. Click View. 

The records that match the search criteria appear.

Tag columns are identified by a yellow icon in the column heading. You can export all or a select set of 
records.

Browsing Data Using Tags
Use tag values as filter and sort options when you browse for records in the database.

1. Click Data Discovery > Browse Data. 

The Browse Data page appears.

2. Select the archive folder, schema, and table. You may also select the entity and the number of rows to 
display. 

The system populates the Available Columns list.

Tag columns appear as ilm_metafield1 to ilm_metafield9.

If you do not see the tag columns, contact the Data Archive administrator for permissions.

3. Use the arrows to move the tag and any other column to the Display Columns list. 

4. Optionally, specify the Where Clause and Order By to further filter and sort the search results. 

5. Click Preview SQL to view the generated SQL query. 

6. Click Search. 

The records that match the search criteria appear. Tag columns are identified by a yellow icon in the 
column heading.

A Click to View link appears if the data in a record has more than 25 characters or if the record has an 
attached file.
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Troubleshooting the Data Discovery Portal
The View button in the Search Data Vault window is always disabled.

The View button might become permanently disabled because of an enhanced security setting in the 
web browser. To enable the button, close Data Archive, disable enhanced security configuration for the 
web browser, and restart Data Archive.

For example, to disable enhanced security configuration for Microsoft Internet Explorer on Windows 
Server 2008, perform the following steps:

1. Log in to the computer with a user account that is a member of the local Administrators group.

2. Click Start > Administrative Tools > Server Manager.

3. If the User Account Control dialog box appears, confirm that the action it displays is what you want, 
and then click Continue.

4. Under Security Information, click Configure IE ESC.

5. Under Administrators, click Off.

6. Under Users, click Off.

7. Click OK.

8. Restart Microsoft Internet Explorer.

For more information about browser enhanced security configuration, see the browser documentation.

I cannot view a logical entity in the Data Discovery portal.

To resolve the issue, verify the following items:

• The Data Vault Service is running.

• The entity is assigned to a Data Vault access role and your user is assigned to the same role. If your 
user is not assigned to the same role as the entity, you will not see the entity in the Data Discovery 
portal.

• The driving table is set for the entity.

• The metadata source for the Data Discovery portal searches is set to the correct source. In the 
conf.properties file, the informia.dataDiscoveryMetadataQuery property is set to AMHOME.

• For tables with exotic columns, the primary key constraint for the table is defined.

The technical view does not show child tables.

To resolve the issue, verify the following items:

• All of the constraints are imported for the entity in the Enterprise Data Manager.

Tip: View the entity constraints in the Data Vault tab.

• The metadata source for the Data Discovery portal searches is set to the correct source. In the 
conf.properties file, verify that the informia.dataDiscoveryMetadataQuery property is set to AMHOME.

Non-English characters do not display correctly from the Data Discovery portal or any other reporting tools.

Verify that the LANG environment variable is set to UTF-8 character encoding on the Data Vault Service. 
For example, you can use en_US.UTF-8 if the encoding is installed on the operating system. To verify 
what type of encoding the operating system has, run the following command:

local -a

In addition, verify that all client tools, such as PuTTY and web browsers, use UTF-8 character encoding.
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To configure UTF-8 character encoding in PuTTY, perform the following steps:

1. In the PuTTY configuration screen, click Window > Translation.

2. In the Received data assumed to be in which character set field, choose UTF-8.

The technical view for an entity returns a class cast exception.

Technical view is not available for entities with binary or varbinary data types as primary, foreign, or 
unique key constraints.
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C h a p t e r  1 5

Data Visualization
This chapter includes the following topics:

• Data Visualization Overview, 186

• Data Visualization User Interface, 187

• Data Visualization Process, 188

• Report Creation, 188

• Report Permissions, 196

• Assigning a User or Access Role to a Report, 197

• Editing Report Permissions for a User or Access Role, 197

• Deleting a User or Access Role From a Report, 198

• Assigning Permissions for Multiple Reports, 198

• Deleting Permissions for Multiple Reports, 199

• Running and Exporting a Report, 199

• Deleting a Report, 202

• Copying Reports, 202

• Troubleshooting, 207

• Designer Application, 209

Data Visualization Overview
Data visualization is a self-service reporting tool available on the Data Archive user interface.

Use data visualization to create, view, copy, run, and delete reports from data that is archived to the Data 
Vault. You can select data from related or unrelated tables for a report. You can also create relationships 
between tables and view a diagram of these relationships. You can then lay out, style, and format the report 
with the design tools available on the data visualization interface.

When you access the Reports and Dashboards page, you can also view any pre-packaged reports that were 
installed by an accelerator. Accelerator reports have the type "TEMPLATE_REPORT" in the Reports and 
Dashboards window. You can perform only copy and grant operations on the TEMPLATE_REPORT type of 
report. You must copy the accelerator reports to an archive folder that corresponds to the Data Vault 
connection where the retired tables on which the reports are built are located. For example, when you copy 
the reports from the Application Retirement for Healthcare accelerator, select an archive folder where the 
healthcare-related tables are archived.
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To create highly designed, pixel-perfect reports, install and use the Designer application on your desktop. The 
Designer application contains an advanced design tool box. After you create a report in Designer, you can 
publish it to the Data Archive server to view the report on the data visualization interface.

Data Visualization User Interface
You access data visualization from the Data Visualization menu option. The Reports and Dashboards 
window displays a list of reports with sort and filter options.

The following figures show the Reports and Dashboards window:

1. List of available reports. Click a row to select the report you plan to run. Click one or more checkboxes to 
select reports you want to delete.

2. Filter box. Enter the entire or part of the value in the filter box above the appropriate column heading and 
click the filter icon.

3. Actions drop-down menu. Contains options to run, create, edit, and copy reports. Also contains the 
options to add permissions or revoke permissions for selected reports.

4. Filter icon. After you specify filter criteria in the fields above the column names, click the filter icon to 
display the reports.

5. Clear filter icon. Click this icon to clear any filter settings.
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6. Sort icon. Click this icon to sort columns alphabetically or chronologically.

7. Resizing bar. Click and drag the bar up and down to resize the sections.

8. Properties section. Displays report details.

9. Permissions icon. Click the Permissions icon to switch to the permissions section from the properties 
section.

10. Permissions section. The permissions section displays which users and access roles have permission to 
take an action on a report. This information is only visible to you if you have the "grant" permission on 
your login user or access role for the selected report. If you do not have the grant permission, you will 
only see the permissions information for your own user and access role.

You can also launch the Data Visualization Advanced Reporting interface from the Data Visualization menu. 
You can use the Advanced Reporting interface to run reports. To access the Advanced Reporting interface, 
you must run the chosen report with a user that has the Report Admin role.

Note: You can see the Data Visualization menu option if your product license includes data visualization.

Data Visualization Process
Complete the following tasks to create a report:

1. Run a retirement job or an archive job so that data exists in the Data Vault.

2. Create a report by either entering an SQL query or selecting tables from the report wizard.

3. Optionally, create relationships between tables.

4. Design the report layout and style.

5. Run the report.

Report Creation
You can create reports with tables, cross tabs, and charts. Then add parameter filters, page controls, labels, 
images, and videos to the report.

For example, you might create a tabular report that displays the customer ID, name, and last order date for all 
retired customer records. You can add filters to allow the user to select customer-status levels. Or, you might 
create a pie chart that shows the percentage of archived customer records that have the platinum, gold, or 
silver status level.

You create a report by specifying the data you want in the report. You can specify the data for the report in 
one of the following ways:

• Select the tables from the report-creation wizard. If required, create relationships between fields within 
and between tables.

• Enter an SQL query with the schema and table details.

After you specify the data for a report, design, save, and run the report.
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Table and Column Names

When a table or column name begins with a number, Data Archive appends the prefix INFA to the name when 
the name appears in the report creation wizard.

For example, if the column name is 34_REFTABLE_IVARCHAR, then the column name appears as 
INFA_34_REFTABLE_IVARCHAR in the report creation wizard.

When a column name contains special characters, Data Archive replaces the special characters with an 
underscore when the column name appears in the report creation wizard.

For example, if the column name is Order$Rate, then the column name appears as Order_Rate in the report 
creation wizard.

Creating a Report from Tables
To specify data for a report, select the tables in an archive folder to include in the report. Each report you 
create can contain data from one archive folder.

1. Click Data Visualization > Reports and Dashboards. 

The Reports and Dashboards window appears.

2. Click Actions and select New > Report. 

The New Report tab with the Create Report: Step 1 of 3 Step(s) wizard appears. 

3. Select a target connection from the Archive Folder Name drop-down list. 

The archive folder list displays archive folders with the same file access role that you have.

4. Select Table(s) and click Next. 

The Add Tables page appears.

5. Select the tables containing the data that you want in the report. Optionally, filter and sort schema, table, 
or data object name to find the tables. Click Next. 
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The Create Report: Step 2 of 3 Steps(s) page appears with a list of the selected tables. 

6. Enter a name in the Data Object Name field. 

7. Click Add More or Remove Selected to add or remove tables from the list. 

8. Click Add constraints. 

The Relationship Map page appears. If necessary, click and drag the tables to get a clearer view of the 
relationship arrows. You can also zoom in and out for clarity. 

9. Click Add Relationship. 

A list of the column names in each table you selected, appears in a child table section and in a parent 
table section. Arrows indicate the relationships between columns.

10. To create a relationship, select a column from Child Table Columns list and a column from the Parent 

Table Columns list. Click the Join button . 
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Links appear between the table columns to show relationships. 

11.
To remove a relationship, click the relationship arrow and click the Remove Join button . 

12. Click OK. 

The Add Tables page appears.

13. Click Add Constraints to view the updated relationship map. Click Close. 

The Add Tables page appears.

14. Click Next. 

The Create Report: Step 3 of 3 Step(s) window appears. This is the design phase of the report-creation 
process.

Creating a Report From an SQL Query
To specify data for a new report you can write an SQL query that contains the archive folder and tables to 
include in the report. Each report you create can contain data from one archive folder.

1. Click Data Visualization > Reports and Dashboards. 

The Reports and Dashboards window appears.

2. Click Actions and select New > Report. 
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The New Report tab with the Create Report: Step 1 of 3 Step(s) wizard appears. 

3. Select a target connection from the Archive Folder Name drop-down list. 

The archive folder list displays archive folders with the same file access role that you have.

4. Select SQL Query and click Next. 

5. Enter a name for the SQL query in the Query Name field. 

6. Enter a query and click Validate. 

If you see a validation error, correct the SQL query and click Validate. 

7. Click Next. 

The Create Report: Step 3 of 3 Step(s) window appears. This is the design phase of the report-creation 
process.

Parameter Filters
You can add parameter filters to a report to make it more interactive. Use a parameter filter to show records 
with the same parameter value. To add parameter filters on a report, you must insert a prompt in the SQL 
query you use to create the report.

Add a parameter prompt for each parameter you want to filter on. For example, you want to create a report 
based on employee details that includes the manager and department ID. You want to give users the 
flexibility to display a list of employees reporting to any given manager or department. To add filters for 
manager and department IDs, you must use placeholder parameters in the SQL query for both the manager 
and department ID variables.

The placeholder parameter must be in the following format: @P_<DataType>_<Prompt>
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<DataType>

Specify a datatype. Use one of the following values:

• Integer

• Number

• String

• Decimal

If you do not specify a datatype, the parameter will be assigned the default datatype, string.

Note: Date, time, and datetime data types must be converted to string datatypes in the SQL query. 
Convert data with a date, time, or datetime datatype to a string datatype in one of the following ways:

• Use the format @P_<Prompt> where the <DataType> value is not specified. The parameter values will 
be treated as string by default.

• Add the char()> function to convert the parameter to string. The complete format is: char(<column 
name>)>@P_<DataType>_<Prompt>

<Prompt>

Represents the label for the parameter filter. Do not use spaces or special characters in the <Prompt> 
value.

Example

The SQL query to add parameter filters for manager and department IDs has the following format: select * 
from employees where manager_id =@P_Integer_MgrId and Department_id =@P_Integer_DeptId

When you run a report, you can choose to filter data by manager ID and department ID. The following image 
shows the filter lists for MgrId and DeptId: 

.
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The report displays details of employees associated with the manager and department you selected. 

You will also see the MgrId and DeptId filters in the Parameters section on the Report page. 

LIKE Operators

For information about using the LIKE operator as a parameter filter, see the Informatica Data Vault SQL 
Reference.

Example SQL Query to Create a Report
The following example shows an sql query to create a report:

SELECT hp.party_name 
      ,hc.cust_account_id             
      ,hc.account_number         customer_number
      ,amount_due_remaining      amount_due_remaining
      ,aps.amount_due_original   amount_due_original
      ,ra.trx_number
  FROM apps.ra_customer_trx_all       ra,
       apps.ra_customer_trx_lines_all rl,
       apps.ar_payment_schedules_all  aps,
       apps.ra_cust_trx_types_all     rt,
       apps.hz_cust_accounts          hc,
       apps.hz_parties                hp,
       apps.hz_cust_acct_sites_all    hcasa_bill,
       apps.hz_cust_site_uses_all     hcsua_bill,
       apps.hz_party_sites            hps_bill,
       apps.ra_cust_trx_line_gl_dist_all rct
WHERE ra.customer_trx_id           = rl.customer_trx_id
   AND ra.customer_trx_id           = aps.customer_trx_id
   AND ra.org_id                    = aps.org_id
   AND rct.customer_trx_id          = aps.customer_trx_id
   AND rct.customer_trx_id          = ra.customer_trx_id
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   AND rct.customer_trx_id          = rl.customer_trx_id
   AND rct.customer_trx_line_id     = rl.customer_trx_line_id
   AND ra.complete_flag             = 'Y'
   AND rl.line_type                 IN ('FREIGHT', 'LINE')
   AND ra.cust_trx_type_id          = rt.cust_trx_type_id
   AND ra.bill_to_customer_id       = hc.cust_account_id
   AND hc.status                    = 'A'
   AND hp.party_id                  = hc.party_id
   AND hcasa_bill.cust_account_id   = ra.bill_to_customer_id
   AND hcasa_bill.cust_acct_site_id = hcsua_bill.cust_acct_site_id
   AND hcsua_bill.site_use_code     = 'BILL_TO'
   AND hcsua_bill.site_use_id       = ra.bill_to_site_use_id
   AND hps_bill.party_site_id       = hcasa_bill.party_site_id
   AND hcasa_bill.status            = 'A'
   AND hcsua_bill.status            = 'A'
   AND aps.amount_due_remaining     <> 0
   AND aps.status                   = 'OP'

Designing the Report
After you select the data for the report, continue with the Create Report wizard to select the page type, layout, 

and style for your report. For more information on designing a report, click the help button ( ) on the top 
right corner of the wizard to open online help.

1. Select a predefined page template on the Page page of the wizard. To customize page size and 
orientation, click Page Setup and enter specifications. Click Next. 

The Layout page appears. 

2. Select a layout for your report. You can customize the layout in the following ways: 

• To split a cell, select the cell and click either the Horizontal Split and Vertical Split.
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• To merge cells, select two or more adjacent cells while holding down the Ctrl key and click Merge.

• To align the components in each cell, select the cell and click Align.

• To resize a cell, hold and drag the cell's borders. The width and height of each cell is displayed below.

3. Select a component to add to each cell. 

Component options include table, crosstab, or chart. You can also choose to leave a cell blank.

4. Click Next. 

The Bind Data page appears.

5. Specify the data source and fields for the first component in the report. 

6. Click Next to specify the data in the next component. 

After you specify data for all the components you selected on the Layout page, the Style page appears.

7. Select a style template. 

8. Click Save. 

The Save As page appears.
When you save the report, you must save it in the same archive folder that you selected when you 
created the report. If you select a different archive folder than the one you used to create the report, you 
receive an internal error when you try to run the report.

9. Complete the fields on the Save As page and click Save. 

The report is saved and displayed on the Reports and Dashboards window.

10. Click Run to run the report. 

Report Permissions
Before you can run, delete, or copy a report, you must have the corresponding permission. If you have the 
grant permission, you can also grant the ability to run, copy, or delete a report to other users or access roles.

The run, copy, delete, and grant permissions are separate permissions. Every report, whether created in Data 
Visualization or imported from an accelerator, has permissions that can be granted or revoked for only that 
report. Each permission can be granted to a specific user or to a Data Vault access role. Each user or access 
role assigned to a report can have different permissions.

The run, delete, and copy permissions allow a user or access role to take those actions on an individual 
report or multiple reports at one time. If your user or access role has the grant permission, you can also 
assign the run, copy, and delete permissions to multiple users or access roles for a single report or multiple 
reports.

You can add or delete permissions for one report at a time, or you can add or delete permissions for multiple 
reports at one time.

By default, the Report Admin user has permission to run, copy, delete, and grant permissions for all reports. If 
you do not have any permissions on a report, then the report is not visible to you in the Reports and 
Dashboards window.
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Assigning a User or Access Role to a Report
To grant a user or access role permissions on a report, assign the user or access role to the report. When you 
assign the user or access role to the report, you also specify which permissions the user or access role has 
on the report. To be able to assign a user to a report and grant permissions to the user, you must have the 
grant permission applied to your login user or access role.

1. Click Data Visualization > Reports and Dashboards. 

The Reports and Dashboards window appears.

2. In the upper pane, select the name of the report that you want to assign a user or access role to. 

Do not select the check box next to the report name. Select the name of the report to highlight the report 
row.

3. In the lower pane, click Permissions. 

4. To assign an access role to the report, click Edit in the Access Roles tab. To assign a user to the report, 
click Edit in the Users tab. 

The Edit Report Permissions window appears. This window lists the users and access roles that are 
already assigned to the report.

5. Click Add. 

The Add Access Roles or Add Users window appears.

6. From the list of available users or access roles, select the check box next to the user or access role that 
you want to add. Users and roles that are already assigned to the report do not appear. 

7. In the Permissions box, select the permissions that you want to grant to the user or access role. 

8. Click OK. 

The user or access role, along with the permissions you granted, appear in the lower pane of the Reports 
and Dashboards screen.

Editing Report Permissions for a User or Access Role
If you have the grant permission assigned to your user or access role, you can edit the permissions for other 
users and access roles.

1. Click Data Visualization > Reports and Dashboards. 

The Reports and Dashboards window appears.

2. In the upper pane, select the name of the report that you want to edit permissions for. 

Do not select the check box next to the report name. Select the name of the report to highlight the report 
row.

3. In the lower pane, click Permissions. 

4. To edit permissions for an access role, click Edit in the Access Roles tab. To edit permissions for a user, 
click Edit in the Users tab. 

The Edit Report Permissions window appears.

5. From the list of assigned users or access roles, select the user or access role that you want to edit 
permissions for. 

6. Clear or select the check box next to each permission that you want to edit. 
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To remove the delete and copy permissions, you must first remove the grant permission. To remove the 
run permission, you must first remove the grant, delete, and copy permissions.

7. To save your selections for an individual user or access role, click the Checkmark icon. To cancel 
without changing any permissions, click the X icon. 

8. To save all of the permission changes, click Save at the bottom of the window. 

The edited permissions appear next to the user or access role in the lower pane of the Reports and 
Dashboards window.

Deleting a User or Access Role From a Report
If you have the grant permission assigned to your user or access role, you can delete a user or access role 
from a report to remove all of the permissions that are granted to the user or access role.

1. Click Data Visualization > Reports and Dashboards. 

The Reports and Dashboards window appears.

2. In the upper pane, select the name of the report that you want to delete a user or access role from. 

Do not select the check box next to the report name. Select the name of the report to highlight the report 
row.

3. In the lower pane, click Permissions. 

4. To delete an access role from the report, click Edit in the Access Roles table. To delete a user from the 
report, click Edit in the Users table. 

The Edit Report Permissions window appears.

5. Select the check box next to the user or access role that you want to delete. 

6. Click Delete. 

The user or access role disappears from the list of assigned users and access roles on the Reports and 
Dashboards page.

Assigning Permissions for Multiple Reports
You can assign the permissions for multiple reports at one time. When you assign the permissions for 
multiple reports, you select a user or access role and then select the permissions for that user or access role. 
Your selections are applied to all of the reports. To grant permissions to multiple reports, you must have the 
grant permission applied to your login user or access role for all of the selected reports.

1. Click Data Visualization > Reports and Dashboards. 

The Reports and Dashboards window appears.

2. In the upper pane, select the check box next to each report that you want to edit permissions for. 
Alternatively, you can select the check box next to the name of an archive folder to select all of the 
reports in the folder. 

3. Click Actions > Add Permissions. 

The Manage Permissions on Reports window appears.
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4. To assign permissions for an access role, select the Access Roles tab. To assign permissions for a user, 
select the Users tab. 

5. Select the check box next to the user name or access role that you want to assign permissions to. 

6. In the Permissions box, select the permissions that you want to grant to the user or access role. 

The permissions that you apply are in addition to any existing permissions for the user or access role. 
For example, if access role "Role1" previously had the run and copy permissions, and you select only the 
delete permission in the Permissions box, Role1 retains the run and copy permissions and gains the 
delete permission.

7. Click OK. 

The user or access role along with the associated permissions appear in the lower pane of the Reports 
and Dashboards window for each report that you selected.

Deleting Permissions for Multiple Reports
You can delete permissions for multiple reports at one time. When you delete permissions on multiple 
reports, you remove all users and access roles assigned to the reports. Only the Report Admin role can delete 
permissions for multiple reports at one time.

1. Click Data Visualization > Reports and Dashboards. 

The Reports and Dashboards window appears.

2. In the upper pane, select the check box next to each report that you want to edit permissions for. 
Alternatively, you can select the check box next to the name of an archive folder to select all of the 
reports in the folder. 

3. Click Actions > Revoke All Permissions. 

A warning appears to ask if you are certain that you want to revoke all permissions on the selected 
reports.

4. To revoke all permissions on the reports, select Yes. To cancel, select No. 

Running and Exporting a Report
You can run a report after you create it. You can also export the report to a file such as a PDF or Microsoft 
Excel file.

1. Click Data Visualization > Reports and Dashboards. 

The Reports and Dashboards window appears with a list of reports sorted by report name.

2. Optionally, sort reports by type, description, creator, created date, or the last modification date to locate 
the report. 

3. Optionally, filter on one or more columns to limit the list of reports displayed. 

4. Click the row of the report you want to run. 

Do not use the checkbox to select a report to run.
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The row is highlighted. 

5. Click Actions > Run Report. 

The report appears in view mode. 

6. You can complete the following tasks in view mode: 

a. Click the Export button  to export the report to a file. 

You can export the report to one of multiple file formats such as PDF, HTML, Microsoft Excel, Text, 
RTF, or XML.

b. Click the Print button. 

c. Click the Filter button and select or exclude variables or certain values in a variable for each 
component in the report. 

d. Click the Save button to save any changes you made. 

e. From the Parameters view, select values to display in the report. 

You will see the Parameters view if the report was created with an SQL query that specified 
parameter filters.

f. From the Filter view, click the + button. Select fields to filter data in the report. 

7. Click Edit Mode to edit the report. 
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The report opens in edit mode. 

8. You can complete the following tasks in edit mode: 

a. All tasks allowed in view mode. 

b. From the Resources view, expand Data Source > report name > column name. Drag a column name 
to the appropriate area to add a new field to a table, crosstab, or chart. 

c. From the Resources view, expand Data Source > report name > Dynamic Resource > Aggregations. 
Click <Add Aggregations...> and select an option such as count, sum, or average to add to a table or 
chart. 

d. From the Resources view, expand Data Source > report name > Dynamic Resource > Formulas > 
Add Formula and add a customized formula to your table or chart. 

e. From the Filter view, click the + button. Select fields to filter data in the report. 

f. From the Components view, drag a component to an area in the report. 

You can add components such as a table, crosstab, chart, label, image, and video.

For more information on how to edit your report, click Menu > Help > User's Guide.
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Deleting a Report
If you have the delete permission, you can delete reports from the data visualization user interface.

1. From the main menu, select Data Visualization > Reports and Dashboards. 

The Reports and Dashboards window appears with a list of reports.

2. Select one or more reports to delete. 

3. From the Actions drop-down list, select Delete Reports. 

A confirmation message appears. Click Yes to delete the reports.

Copying Reports
If you have the copy permission, you can copy the reports in a folder to another folder.

To copy a report folder from one archive folder to another, the target archive folder must meet the following 
requirements:

• The target archive folder must contain all the tables required for the report.

• The tables for the report must be in the same schema in the target archive folder.
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The copy functionality works at the folder level. Select all the reports in the folder or select the folder to 
enable the copy action. You cannot select an individual report to copy if the folder contains other reports.

1. From the main menu, select Data Visualization > Reports and Dashboards. 

The Reports and Dashboards page appears with a list of reports within each folder.

2. Select a report folder that contains the reports that you want to copy. 

3. Click Actions > Save As. 

The Save As dialog box appears.
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4. Select an archive folder to copy the report folder to. 

5. Enter a name for the new folder. 

6. Click OK. 

The new folder with the copied reports appears on the Reports and Dashboards page.

Copying SAP Application Retirement Reports
To copy SAP application reports, you save the folder containing the reports to a new location. Then, publish 
details for the new schema from Data Visualization Designer to Data Archive.

Before you copy reports based on a retired SAP application, perform the following tasks:

• Install the SAP application accelerator.

• Install Data Visualization Designer.

1. From the main menu, select Data Visualization > Reports and Dashboards. 

The Reports and Dashboards window appears with a list of reports within each folder.

2. Enable the check box for the SAP report folder. 
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Data Archive selects all the reports in the SAP folder.

3. Click Actions > Save As. 

The Save As dialog box appears.

4. Enter values for the following parameters: 

Current Folder

Name of the report folder.

Save to Archive Folder

Target folder where the tables for the reports reside.
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New Folder Name

Name for the folder that you want to copy the reports to.

5. Click OK. 

Data Archive copies the reports to the new folder.

6. From Data Archive, click Data Visualization > Reports and Dashboards. 

7. Expand the folder that contains the copied SAP reports. 
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8. Run the file Home_Page.cls. 

The Run Report:Home_Page.cls window appears.

The Home_Page.cls file runs all the reports in the folder.

Troubleshooting
The following list describes some common issues you might encounter when you use Data Visualization.

You want to create a report but do not see the tables that you need in the selection list.

Contact your administrator and ensure that you have the same file access role as the data that you 
require for the report.

You encountered a problem when creating or running a report and want to view the log file.

The name of the log file is Visualization_API.log file. To access the log file, browse to the following 
location: <Data Archive install directory>\logs\Visualization_API

When you click any button on the Data Visualization page, you see the error message, "HTTP Status 404."

You cannot access Data Visualization if you installed Data Visualization on one or more machines but 
did not configure the machine to load it. Contact your Data Archive administrator.

You created a new user with the Report Designer role, but when you access Reports and Dashboards you receive an 
HTTP error.

Data Archive updates new users according to the value of the user cache timeout parameter in the Data 
Archive system profile. The default value of this parameter is five minutes. You can wait five minutes for 
the user cache to refresh and then access the Reports and Dashboards page. If you do not want to wait 
five minutes, or if a user assignment has not updated after five minutes, review the user cache timeout 
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parameter in the Data Visualization section of the system profile. For more information about the Data 
Archive system profile, see the Informatica Data Archive Administrator Guide.

A user can run a report even if the user does not have the Data Archive access roles for the tables in the report.

Run the report as a user with a Report Designer role. When you run the report with the Report Designer 
role, Data Archive activates the security levels.

1. Log in to Data Archive as a user with the Report Designer role.

2. Click Data Visualization > Reports and Dashboard.

3. Select the report.

4. Click Actions > Run Report.

Data in a report does not appear masked although the data appears masked in Data Discovery search results.

Run the report as a user with a Report Designer role. When you run the report with the Report Designer 
role, Data Archive activates the security levels.

1. Log in to Data Archive as a user with the Report Designer role.

2. Click Data Visualization > Reports and Dashboard.

3. Select the report.

4. Click Actions > Run Report.

You cannot create a Data Visualization report for entity reference tables.

Data Visualization reports for entity reference tables are not supported.

You cannot copy a report folder to another archive folder.

You might not be able to copy a report folder from one archive folder to another because of one of the 
following reasons:

• The target archive folder does not contain one or more tables required for the report.

• The tables required for the report are not in the same schema.

Select another archive folder to save the report folder to.

The following table describes the outcome when you copy a report folder from one archive folder to 
another under different scenarios:

Scenario Tables in the 
Archive Folder You 
are Copying From

Tables in the 
Archive Folder You 
are Copying To

Result

1 UF2.MARA
UF2.MARC
UF2.BKPF

SAP.MARA
SAP.MARC
SAP.BKPF

Success. Data Archive copies the report folder to 
the target archive folder.

2 UF2.MARA
UF2.MARC
UF2.BKPF

SAP.MARA
SAP.MARC

Error. Data Archive cannot copy the report folder 
because the target archive folder does not contain 
the table UF2.BKPF.

3 UF2.MARA
UF2.MARC
UF2.BKPF

SAP.MARA
SAP.MARC
DBO.BKPF

Error. Data Archive cannot copy the report folder 
because the tables in the target archive folder are 
spread across two different schemas, the SAP and 
the DBO schemas.
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When you run existing data visualization reports, they fail if you run the reports directly from Data Visualization 
Designer or "Advanced Reporting" on the new SSL-enabled environment.

For Data Visualization Designer, add SSL=1 to the JDBC URL. For Advanced Reporting, first run the report 
from the Reports and Dashboards page or the Patient Archives, and then run the report from the 
Advanced Reporting interface.

Designer Application
Data Visualization Designer is a stand-alone application that you can install on your desktop. Use the 
Designer application to create pixel-perfect page and web reports and then publish these reports to the Data 
Archive server. Reports on the Data Archive server appear on the data visualization interface and can be 
viewed and executed by you or other users.

Reports created in the Designer application can be edited only in Designer. Reports created on the data 
visualization interface can be edited on the interface or saved to a local machine and edited in Designer.

For information on how to use Designer, see the Data Archive Data Visualization Designer User Guide.
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Data Privacy
This chapter includes the following topics:
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• Data Privacy FAQ, 228

Data Privacy Overview
With Data Privacy, you can search for specific records in the Data Vault and export, purge, or export and 
purge the records. When you export the records, you can choose to export them to CSV or XML file format. 
When you search for the records initially, you can search across multiple applications in the Data Vault. Use 
Data Privacy to ensure compliance with organizational policies about locating and purging specific data in 
the Data Vault.

When you export, purge, or export and purge the records returned by a search, you can choose to run the job 
immediately or add the job to a batch of jobs to run at a later time. If you run an export, purge, or export and 
purge job immediately, the action triggers a job that you can monitor from the Monitor Jobs page. If you add 
the job to a batch, you can schedule the Data Privacy Batch standalone job to run multiple export, purge, or 
export and purge jobs at a later time.

The login user that you use to access Data Privacy and run a Data Privacy search or job must have the Data 
Privacy User system-defined role. The login user must also have the required Data Vault access role to 
search across the applications in Data Vault.
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Data Privacy Process
Complete the following tasks to run Data Privacy searches and then export, purge, or export and purge jobs:

1. In the Enterprise Data Manager, index the table columns that you want to include in the Data Privacy 
search. After you index the columns for search, you must run the Create Indexes on Data Vault or Re 
Index on Data Vault standalone job.

2. Assign the Data Privacy User system-defined role to the login user that accesses Data Privacy. By 
default the Administrator role has the Data Privacy User privileges. Verify that your login user has an 
access role with the necessary entity access to the application data.

3. In the Data Privacy search page, run a search for a specific term or text to return the matching records.

4. Choose whether to export, purge, or export and purge the search results. You can run the jobs 
immediately or add them to a batch to run later by scheduling the Data Privacy Batch standalone job.

5. Optionally, you can view and manage the Data Privacy jobs from the Manage Data Privacy page.

Column Indexing for Data Privacy Searches
Before you can run a Data Privacy search on data archived to the Data Vault, you must index the columns that 
you want to include in the search. You can manually mark the columns for indexing in Enterprise Data 
Manager. Or if you want to index a large number of columns, you can run the Export Index Metadata and 
Import Index Metadata jobs.

After you mark the necessary columns for indexing, run either the Create Indexes on Data Vault or the Re 
Index on Data Vault standalone job.

Run the Re Index on Data Vault standalone job if one of the following conditions is true:

• On Data Archive 6.4.4, you indexed the tables before you applied EBF 12307.

• On Data Archive 6.4.4, you ran update jobs, such as retention, legal hold, tagging, or purge jobs, on a table 
that was previously indexed.

• You archived additional data to the same Data Vault folder since you last indexed the table columns.

For more information about the Create Indexes on Data Vault and the Re Index on Data Vault standalone jobs, 
see the Data Archive Administrator Guide.

Indexing Columns for Search
In the Enterprise Data Manager, mark the columns that you want to include in the Data Privacy search for 
indexing.

1. In Data Archive, click Accelerators > Enterprise Data Manager to launch the Enterprise Data Manager. 

2. In the Enterprise Data Manager, click the Constraints tab and select an application version and a table 
that you want to index for search. 

3. Click the Columns tab. 

A list of all the columns in the table appears.

4. Enable the Index for Search field for each column you want to add to the Data Privacy search index. 
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5. Click the Save icon. 

6. Run the Create Indexes on Data Vault or Re Index on Data Vault standalone job to update the index. For 
more information on these jobs, see the Data Archive Administrator Guide. 

Indexing a Large Number of Columns for Search
If you want to index a large number of columns for a Data Privacy search, you can export a metadata CSV file 
from the Enterprise Data Manager and quickly mark which columns you want to index. Then, import the 
metadata file to update the indexing.

1. In the Enterprise Data Manager, click the Constraints tab. 

2. Right-click the application version that you want to index for search. 

3. Select Export Index Metadata. 

 

 

You receive a message that a background job will be submitted.
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4. Click OK. 

Data Archive triggers the Export Index Metadata job.

5. In Data Archive, click Jobs > Monitor Jobs. 

6. When the job completes successfully, expand the job details and click the Index Columns link to 
download the metadata file. 

 

 

7. Open the CSV metadata file. In the last column of the file, the QUICK_SEARCH_INDEX column, mark each 
column that you want to index for search with Y and columns that you do not want to index with N. 

 

 

8. Save the metadata file. 

9. In the Enterprise Data Manager, right-click the application version and select Import Index Metadata. 

10. Enter the location of the metadata file and click OK. 

Data Archive triggers an Import Index Metadata job that you can monitor from the Monitor Jobs page.

11. Run the Create Indexes on Data Vault or Re Index on Data Vault standalone job to update the index. For 
more information on these jobs, see the Data Archive Administrator Guide. 
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Data Privacy User and Access Roles
To access the Data Privacy menu and run a Data Privacy search or job, you must have the Data Privacy User 
system-defined role. You must also have a Data Vault access role with the required entity access assigned to 
it. By default, the Administrator user has the Data Privacy user role.

For more information on system-defined and access roles, see the Data Archive Administrator Guide.

Searching with Data Privacy
From the Data Privacy menu, you can conduct a search for a specific term or text. You can select which 
applications you want to search, provided that you have entity access to the applications. The search returns 
records that match the search text from the applications that you specified.

1. From the Data Archive main menu, select Data Privacy > Data Privacy Search. 

The Data Privacy Search page appears.

2. From the All Applications menu, select the applications that you want to search. 

 

 

3. In the Search Subject box, enter the search term or text that you want to search for. 

4. Click Search. 

Data Privacy returns indexed data from tables that you have access to across the applications that you 
selected.

For example, if you want to search for records that contain the terms "James" or "Smith":
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Supported Search Operators
Use search operators to refine the results of a Data Privacy search.

The following list describes the search operators that you can use in a Data Privacy search:

~ (Tilde)

For a fuzzy search, use the tilde ("~") symbol at the end of a single word search term. For example, to 
search for a term similar in spelling to "roam," use the fuzzy search: roam~

This type of search returns words like roam, roams, or foam.

To limit the results returned by a search using a tilde operator, append a 0 or 1 after the tilde operator. 
For example:

• ~0. This does a fuzzy search with zero edits. 0 operations (insertions, deletions or substitutions of a 
single character; or transposition of two adjacent characters) are allowed to change a word into 
another. For example, the search term "Doe~0" will return results if and only if Doe exists in the 
records.

• ~1. This does a fuzzy search with one edit. 1 operation (insertion, deletion or substitution of a single 
character, or the transposition of two adjacent characters) is allowed to change a word into another. 
For example, the search term "Zo~1" will find terms like Zoe, Jo, So, or Ho.

~ (Tilde) Between Two Distant Terms

This operator finds words that are a within a specific distance away. For example: "4007 9901"~2 will 
return 4007-5368-2997-9901 since 4007 and 9901 are separated by only 2 indexed terms (5368 and 
2997).

^ (Caret)

This operator boosts precedence of the term in search. For example:

Alan Zoe^4 will first return results that contain Zoe and then results that contain Alan.

Alan^4 Zoe will first return results that contain Alan and then results that contain Zoe

&& (Double Ampersand)

The && operator matches documents where both terms exist anywhere in the text of a single document. 
This is equivalent to an intersection using sets. For example:

Alan && Zheng will return the results which must contain both of the terms Alan and Zheng.

||, OR, Space

The operators ||, OR, or a space between two terms have the same function. These operators link two 
terms and find a matching document if either of the terms exist in a document. This is equivalent to a 
union using sets. You must enclose the complete search string in parenthesis.

For example:

(Alan || Zheng)

(Alan OR Zheng)

(Alan Zheng)

All three operators return the same result. The operators return results that contain either Alan or Zheng 
or both.
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+ (Plus Sign)

This operator requires that the term after the "+" symbol exist somewhere in the field of a single 
document.

For example:

James+ Smith will return all the results which must contain James and might also contain Smith.

? (Question Mark)

The single character wildcard search looks for terms that match the term with a single character 
replaced.

For example:

Al?n will return Alan, Alon, Alen.

* (Asterisk)

The multiple character wildcard search looks for 0 or more characters.

For example:

Alan* will return Alan, Alanda, Alane.

Using Data Privacy Purge
After you verify that the table indexes are up-to-date and identify a record or records with Data Privacy 
search, you can purge the records from Data Vault. Records that are on legal hold will not be purged.

1. After you have searched for the records that you want to purge, click the Purge button next to the Search 
Subject text box. 

The Purge pop-up window appears.

2. In the text box, enter a reason for the purge. 

3. Click Schedule Now to schedule the purge job to run immediately, or click Add to Batch to schedule the 
purge job at a later time with other Data Privacy jobs. 

Depending on whether you scheduled the job to run immediately or added the job to a batch, complete one of 
the following tasks.

Scheduling the Purge Job Immediately
When you select the Schedule Now option for the purge job, Data Archive triggers a Data Privacy Purge job 
and then opens the Monitor Jobs page.

1. On the Monitor Jobs page, expand the Data Privacy Purge job to view the job steps. 

2. When the "validate" job step is complete, Data Archive pauses the purge job. Before you can resume the 
job, you must review the Data Privacy Validation Report. 

3. Click the Review Data Privacy Validation link in the job details. 
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The Review Data Privacy Validation Report window opens.

4. Review the report details. Verify that the index row count matches the actual row count for each record. 

5. To download a .zip file of PDF reports that list the data that the job will purge, click the View Report link 
for each search term. Data Archive generates a PDF report for each table. 

 

 

6. To approve or reject the data for purge, select a report row and click the Approve or Reject button at the 
top of the report. Alternatively, you can click the green checkmark in the Action column to approve the 
records for purge or the red "X" to reject the records for purge. 

 

 

After you approve or reject the records, the status column reflects the action you have taken. If you have 
not approved or rejected a record, the status remains as "No Action." You must approve or reject each 
record in the validation report. If you do not approve or reject each record and try to resume the purge 
job, the job will fail.

7. Once you have approved or rejected all of the records in the validation report, return to the Monitor Jobs 
page and resume the Data Privacy Purge job. 

The job proceeds through the remaining steps to purge the validated data. During the "purge" job step, 
Data Archive both purges the data from the Data Vault and refreshes the indexes that are related to any 
purged tables. In the "delete report data" job step, Data Archive deletes the data generated in the 
validation step. The final job step, "refresh materialized views", refreshes the materialized views that are 
related to the purged tables.
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Adding the Purge Job to a Batch
When you select the Add to Batch option for the Purge job, Data Archive adds the job to a batch that you can 
run at a later time. To run a batch of jobs, you can review the search subjects on the Manage Data Privacy 
page and then schedule the Data Privacy Batch standalone job.

1. To review the search subjects that you have added to a batch, click Data Privacy > Manage Data Privacy. 

 

 

The Manage Data Privacy page opens. From this page, you can review all of the search subjects that you 
have added to a batch.

2. The search subjects that you have added to a batch are listed with the status "Not Executed." To remove 
any of these search subjects from the batch, click the Delete icon on the job row. 

3. To purge the records, run the Data Privacy Batch standalone job. Click Jobs > Schedule a Job. 

4. Choose Standalone Programs and click Add Item. 

The Select Definitions window appears with a list of all available jobs.

5. Select Data Privacy Batch from the list of standalone jobs. 

6. In the job parameters, select "Yes" if you want to refresh the materialized views related to the tables in 
the purge job. If you do not want to refresh the materialized views, select "No." This parameter is 
mandatory. 

7. Schedule the job to run. 

Note: When you schedule the Data Privacy Batch standalone job, any Data Privacy batch jobs with the 
status "Not Executed" in the Manage Data Privacy page will be added to the current operation for batch 
processing. For example, if you previously added some Export jobs to a batch and their status is still 
"Not Executed," then Data Archive runs the Export batch jobs as well as any Purge jobs that you have 
added to a batch.

8. On the Monitor Jobs page, the Data Privacy Batch standalone job appears as "Completed." The 
standalone job triggers a Data Privacy Purge job, an Export job, and/or an Export and Purge job based on 
the types of jobs you have added to the batch. 

The Data Privacy Purge job proceeds through the job steps, starting with a validate step. After the 
validate step, Data Archive pauses the job.

9. Before you can purge all of the records that you have added to a batch, you must review the Data Privacy 
validation report and approve or reject the records that will be purged. To open the Data Privacy 
validation report, click the Review Data Privacy Validation link in the job row. 

Note: You must review the validation report for every search subject in the batch job.

The Review Data Privacy Validation Report window opens.

10. Review the report details. Verify that the index row count matches the actual row count for each record. 

11. To download a .zip file of PDF reports that list the data that the job will purge, click the View Report link 
for each search term. Data Archive generates a PDF report for each table. 
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12. To approve or reject the data for purge, select a report row and click the Approve or Reject button at the 
top of the report. Alternatively, you can click the green checkmark in the Action column to approve the 
records for purge or the red "X" to reject the records for purge. 

 

 

After you approve or reject the records, the status column reflects the action you have taken. If you have 
not approved or rejected a record, the status remains as "No Action." You must approve or reject each 
record in the validation report.

13. After you have approved or rejected all of the records in the validation report, resume the batch job from 
the Monitor Jobs page. 

Data Archive continues to the "purge" job step. During the "purge" job step, Data Archive both purges the 
data from the Data Vault and refreshes the indexes that are related to any purged tables. In the "delete 
report data" job step, Data Archive deletes the data generated in the validation step. If you selected to 
run the "refresh materialized views" job step in the Data Privacy Batch standalone job, the final job step 
will be "refresh materialized views."

Using Data Privacy Export
After you verify that the table indexes are up-to-date and identify a record or records with Data Privacy 
search, you can export the records in CSV or XML file format. Records that are on legal hold will not be 
exported.

1. After you have searched for the records that you want to export, click the Export button next to the 
Search Subject text box. 

The Export pop-up window appears.

2. Select either CSV or XML for the file format that you want to export. 

3. In the text box, enter a reason for the export. 

4. Click Schedule Now to schedule the export job to run immediately, or click Add to Batch to schedule the 
export job at a later time with other Data Privacy jobs. 

Depending on whether you scheduled the job to run immediately or added the job to a batch, complete one of 
the following tasks.
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Scheduling the Export Job Immediately
When you select the Schedule Now option for the export job, Data Archive triggers a Data Privacy Export job 
and then opens the Monitor Jobs page.

1. On the Monitor Jobs page, expand the Data Privacy Export job to view the job steps. 

2. When the "validate" job step is complete, Data Archive pauses the export job. Before you can resume the 
job, you must review the Data Privacy Validation Report. If you resume the job without validating the 
report, the export job fails. 

3. Expand the job details of the "validate" step and click the Review Data Privacy Validation. 

 

 

The Review Data Privacy Validation Report window opens.

4. Review the report details. Verify that the index row count matches the actual row count for each record. 

5. To download a .zip file of PDF reports that list the data that the job will export, click the View Report link 
for each row. Data Archive generates a PDF report for each table. 

 

 

6. To approve or reject the data for export, select a report row and click the Approve or Reject button at the 
top of the report. Alternatively, you can click the green checkmark in the Action column to approve the 
records for export or the red "X" to reject the records for export. 

 

 

After you approve or reject the records, the status column reflects the action you have taken. If you have 
not approved or rejected a record, the status remains as "No Action." You must approve or reject each 
record in the validation report. If you do not approve or reject each record and try to resume the export 
job, the job fails at the "export" job step.
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7. Once you have approved or rejected all of the records in the validation report, return to the Monitor Jobs 
page and resume the Data Privacy Export job. 

The job proceeds through the remaining steps to export the validated data. During the "export" job step, 
Data Archive exports the data validated in the "validate" job step. In the job details for the "export" step, 
you can click the View Exported Data link to download a .zip file that contains the exported data in the 
specified file format. In the "delete report data" job step, Data Archive deletes the data generated in the 
validation step.

Adding the Export Job to a Batch
When you select the Add to Batch option for the export job, Data Archive adds the job to a batch that you can 
run at a later time. To run a batch of jobs, you can review the search subjects on the Manage Data Privacy 
page and then schedule the Data Privacy Batch standalone job.

1. To review the search subjects that you have added to a batch, click Data Privacy > Manage Data Privacy. 

 

 

The Manage Data Privacy page opens. From this page, you can review all of the search subjects that you 
have added to a batch.

2. The jobs that you have added to a batch are listed with the status "Not Executed." To remove any of 
these jobs from the batch, click the Delete icon on the job row. 

3. To export the records, run the Data Privacy Batch standalone job. Click Jobs > Schedule a Job. 

4. Choose Standalone Programs and click Add Item. 

The Select Definitions window appears with a list of all available jobs.

5. Select Data Privacy Batch from the list of standalone jobs. 

6. In the job parameters, select "Yes" if you want to refresh the materialized views related to the tables in 
the job. If you do not want to refresh the materialized views, select "No." This parameter is mandatory, 
but not specifically relevant to the Export job. If you run only Export jobs in a batch, the refresh 
materialized views step is unnecessary and Data Archive does not add the step to the Export job. If you 
run a batch job containing both Export and Purge jobs, this parameter applies to the Purge jobs in the 
batch. 

7. Schedule the job to run. 

Note: When you schedule the Data Privacy Batch standalone job, any Data Privacy batch jobs with the 
status "Not Executed" in the Manage Data Privacy page will be added to the current operation for batch 
processing. For example, if you previously added some Purge jobs to a batch and their status is still "Not 
Executed," then Data Archive runs the Purge batch jobs and any Export jobs that you have added to a 
batch.

8. On the Monitor Jobs page, the Data Privacy Batch standalone job appears as "Completed." The 
standalone job triggers a Data Privacy Purge job, an Export job, and/or an Export and Purge job based on 
the types of jobs you have added to the batch. 

The Data Privacy Export job proceeds through the job steps, starting with a validate step. After the 
validate step, Data Archive pauses the job.

9. Before you can run a batch job to export all of the records that you have added to a batch, you must 
review the Data Privacy validation report and approve or reject the records that will be exported. To open 
the Data Privacy validation report, click the Review Data Privacy Validation link in the job row. 
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Note: You must review the validation report for every search subject that you want to run in the batch 
job.

The Review Data Privacy Validation Report window opens.

10. Review the report details. Verify that the index row count matches the actual row count for each record. 

11. To download a .zip file of PDF reports that list the data that the job will export, click the View Report link 
for each search term. Data Archive generates a PDF report for each table. 

 

 

12. To approve or reject the data for export, select a report row and click the Approve or Reject button at the 
top of the report. Alternatively, you can click the green checkmark in the Action column to approve the 
records for export or the red "X" to reject the records for export. 

 

 

After you approve or reject the records, the status column reflects the action you have taken. If you have 
not approved or rejected a record, the status remains as "No Action." You must approve or reject each 
record in the validation report.

13. After you have approved or rejected all of the records in the validation report, resume the batch job from 
the Monitor Jobs page. 

Data Archive continues to the "export" job step. During the "export" job step, Data Archive exports the 
data validated in the "validate" job step. In the job details for the "export" step, you can click the View 
Exported Data link to download a .zip file that contains the exported data in the specified file format. In 
the "delete report data" job step, Data Archive deletes the data generated in the validation step.

Using Data Privacy Export and Purge
After you verify that the table indexes are up-to-date and identify a record or records with Data Privacy 
search, you can both export and then purge the records from Data Vault. Records that are on legal hold will 
not be exported or purged.

1. After you have searched for the records that you want to export and purge, click the Export and Purge 
button next to the Search Subject text box. 

The Export and Purge pop-up window appears.

2. Select either CSV or XML for the file format that you want to export. 

3. In the text box, enter a reason for the export and purge. 

4. Click Schedule Now to schedule the export job to run immediately, or click Add to Batch to schedule the 
export and purge job at a later time with other Data Privacy jobs. 
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Depending on whether you scheduled the job to run immediately or added the job to a batch, complete one of 
the following tasks.

Scheduling the Export and Purge Job Immediately
When you select the Schedule Now option for the export and purge job, Data Archive triggers a Data Privacy 
Export and Purge job and then opens the Monitor Jobs page.

1. On the Monitor Jobs page, expand the Data Privacy Export and Purge job to view the job steps. 

2. When the "validate" job step is complete, Data Archive pauses the export and purge job. Before you can 
resume the job, you must review the Data Privacy Validation Report. 

3. Click the Review Data Privacy Validation link in the Validate job step details. 

 

 

The Review Data Privacy Validation Report window opens.

4. Review the report details. Verify that the index row count matches the actual row count for each record. 

5. To download a .zip file of PDF reports that list the data that the job will export and purge, click the View 
Report link for each search term. Data Archive generates a PDF report for each table. 

 

 

6. To approve or reject the data for export and purge, select a report row or rows and click the Approve or 
Reject button at the top of the report. Alternatively, you can click the green checkmark in the Action 
column to approve the records for export and purge or the red "X" to reject the records for export and 
purge for each row. 
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After you approve or reject the records, the status column reflects the action you have taken. If you have 
not approved or rejected a record, the status remains as "No Action." You must approve or reject each 
record in the validation report. If you do not approve or reject each record and try to resume the export 
and purge job, the job fails at the "export" step.

7. Once you have approved or rejected all of the records in the validation report, return to the Monitor Jobs 
page and resume the Data Privacy Export and Purge job. 

The job proceeds through the remaining steps to export and purge the validated data. During the "export" 
job step, Data Archive exports the data validated in the "validate" job step. In the job details for the 
"export" step, you can click the View Exported Data link to download a .zip file that contains the exported 
data in the specified file format. Once the "export" job step is complete, Data Archive pauses the job. You 
can validate the exported data before proceeding to the "purge data" step. Resume the job to proceed to 
the "purge data" step or terminate the job to cancel the operation. During the "purge data" job step, Data 
Archive both purges the data from the Data Vault and refreshes the indexes that are related to any 
purged tables. In the "delete report data" job step, Data Archive deletes the data generated in the 
validation step. The final job step, "refresh materialized views," refreshes the materialized views that are 
related to the purged tables.

Adding the Export and Purge Job to a Batch
When you select the Add to Batch option for the export and purge job, Data Archive adds the job to a batch 
that you can run at a later time. To run a batch of jobs, you can review the search subects on the Manage 
Data Privacy page and then schedule the Data Privacy Batch standalone job.

1. To review the search subjects that you have added to a batch, click Data Privacy > Manage Data Privacy. 

 

 

The Manage Data Privacy page opens. From this page, you can review all of the search subjects that you 
have added to a batch.

2. The jobs that you have added to a batch are listed with the status "Not Executed." To remove any of 
these jobs from the batch, click the Delete icon on the job row. 

3. To export and purge the records, run the Data Privacy Batch standalone job. Click Jobs > Schedule a 
Job. 

4. Choose Standalone Programs and click Add Item. 

The Select Definitions window appears with a list of all available jobs.

5. Select Data Privacy Batch from the list of standalone jobs. 

6. In the job parameters, select "Yes" if you want to refresh the materialized views related to the tables in 
the export and purge job. If you do not want to refresh the materialized views, select "No." This 
parameter is mandatory. 

7. Schedule the job to run. 

Note: When you schedule the Data Privacy Batch standalone job, any Data Privacy batch jobs with the 
status "Not Executed" in the Manage Data Privacy page will be added to the current operation for batch 
processing. For example, if you previously added some Export jobs to a batch and their status is still 
"Not Executed," then Data Archive runs the Export batch jobs as well as any Export and Purge jobs that 
you have added to a batch.
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8. On the Monitor Jobs page, the Data Privacy Batch standalone job appears as "Completed." The 
standalone job triggers a Data Privacy Purge job, an Export job, and/or an Export and Purge job based on 
the types of jobs you have added to the batch. 

The Data Privacy Export and Purge job proceeds through the job steps, starting with a validate step. 
After the validate step, Data Archive pauses the job.

9. Before you can export and purge all of the records that you have added to a batch, you must review the 
Data Privacy validation report and approve or reject the records that will be exported and purged. To 
open the Data Privacy validation report, click the Review Data Privacy Validation link in the job row. 

Note: You must review the validation report for every search term that you want to run in the batch job.

The Review Data Privacy Validation Report window opens.

10. Review the report details. Verify that the index row count matches the actual row count for each record. 

11. To download a .zip file of PDF reports that list the data that the job will export and purge, click the View 
Report link for each search term. Data Archive generates a PDF report for each table. 

 

 

12. To approve or reject the data for export and purge, select a report row and click the Approve or Reject 
button at the top of the report. Alternatively, you can click the green checkmark in the Action column to 
approve the records for export and purge or the red "X" to reject the records for export and purge. 

 

 

After you approve or reject the records, the status column reflects the action you have taken. If you have 
not approved or rejected a record, the status remains as "No Action." You must approve or reject each 
record in the validation report.

13. After you have approved or rejected all of the records in the validation report, resume the batch job from 
the Monitor Jobs page. 

When you resume the job, Data Archive continues to the "export" job step. During the "export" job step, 
Data Archive exports the data validated in the "validate" job step. In the job details for the "export" step, 
you can click the View Exported Data link to download a .zip file that contains the exported data in the 
specified file format. During the "purge data" job step, Data Archive both purges the data from the Data 
Vault and refreshes the indexes that are related to any purged tables. In the "delete report data" job step, 
Data Archive deletes the data generated in the validation step. If you selected to run the "refresh 
materialized views" job step in the Data Privacy Batch standalone job, the final job step will be "refresh 
materialized views."
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Manage Data Privacy
In the Manage Data Privacy page, you can view all of the Data Privacy search subjects, their corresponding 
actions, and their status. You can click a link to review the validation report for each search subject. If the 
status is "Not Executed," you can delete the search subject from the batch.

The following image shows the Manage Data Privacy page:

 

 

The Manage Data Privacy page includes the search subject that you entered in the Data Privacy search, the 
action that you chose to take on the records, and other details.

To run the batch jobs that you have created, you can schedule the Data Privacy Batch standalone job. For 
more information about the Data Privacy Batch standalone job, see “Adding the Export Job to a Batch” on 
page 221, “Adding the Purge Job to a Batch” on page 218, and “Adding the Export and Purge Job to a 
Batch” on page 224.

Data Privacy Audit Logs
When you use Data Privacy to search for records, or run an export, purge, or export and purge job, the actions 
you take are recorded in the Data Archive audit logs.

The audit logs contain information about the action you performed, such as the type of action, your user 
name, and the date and time of the action. For example, if you run a Data Privacy search, the audit log 
contains details of the search as shown in the images below:

 

 

226       Chapter 16: Data Privacy



 

 

The following Data Privacy actions are recorded in the audit logs:

• Performing a search.

• Scheduling a purge, export, or export and purge job.

• Accessing a Data Privacy validation report.

• Downloading a Data Privacy validation report.

• Downloading the Data Privacy "export" job step .zip file.

• Accepting or rejecting a Data Privacy validation report.

• Resuming a Data Privacy job.

• The status of the different job steps.

To access the audit logs, click Administration > Audit Logs and then the View tab. For more information 
about audit logs, see the Data Archive Administrator Guide.

Parallel Jobs
You cannot run two Data Privacy jobs, for example Data Privacy Purge, Data Privacy Export, or Data Privacy 
Export and Purge, in parallel and on the same application. You must either complete or terminate the 
previously running job to run another job on the same application. You can run Data Privacy jobs on different 
applications in parallel.

In addition to parallel Data Privacy jobs, you cannot simultaneously run any job that updates Data Vault 
metadata while a Data Privacy job is running on an application. Any parallel job fails with an error.

The following list contains the jobs that you cannot run while a Data Privacy job runs on the same 
application:

• Archive crawler

• Update retention policy

• Purge expired records

• Add tagging

• Update tagging

• Remove tagging
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• Apply legal hold

• Load external attachments

• Restore external attachments from archive folder

• Archive structured digital records

• Restore file archive

• Create materialized views

• Refresh materialized views

• Release of information index record

If a Remove Legal Hold job is in an error or running state, you cannot run any Data Privacy job on any 
application.

Data Privacy FAQ
I have some records retired to my application, but I am not able to see those records in Data 
Privacy Search.

For records to be visible in Data Privacy Search, you must have access to the Data Vault folder and the 
related tables must be indexed.

How does job execution in batches work?

The Data Privacy Batch standalone job triggers jobs (Export, Export and Purge, Purge in that order) based on 
the search subjects with a "Not Executed" status in the Manage Data Privacy page.

All of the similar actions (Export, Purge, Export and Purge) are grouped into one job. For example, if there are 
two search subjects for the Export action, Data Archive triggers one Data Privacy Export job to process these 
two search subjects. The same applies for other actions.

Does the time required for the Data Privacy Purge and Data Privacy Export and Purge jobs 
depend on the number of table rows?

Yes. The amount of time required for these jobs depends on the number of rows in a table because Data 
Archive re-indexes the purged table. It does not depend on the number of records being purged.

Why do I see a difference in the row counts in the "Data Privacy Search" and the "Search in 
Data Vault" pages?

If there are records in the indexes that were created before 6.4.4 Data Privacy EBF12307 and if they are not 
re-indexed after you upgrade to the latest version, there is a difference in the row counts.

To fix this issue, after you upgrade to the latest version, run the Re Index on Data Vault standalone job on the 
specific application, or run the job on all applications (ALL CONNECTIONS).

The Create Indexes on Data Vault or Re Index on Data Vault job is failing with the exception 
"java.sql.SQLException: read/write operation failed." What should I do?

When you run the Create Indexes on Data Vault job, Data Archive runs multiple threads in parallel. Each 
thread fetches indexed column data from Data Vault. If the fetched data consumes more memory and the 
system memory is exhausted, you might face this issue. Use one of the following workarounds:

• Configure "informia.maxActiveIndexThreads" to 1. This creates a single thread to process tables in 
sequence.
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• Increase the system memory.

Which records are purged from Data Vault when I run “Data Privacy Export and Purge” or 
“Data Privacy Purge?”

Records that match the search subject and are not on legal hold will be purged. For “Data Privacy Export and 
Purge,” the .zip file created in the "export" job step contains the records that will be purged. For "Data Privacy 
Purge," the data present in the .pdf files in "Review Data Privacy Validation" will be purged.

I upgraded to the latest version. I can access Data Privacy Search, but I cannot see any 
applications under the "Choose an Application" drop-down. What do I do?

Run the Re Index on Data Vault standalone job. The corresponding applications will be visible.

I upgraded to the latest version. I can access Data Privacy Search, but I see the message 
"The Search Index is not up to date. The Data Archive Administrator must refresh the search 
index for the following application:", followed by application names. What do I do?

Run the Re Index on Data Vault standalone job for the specified applications or on all connections.

I have BLOB data in my table. Can I export the BLOB data using Data Privacy Export or 
Export and Purge?

Yes, you can export BLOB data to an XML file. If you select the CSV file format for export, the BLOB data will 
not be exported.

How long will my exported data exist in Data Archive. Can I configure the duration?

Yes, you can configure the duration. Click Administration > System Profile > Data Discovery Portal > Export 
Report Expiration Date and enter the number of days that you want to retain the report.

In Review Data Privacy Validation, I see a mismatch in the actual and Data Vault row counts. 
Clicking on Approve returns an error. Why am I getting this issue? How do I proceed?

There is mismatch between the actual and Data Vault row counts. The index is not in sync with the data 
present in the Data Vault. Terminate the current Data Privacy job and run the Re Index on Data Vault 
standalone job. Go to the Data Privacy Search page, run the search. and schedule the job.

Are there words that I should not use as search subjects in Data Privacy Search?

The following list contains the words that will retrieve all records, much like %. Do not use these words as 
search subjects in Data Privacy Search.

• a

• an

• and

• are

• as

• at

• be

• but

• by

• for

• if

• in

• into
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• is

• it

• no

• not

• of

• on

• or

• such

• that

• the

• their

• then

• there

• these

• they

• this

• to

• was

• will

• with
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C h a p t e r  1 7

Oracle E-Business Suite 
Retirement Reports

This chapter includes the following topics:

• Retirement Reports Overview, 231

• Prerequisites, 232

• Accounts Receivable Reports, 233

• Accounts Payable Reports, 236

• Purchasing Reports, 241

• General Ledger Reports, 242

• Saving the Reports to the Archive Folder, 245

• Running a Report, 245

Retirement Reports Overview
If you have a Data Visualization license, you can generate reports for certain application modules after you 
have retired the module data to the Data Vault. Run the reports to review details about the application data 
that you retired.

You can generate the reports in the Data Visualization area of Data Archive. Each report contains multiple 
search parameters, so that you can search for specific data within the retired entities. For example, you want 
to review payment activities related to a specific invoice for a certain supplier and supplier site. You can run 
the Invoice History Details report and select a specific value for the supplier and supplier type.

When you install the accelerator, the installer imports metadata for the reports as an entity within the 
appropriate application module. Each report entity contains an interim table and potentially multiple tables 
and views. You can view the report tables, views, and their columns and constraints in the Enterprise Data 
Manager. You can also use the report entity for Data Discovery.

Some reports also contain user-defined views. The user-defined views are required for some reports that 
include tables that have existed in different schemas in different versions of Oracle E-Business Suite. Some 
of the user-defined views are required because of the complexity of the queries that generate a single report. 
Finally, some of the user-defined views are required because some of the queries that generate the reports 
refer to package functions that Data Vault does not support.

You can run a script to create a user-defined view that is required for a report. Contact Informatica Global 
Customer Service to acquire the scripts for the user-defined views in each report.
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Prerequisites
Before you can run a Data Visualization report, you must first retire the Oracle E-Business Suite application.

Note: When you archive data from Oracle applications, the ILM repository must be an Oracle repository.

To retire a Oracle E-Business Suite application, perform the following high-level tasks:

1. In the Enterprise Data Manager, create a customer-defined application version.

2. Import metadata from the Oracle E-Business Suite application to the customer-defined application 
version, along with user-defined views.

3. Create retirement entities. Use the generate retirement entity wizard to automatically generate the 
retirement entities.

4. In the Data Archive user interface, create a source connection. For the connection type, choose the 
database in which the Oracle E-Business Suite application is installed.

5. Create a target connection to the Data Vault.

6. Define a new data type mapping to handle VARCHAR2(0) length columns that exist in the views.

a. In the Data Archive user interface, click Administration > Data Type Mappings for File Archive.

b. Click New Data Type Mapping.

c. For Connection Type, select All Connections.

d. For Data Type, select VARCHAR2.

e. For Operator, select Equals.

f. For Length, enter 0.

g. For Precision and Scale, enter 0,0.

h. For File Archive Data Type, select VARCHAR.

i. For Source Length, enter 40.

j. Click Save.

7. Run the create archive folder standalone job to create archive folders in the Data Vault.

8. Create and run a retirement project.

9. In the Enterprise Data Manager, create constraints for the imported source metadata in the ILM 
repository. Constraints are required for Data Discovery portal searches. The Oracle E-Business Suite 
application retirement accelerator includes constraints for some tables in the Oracle E-Business Suite 
system. You might need to define additional constraints for tables that are not included in the 
accelerator.

10. Copy the entities from the pre-packaged Oracle E-Business Suite application version to the customer-
defined application version. To copy the entities, perform the following high-level steps:

a. Right-click the customer-defined application version where the metadata is imported and select 
Copy entities from Application Version. The Copy Entities from Application Version window 
appears.

b. Select the application version from where you need to copy, which is typically Oracle Applications 
Retirement 1.0.

c. Provide the prefix that will be appended before the entity while copying. The Copy All Entities option 
is not required.

d. Click OK.
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e. After you submit the background job, you can view the job status from the Data Archive user 
interface. Once the job successfully completes, you can view the copied entities in your customer-
defined application version. You can use these entities for Data Discovery.

11. Before you run the reports, copy the report templates to the folder that corresponds to the Data Vault 
connection. You can use these pre-packaged Data Visualization reports to access retired data in the 
Data Vault. When you copy the reports, the system updates the report schemas based on the connection 
details.

12. Optionally, validate the retired data.

13. After you retire and validate the application, use the Data Discovery Portal, Data Visualization reports, or 
third-party query tools to access the retired data.

Accounts Receivable Reports
In the Accounts Receivable module, you can run the following reports:

• Customer Listing Detail

• Adjustment Register

Customer Listing Detail Report
Use the Customer Listing Detail report to review summary information about your customers. You can view 
customer name, customer number, status, and any addresses or site uses you entered for a customer.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Set of Books <Any> Yes

Operating Unit <Any> Yes

Order By Customer Name No

Customer Name <Any> No

Customer Number Low <Any> No

Customer Number High <Any> No

Report Tables and Views
The following tables and views are included in the report:

Tables
• HZ_CUSTOMER_PROFILES

• HZ_CUST_ACCOUNTS
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• HZ_CUST_ACCT_SITES_ALL

• HZ_CUST_PROFILE_CLASSES

• HZ_PARTIES

• HZ_PERSON_PROFILES

Views
• OE_LOOKUPS_115

• OE_PRICE_LISTS_115_VL

• OE_TRANSACTION_TYPES_VL

• ORG_FREIGHT_VL

• ORG_ORGANIZATION_DEFINITIONS

• AR_LOOKUPS

• RA_SALESREPS

User-Defined Views
• V_REPORT_CU_ADDRESS

• V_REPORT_CU_AD_CONTACTS

• V_REPORT_CU_AD_PHONE

• V_REPORT_CU_AD_BUSPURPOSE

• V_REPORT_CU_AD_CON_ROLE

• V_REPORT_CU_AD_CON_PHONE

• V_REPORT_CU_BANKACCOUNTS

• V_REPORT_CU_BUS_BANKACCOUNT

• V_REPORT_CU_BUS_PYMNT_MTHD

• V_REPORT_CU_CONTACTS

• V_REPORT_CU_CONTACT_PHONE

• V_REPORT_CU_CONTACT_ROLES

• V_REPORT_CU_PHONES

• V_REPORT_CU_PYMNT_MTHDS

• V_REPORT_CU_RELATIONS

• V_REPORT_GL_SETS_OF_BOOKS

Adjustment Register Report
Use the Adjustment Register report to review approved adjustments by document number. Adjustments 
include manual adjustments, automatic adjustments, invoices applied to commitments, and credit memos 
applied to commitment-related invoices. This report groups and displays transactions by currency, postable 
status, document sequence name, and balancing segment.
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Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Chart of Accounts - Yes

Operating Unit <Any> Yes

Set of Books <Any> Yes

Company Segment Value <Any> No

Report Tables and Views
The following tables and views are included in the report:

Tables
• GL_CODE_COMBINATIONS

Views
• ORG_ORGANIZATION_DEFINITIONS

• FND_FLEX_VALUES_VL

• FND_ID_FLEX_SEGMENTS_VL

User-Defined Views
• V_REPORT_GL_SETS_OF_BOOKS

• V_REPORT_ADJMNT_REGISTER

AR Transaction Detail Report
Use the AR Transaction Detail report to review all of the information you entered for invoices, credit memos, 
debit memos, chargebacks, guarantees, and deposits.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Operating Unit <Any> Yes

Set of Books <Any> Yes

Transaction Class <Any> No

Transaction Number Low - Yes

Transaction Number High - Yes
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Report Views
The following views are included in the report:

Views
• ORG_ORGANIZATION_DEFINITIONS

• AR_LOOKUPS

User-Defined Views
• V_REPORT_GL_SETS_OF_BOOKS

• V_REPORT_AR_ACCTSETS

• V_REPORT_AR_FRTLINES

• V_REPORT_AR_LINES

• V_REPORT_AR_RELTRX

• V_REPORT_AR_REVACCTS

• V_REPORT_AR_SALESREPS

• V_REPORT_AR_TAXLINES

• V_REPORT_AR_TRNFLEX

• V_REPORT_TRANSACTIONS

Accounts Payable Reports
In the Accounts Payable module, you can run the following reports:

• Supplier Details

• Supplier History Payment Details

• Invoice History Details

Supplier Details Report
The Supplier Details report contains detailed information about supplier records. You can use this report to 
verify the accuracy of your current supplier information and to manage your master listing of supplier 
records.

The report displays detailed information for each supplier, and optionally, supplier site, including the user 
who created the supplier/site, creation date, pay group, payment terms, bank information, and other supplier 
or site information. You can sort the report by suppliers in alphabetic order, by supplier number, by the user 
who last updated the supplier record, or by the user who created the supplier record.
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Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Set of Books <Any> Yes

Operating Unit <Any> Yes

Supplier Type <Any> No

Supplier Name <Any> No

Include Site Information Yes No

Include Contact Information Yes No

Include Bank Account Information Yes No

Order By Supplier Name No

Report Tables and Views
The following tables and views are included in the report:

Tables
• AP_BANK_ACCOUNTS_ALL

• AP_BANK_ACCOUNT_USES_ALL

• AP_TERMS_TL

• FND_USER

• AP_TOLERANCE_TEMPLATES

Views
• ORG_ORGANIZATION_DEFINITIONS

• PO_LOOKUP_CODES

• AP_LOOKUP_CODES

• FND_LOOKUP_VALUES_VL

• FND_TERRITORIES_VL

User-Defined Views
• V_REPORT_PO_VENDORS

• V_REPORT_PO_VENDOR_SITES_ALL

• V_REPORT_GL_SETS_OF_BOOKS

• V_REPORT_PO_VENDOR_CONTACTS
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Supplier Payment History Details Report
Run the Supplier Payment History report to review the payment history for a supplier or a group of suppliers 
with the same supplier type.

You can submit this report by supplier or supplier type to review the payments that you made during a 
specified time range. The report displays totals of the payments made to each supplier, each supplier site, 
and all suppliers included in the report. If you choose to include invoice details, the report displays the invoice 
number, date, invoice amount, and amount paid.

The Supplier Payment History Details report also displays the void payments for a supplier site. The report 
does not include the amount of the void payment in the payment total for that supplier site. The report lists 
supplier payments alphabetically by supplier and site. You can order the report by payment amount, payment 
date, or payment number. The report displays payment amounts in the payment currency.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Set of Books <Any> Yes

Operating Unit <Any> Yes

Supplier Type <Any> No

Supplier Name <Any> No

Start Payment Date System Date Yes

End Payment Date System Date Yes

Invoice Detail Yes No

Order By Option Payment Date No

Report Tables and Views
The following tables and views are included in the report:

Tables
• AP_CHECKS_ALL

• AP_INVOICES_ALL

• AP_INVOICE_PAYMENTS_ALL

• FND_LOOKUP_VALUES

Views
• ORG_ORGANIZATION_DEFINITIONS

User-Defined Views
• V_REPORT_PO_VENDORS

• V_REPORT_PO_VENDOR_SITES_ALL
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• V_REPORT_GL_SETS_OF_BOOKS

Invoice History Details Report
The Invoice History Details report includes information to support the balance due on an invoice.

The report generates a detailed list of all payment activities that are related to a specific invoice, such as 
gains, losses, and discounts. The report displays amounts in the payment currency.

Important: Payments must be accounted before the associated payment activities appear on the report.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Set of Books <Any> Yes

Operating Unit <Any> Yes

Supplier <Any> No

Supplier Site <Any> No

Pre-payments Only YES No

Invoice Number From - No

Invoice Number To - No

Invoice Date From - No

Invoice Date To - No

Report Views
The following views are included in the report:

Views
• ORG_ORGANIZATION_DEFINITIONS

User-Defined Views
• V_INVOICE_HIST_HDR

• V_INVOICE_HIST_DETAIL

• V_REPORT_PO_VENDORS

• V_REPORT_PO_VENDOR_SITES_ALL

• V_REPORT_GL_SETS_OF_BOOKS
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Print Invoice Notice Report
Use the print invoice notice report to generate a standard invoice notice to send to a supplier to inform them 
about one or more invoices you have entered. The notice informs the supplier of outstanding credit or debit 
memos that you will apply to future invoices.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Invoice Date From - Yes

Supplier Type <Any> Yes

Supplier Name <Any> No

Pay Group <Any> No

Invoice Type <Any> No

Invoice Number - Yes

Name of Sender - No

Title of Sender - No

Phone of Sender - No

Report Tables and Views
The following tables and views are included in the report:

Tables
• PO_USAGES

• PO_LINE_LOCATIONS_ALL

• PO_LINES_ALL

• PO_HEADERS_ALL

• PO_DISTRIBUTIONS_ALL

• FND_LOOKUP_VALUES

• FND_DOCUMENT_CATEGORIES

• FND_DOCUMENTS_TL

• FND_DOCUMENTS_SHORT_TEXT

• FND_DOCUMENTS_LONG_TEXT

• FND_DOCUMENTS

• FND_ATTACHED_DOCUMENTS

• AP_INVOICES_ALL

• AP_INVOICE_DISTRIBUTIONS_ALL
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Views
• PO_LOOKUP_CODES

User-Defined Views
• V_REPORT_PO_VENDORS

• V_REPORT_PO_VENDOR_SITES_ALL

Purchasing Reports
In the Purchasing module, you can run the following report:

• Purchase Order Details

Purchase Order Details Report
The Purchase Order Detail report lists all, specific standard, or planned purchase orders.

The report displays the quantity that you ordered and received, so that you can monitor the status of your 
purchase orders. You can also review the open purchase orders to determine how much you still have to 
receive and how much your supplier has already billed to you.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Set of Books <Any> Yes

Operating Unit <Any> Yes

Vendor From <Any> No

To <Any> No

PO Number From - No

To - No

Buyer Name <Any> No

Status <Any> No

Report Tables and Views
The following tables and views are included in the report:

Tables
• FND_CURRENCIES
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• MTL_CATEGORIES_B

• MTL_SYSTEM_ITEMS_B

• PO_DOCUMENT_TYPES_ALL_TL

• PO_HEADERS_ALL

• PO_LINES_ALL

• PO_LINE_LOCATIONS_ALL

Views
• ORG_ORGANIZATION_DEFINITIONS

• PO_LOOKUP_CODES

• PER_PEOPLE_F

User-Defined Views
• V_PO_HDR_LINES

• V_PO_HDR_LKP_CODE

• V_REPORT_GL_SETS_OF_BOOKS

• V_REPORT_PO_VENDORS

• V_REPORT_PO_VENDOR_SITES_ALL

General Ledger Reports
In the General Ledger module, you can run the following reports:

• Chart of Accounts - Detail Listing

• Journal Batch Summary

Chart of Accounts - Detail Listing Report
Use the Chart of Accounts - Detail Listing report to review the detail and summary accounts defined for the 
chart of accounts.

This report has three sections. The first section is for enabled detail accounts, followed by disabled 
accounts, and then summary accounts. Each section is ordered by the balancing segment value. You can 
specify a range of accounts to include in your report. You can also sort your accounts by another segment in 
addition to your balancing segment.

Report Parameters
The following tables describes the report input parameters:

Parameter Default Value Mandatory

Chart of Accounts US Federal Grade Yes

Account From - Company - Yes
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Parameter Default Value Mandatory

Account From - Department - Yes

Account From - Account - Yes

Account From - Sub-account - Yes

Account From - Product - Yes

Account To - Company - Yes

Account To - Department - Yes

Account To - Account - Yes

Account To - Sub-account - Yes

Account To - Product - Yes

Order By Account Yes

Report Tables and Views
The following tables and views are included in the report:

Tables
• GL_CODE_COMBINATIONS

Views
• FND_FLEX_VALUES_VL

• FND_ID_FLEX_SEGMENTS_VL

• FND_ID_FLEX_STRUCTURES_VL

• GL_LOOKUPS

Journal Batch Summary Report
The Journal Batch Summary report displays information on actual balances for journal batches, source, batch 
and posting dates, and total entered debits and credits.

Use the report to review posted journal batches for a particular ledger, balancing segment value, currency, 
and date range. The report sorts the information by journal batch within each journal entry category. In 
addition, the report displays totals for each journal category and a grand total for each ledger and balancing 
segment value combination. This report does not report on budget or encumbrance balances.
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Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Chart of Accounts <Any> Yes

Ledger/Ledger Set <Any> Yes

Currency <Any> Yes

Balancing Statement <Any> Yes

Start Date - Yes

End Date - Yes

Adjustment Periods Yes Yes

Report Tables and Views
The following tables and views are included in the report:

Tables
• GL_DAILY_CONVERSION_TYPES

• GL_JE_BATCHES

• GL_CODE_COMBINATIONS

• GL_JE_HEADERS

• GL_JE_LINES

• GL_PERIODS

• GL_PERIOD_STATUSES

Views
• FND_CURRENCIES_VL

• FND_FLEX_VALUES_VL

• FND_ID_FLEX_SEGMENTS_VL

• GL_JE_CATEGORIES_VL

• GL_JE_SOURCES_VL

User-Defined Views
• V_REPORT_GL_SETS_OF_BOOKS
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Saving the Reports to the Archive Folder
Before you can run a report, you must save the imported reports to the Data Vault archive folder where you 
retired the application data.

1. Click Data Visualization > Reports and Dashboards. 

2. Click the check box next to ILM_OracleApps to select all of the imported reports. 

3. Click Actions > Save As. 

The Save As window appears.

4. Select the Data Vault archive folder where you retired the application data. 

5. Enter a name for the reports folder. 

6. Click OK. 

Data Archive creates the reports folder within the archive folder.

Running a Report
You can run a report through the Data Visualization area of Data Archive. Each report has two versions. To 
run the report, use the version with "Search Form" in the title, for example "Invoice History Details Report - 
Search Form.cls."

To ensure that authorized users can run the report, review the user and role assignments for each report in 
Data Archive.

1. Click Data Visualization > Reports and Dashboards. 

2. Select the check box next to the report that you want to run. 

3. Click Actions > Run Report. 

The Report Search Form window appears.

4. Enter or select the values for each search parameter that you want to use to generate the report. 

5. Click Apply. 
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This chapter includes the following topics:
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• Accounts Receivable Reports, 257

• Sales Order Management Reports, 259

• Inventory Reports, 261

• Address Book Reports, 262

• Saving the Reports to the Archive Folder, 263

• Running a Report, 263

Retirement Reports Overview
If you have a Data Visualization license, you can generate reports for certain application modules after you 
have retired the module data to the Data Vault. Run the reports to review details about the application data 
that you retired.

You can generate the reports in the Data Visualization area of Data Archive. Each report contains multiple 
search parameters, so that you can search for specific data within the retired entities. For example, you want 
to review purchase orders with a particular order type and status code. You can run the Print Purchase Order 
report and select a specific value for the order type and status code.

When you install the accelerator, the installer imports metadata for the reports as an entity within the 
appropriate application module. Each report entity contains an interim table and multiple report-related 
tables. You can view the report tables and the table columns and constraints in the Enterprise Data Manager. 
You can also use the report entity for Data Discovery.
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Prerequisites
Before you can run a Data Visualization report, you must first retire the JDEdwards Enterprise application.

To retire a JD Edwards Enterprise application, perform the following high-level tasks:

1. In the Enterprise Data Manager, create a customer-defined application version. 

2. Import metadata from the JD Edwards application to the customer-defined application version. 

3. Create retirement entities. Use the generate retirement entity wizard to automatically generate the 
retirement entities. 

4. In the Data Archive user interface, create a source connection. For the connection type, choose the 
database in which the JD Edwards application is installed. 

5. Configure the JD Edwards application login properties. 

6. Create a target connection to the Data Vault. 

7. Run the create archive folder standalone job to create archive folders in the Data Vault. 

8. Create and run a retirement project. 

9. In the Enterprise Data Manager, create constraints for the imported source metadata in the ILM 
repository. Constraints are required for Data Discovery Portal searches. The JD Edwards application 
retirement accelerator includes constraints for some tables in the JD Edwards system. You might need 
to define additional constraints for tables that are not included in the accelerator. 

10. Copy the entities from the pre-packaged JD Edwards application version to the customer-defined 
application version. To copy the entities, perform the following high-level steps: 

After you install the JD Edwards retirement report accelerator, the report entities and application 
modules appear underneath the JD Edwards Retirement application 1.0.

• If you imported the application metadata from a single schema to the customer-defined application 
version:

a. Right click on the customer-defined application version where you imported the metadata and select 
Copy Entities from Application Version. 

The Copy Entities from Application Version window appears.

b. Select the application version from where you need to copy, which is typically JD Edwards 
Retirement 1.0. 

c. Provide the prefix that will be appended before the entity while copying. The Copy All Entities option 
is not required. 

d. Click OK. 

e. After you submit the background job, you can view the job status from the Data Archive user 
interface. Once the job successfully completes, you can view the copied entities in your customer-
defined application version. You can use these entities for Data Discovery. 

• If you imported the application metadata from multiple schemas to the customer-defined application 
version, you must march the schema names and the application module names in the ILM repository 
to the pre-packaged JD Edwards application version names. To map these names, you must manually 
update the ILM repository. After you copy the entities, you will revert back to the original names.
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The pre-packaged JD Edwards application version has two schemas: TESTDTA and TESTCTL. The 
TESTCTL schema has one table called "F0005." The remaining tables are from TESTDTA.

a. Run the following update statements: 

/* identify your custom-defined product family version id*/
SELECT * FROM AM_PRODUCT_FAMILY_VERSIONS; 
/* identify schema id’s of custom-defined product family version*/
SELECT * FROM AM_META_SCHEMAS WHERE PRODUCT_FAMILY_VERSION_ID= < pfv id>; 
UPDATE AM_META_SCHEMAS SET META_SCHEMA_NAME='TESTCTL' WHERE 
META_SCHEMA_ID=<Schema id of F0005 table>;
UPDATE AM_META_SCHEMAS SET META_SCHEMA_NAME='TESTDTA'  WHERE 
META_SCHEMA_ID=<Schema id of remaining tables>;

b. Create the metadata application modules to map to the JD Edwards retirement application modules. 
Right-click on the application version and select New Application Module. 

The Application Module Wizard window appears.

c. Enter the application module name to match the source name. 

d. Repeat the naming process for all of the modules. 

e. Right-click the product family version where the tables are imported and retired. 

f. Select Copy Entities from Application Version. 

The Copy Entities from Application Version window appears.

g. Select the application version from where you need to copy, typically JD Edwards Retirement 1.0. 

h. Provide the prefix that will be appended before the entity while copying. The Copy All Entities option 
is not required. 

i. Click OK. 

j. After you submit the background job, you can view the job status from the Data Archive user 
interface. Once the job successfully completes, you can view the copied entities in your customer-
defined application version. You can use these entities for Data Discovery and retention. 

k. Once the copy process is complete, revert the updates you made in step a. 

In JD Edwards applications, dates are stored in Julian format which is 5 or 6 digits. When you search on 
columns with date values in Data Discovery, select data conversion from Julian data to Gregorian data in 
the available search options.
To update a retention policy, use the following conversion from Julian to Gregorian as an expression:

(CASE WHEN length(char(dec(F43199.OLUPMJ))) = 5 THEN date('1900-01-01') + 
int(left(char(int(F43199.OLUPMJ)),2)) years + int(right(char(int(F43199.OLUPMJ)),
3))-1 days ELSE date('1900-01-01') + int(left(char(int(F43199.OLUPMJ)),3)) years + 
int(right(char(int(F43199.OLUPMJ)),3))-1 days END)

11. Before you run the reports, copy the report templates to the folder that corresponds to the Data Vault 
connection. You can use these pre-packaged Data Visualization reports to access retired data in the 
Data Vault. When you copy the reports, the system updates the report schemas based on the connection 
details. 

12. Optionally, validate the retired data. 

13. After you retire and validate the application, use the Data Discovery Portal, Data Visualization reports, or 
third-party query tools to access the retired data. 
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Accounts Payable Reports
In the Accounts Payable module, you can run the following reports:

• AP Payment History Details

• Open AP Summary

• Manual Payment

• Voucher Journal

AP Payment History Details Report
The AP Payment History Details report shows voucher details for all payments from a selected supplier. Use 
this report to determine which vouchers have been paid.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Supplier % Yes

Start Payment Date - No

End Payment Date - No

Report Tables
The following tables are included in the report:

• F0005

• F0010

• F0101

• F0111

• F0411

• F0413

• F0414

Open AP Summary Report
The Open AP Summary report displays the total open payable amounts for each supplier. Use the report to 
review summary information about open balances and aging information.

Accounts Payable Reports       249



Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Aging Date System Date Yes

Date Type G - G/L Date No

Aging Credits 0 No

Company Name % Yes

Order Type % No

Supplier Number % Yes

Report Tables
The following tables are included in the report:

• F0005

• F0010

• F0101

• F0013

• F0115

• F0411

Manual Payment Report
Use this report to review manual payment journal information in a printed format, instead of viewing the 
information online.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Document Company % Yes

Document Type % No

Document Number - No

Report Tables
The following tables are included in the report:

• F0005
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• F0010

• F0013

• F0111

• F0411

• F0413

• F0414

• F0901

• F0911

Voucher Journal Report
Use this report to review voucher journal information in a printed format, instead of viewing the information 
online.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Document Company % Yes

Document Type % No

Document Number - No

Batch Number - No

Report Tables
The following tables are included in the report:

• F0005

• F0010

• F0013

• F0111

• F0411

• F0901

• F0911

Procurement Management Reports
In the Procurement Management module, you can run the following reports:

• Print Purchase Order
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• Purchase Order Detail Print

• Purchase Order Revisions

Print Purchase Order Report
The Print Purchase Order report prints the purchase orders that you have created. Use the reports to review 
the orders and send them to the appropriate suppliers.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Order Number From - No

Order Number To - No

Order Type % No

Company % Yes

Supplier % No

Status Code % Yes

Report Tables
The following tables are included in the report:

• F0005

• F0101

• F0010

• F0111

• F0116

• F4301

• F4311

Purchase Order Detail Print Report
The Purchase Order Detail Print report displays the system print information about subcontracts, for example 
associated text and tax information.
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Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Order Number From - No

Order Number To - No

Order Type % No

Company % Yes

Supplier % Yes

Report Tables
The following tables are included in the report:

• F0005

• F0101

• F0010

• F0006

• F4301

• F4316

• F4311

Purchase Order Revisions History Report
Use the Purchase Order Revisions History report to review information about order revisions, for example the 
number of revisions to each detail line and the history of all detail line revisions.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Order Number From - No

Order Number To - No

Order Type % No

Order Company % Yes

Supplier % Yes
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Report Tables
The following tables are included in the report:

• F0005

• F0101

• F0010

• F0013

• F40205

• F4301

• F4311

• F4316

• F43199

General Accounting Reports
In the General Accounting module, you can run the following reports:

• General Journal by Account

• Supplier Customer Totals by Account

• General Journal Batch

• GL Chart of Accounts

• GL Trial Balance

General Journal by Account Report
Use the General Journal by Account report to review posted and unposted transactions by account. The 
report displays totals by the account number.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Document Number - No

Document Type % Yes

Account Number % No

Report Tables
The following tables are included in the report:

• F0005

• F0010
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• F0013

• F0901

• F0911

Supplier Customer Totals by Account Report

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Account Number % No

Address Number % No

Company % Yes

Report Tables
The following tables are included in the report:

• F0006

• F0010

• F0013

• F0101

• F0111

• F0116

• F0901

• F0911

General Journal Batch Report
The General Journal Batch report prints the debit and credit amounts that amount to balanced entries for 
invoices and vouchers.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Batch Number - No

Batch Type % No

Document Number From - No
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Parameter Default Value Mandatory

Document Number To - No

Document Type % Yes

Ledger Type % Yes

Report Tables
The following tables are included in the report:

• F0005

• F0901

• F0911

GL Trial Balance Report
Use the Trial Balance report to review account balances across all business units. You can review similar 
object accounts, such as all cash accounts. You can also view account totals for each group of accounts.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Fiscal Year (yyyy) Current Fiscal Year Yes

Period 1 Yes

Company Name % Yes

Ledger Type AA% No

Sub Ledger * No

Sub Ledger Type % No

Currency Code % No

Report Tables
The following tables are included in the report:

• F0012

• F0013

• F0902

• F0901

• F0008
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• F0005

• F0010

GL Chart of Accounts Report
Use the Chart of Accounts report to review the updated chart of accounts.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Posting Edit Code % No

Company % Yes

Report Tables
The following tables are included in the report:

• F0909

• F0005

• F0010

Accounts Receivable Reports
In the Accounts Receivable module, you can run the following reports:

• Open Accounts Receivable Summary

• AR Print Invoice

• Invoice Journal

Open Accounts Receivable Summary Report
Use the Open Accounts Receivable Summary report to review summary information about open voucher 
balances in addition to aging information.
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Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Aging Date System date No

Print Parent Number - No

Date to Aging Accounts From D-DUEDATE No

Age Credits 0 No

Company % Yes

Address Number % Yes

Report Tables
The following tables are included in the report:

• F03B11

• F0010

• F0013

• F0101

Invoice Journal Report
Use the Invoice Journal report to print invoice journal information. The system selects transactions from the 
customer ledger (F03B11) and account ledger (F0911) tables.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Batch Type % No

Batch Number - No

Document Type % No

Document Number - No

Company % Yes

Report Tables
The following tables are included in the report:

• F0005
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• F0010

• F0013

• F03B11

• F0901

• F0911

AR Print Invoice Report
Use this report to print the invoices that you created during invoice entry or receipts entry.

Report Parameters
The following tables describes the report input parameters:

Parameter Default Value Mandatory

Invoice Print Date System date No

Print Currency - No

Print Tax Amounts - No

Report Tables
The following tables are included in the report:

• F0005

• F0010

• F0013

• F0101

• F0111

• F0116

• F03B11

Sales Order Management Reports
In the Sales Order Management module, you can run the following reports:

• Print Open Sales Order

• Sales Ledger

• Print Held Sales Order
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Print Open Sales Order Report
Use the Print Open Sales Order report to review orders that have been picked but not shipped, or picked but 
not billed. You can also review orders that exceed the customer's requested ship date.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Branch Number % No

From Date 1900-01-01 No

Thru Date System Date No

Order Type % No

Company % Yes

Status Code % No

Currency Print Option - No

Report Tables
The following tables are included in the report:

• F0005

• F0006

• F0013

• F0101

• F4211

• F0010

Sales Ledger Report
Use the Sales Ledger report to analyze and review sales history based on the specific customer number and 
branch.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

From Date 1900-01-01 No

Thru Date System date No
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Parameter Default Value Mandatory

Customer Number % No

Branch Number % No

Report Tables
The following tables are included in the report:

• F0006

• F0013

• F0101

• F4101

• F42199

• F0010

Print Held Sales Order Report
Use this report to review a list of all sales orders that are on hold for credit, profit margin, partial order hold, 
and price review.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Hold Code % No

Report Tables
The following tables are included in the report:

• F0005

• F0101

• F4209

Inventory Reports
In the Inventory module, you can run the following report:

• Item Master Directory

Item Master Directory Report
Use this report to print a list of item master records.
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Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Item Number % No

Report Tables
The following tables are included in the report:

• F4101

• F0005

Address Book Reports
In the Address Book module, you can run the following reports:

• One Line Per Address

One Line Per Address Report
Use the One Line Per Address report to print a list of all addresses that contain one line of detail for each 
address number.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Address Number % No

Report Tables
The following tables are included in the report:

• F0005

• F0101

• F0111

• F0115

• F0116
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Saving the Reports to the Archive Folder
Before you can run a report, you must save the imported reports to the Data Vault archive folder where you 
retired the application data.

1. Click Data Visualization > Reports and Dashboards. 

2. Click the check box next to ILM_JDEdwards to select all of the imported reports. 

3. Click Actions > Save As. 

The Save As window appears.

4. Select the Data Vault archive folder where you retired the application data. 

5. Enter a name for the reports folder. 

6. Click OK. 

Data Archive creates the reports folder within the archive folder.

Running a Report
You can run a report through the Data Visualization area of Data Archive. Each report has two versions. To 
run the report, use the version with "Search Form" in the title, for example "Invoice Journal Report - Search 
Form.cls."

To ensure that authorized users can run the report, review the user and role assignments for each report in 
Data Archive.

1. Click Data Visualization > Reports and Dashboards. 

2. Select the check box next to the report that you want to run. 

3. Click Actions > Run Report. 

The Report Search Form window appears.

4. Enter or select the values for each search parameter that you want to use to generate the report. 

5. Click Apply. 
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• Running a Report, 277

Retirement Reports Overview
If you have a Data Visualization license, you can generate reports for certain application modules after you 
have retired the module data to the Data Vault. Run the reports to review details about the application data 
that you retired.

You can generate the reports in the Data Visualization area of Data Archive. Each report contains multiple 
search parameters, so that you can search for specific data within the retired entities. For example, you want 
to review purchase orders with a particular order type and status code. You can run the Print Purchase Order 
report and select a specific value for the order type and status code.

When you install the accelerator, the installer imports metadata for the reports as an entity within the 
appropriate application module. Each report entity contains an interim table and multiple report-related 
tables. You can view the report tables and the table columns and constraints in the Enterprise Data Manager. 
You can also use the report entity for Data Discovery.
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Prerequisites
Before you can run a Data Visualization report, you must first retire the Oracle PeopleSoft application.

To retire a PeopleSoft application, perform the following high-level tasks:

1. In the Enterprise Data Manager, create a customer-defined application version.

2. Import metadata from the PeopleSoft application to the customer-defined application version, along with 
user-defined views.

3. Create retirement entities. Use the generate retirement entity wizard to automatically generate the 
retirement entities.

4. In the Data Archive user interface, create a source connection. For the connection type, choose the 
database in which the PeopleSoft application is installed.

5. Create a target connection to the Data Vault.

6. Run the create archive folder standalone job to create archive folders in the Data Vault.

7. Create and run a retirement project.

8. In the Enterprise Data Manager, create constraints for the imported source metadata in the ILM 
repository. Constraints are required for Data Discovery portal searches. The PeopleSoft application 
retirement accelerator includes constraints for some tables in the PeopleSoft system. You might need to 
define additional constraints for tables that are not included in the accelerator.

9. Copy the entities from the pre-packaged PeopleSoft application version to the customer-defined 
application version. To copy the entities, perform the following high-level steps:

a. Right-click the customer-defined application version where the metadata is imported and select 
Copy entities from Application Version. The Copy Entities from Application Version window 
appears.

b. Select the application version from where you need to copy, which is typically PeopleSoft 
Retirement 1.0.

c. Provide the prefix that will be appended before the entity while copying. The Copy All Entities option 
is not required.

d. Click OK.

e. After you submit the background job, you can view the job status from the Data Archive user 
interface. Once the job successfully completes, you can view the copied entities in your customer-
defined application version. You can use these entities for Data Discovery and retention policies.

10. Before you run the reports, copy the report templates to the folder that corresponds to the Data Vault 
connection. You can use these pre-packaged Data Visualization reports to access retired data in the 
Data Vault. When you copy the reports, the system updates the report schemas based on the connection 
details.

11. Optionally, validate the retired data.

12. After you retire and validate the application, use the Data Discovery Portal, Data Visualization reports, or 
third-party query tools to access the retired data.

Accounts Payable Reports
In the Accounts Payable module, you can run the following reports:

• AP Outstanding Balance by Supplier

Prerequisites       265



• AP Payment History by Payment Method

• AP Posted Voucher Listing

AP Outstanding Balance by Supplier Report
The AP Outstanding Balance by Supplier report lists the gross amount of all the outstanding vouchers for the 
specified supplier or vendor.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Supplier Set ID <Any> Yes

Supplier ID <Any> No

Report Tables
The report contains the following tables:

• PS_BUS_UNIT_TBL_AP

• PS_BUS_UNIT_TBL_FS

• PS_INSTALLATION_FS

• PS_PYMNT_VCHR_XREF

• PS_PYMT_TRMS_HDR

• PS_SEC_BU_CLS

• PS_SEC_BU_OPR

• PS_SETID_TBL

• PS_SET_CNTRL_REC

• PS_VCHR_VNDR_INFO

• PS_VENDOR

• PS_VOUCHER

AP Payment History by Payment Method Report
The AP Payment History by Payment Method report provides a history of payments in detail by different 
payment methods and for different suppliers.
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Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

From Date 1900-01-01 Yes

To Date System Date Yes

SetID <Any> Yes

Currency USD -US Dollar No

Run Option All Banks No

Payment Method ACH : Automated Cleaning House No

Report Tables
The following tables are included in the report:

• PSXLATDEFN

• PSXLATITEM

• PS_BANK_ACCT_CPTY

• PS_BANK_ACCT_DEFN

• PS_BANK_BRANCH_TBL

• PS_BANK_CD_TBL

• PS_CURRENCY_CD_TBL

• PS_PAYMENT_TBL

• PS_SETID_TBL

AP Posted Voucher Listing Report
The AP Posted Voucher Listing report lists all of the posted vouchers for a given business unit and date 
range. For each voucher ID, the report lists document type, document date, document sequence, ledger, 
accounting date, application journal, dist type, vchr line, dist line, GL unit, account, dept, product, project, debit 
amount, credit amount, currency code, and unpost seq#.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

From Date (yyyy-MM-dd) System Date Yes

Through Date(yyyy-MM-dd) System Date Yes
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Parameter Default Value Mandatory

Business Unit <Any> Yes

Vendor/Supplier Select All Vendors/Suppliers No

Report Tables
The following tables are included in the report:

• PS_BUS_UNIT_TBL_AP

• PS_BUS_UNIT_TBL_FS

• PS_VCHR_ACCTG_LINE

• PS_VCHR_VNDR_INFO

• PS_VENDOR

• PS_VOUCHER

Purchase Order Reports
In the Purchase Order module, you can run the following reports:

• PO Detail Listing by PO Date

• Non-Owned Purchase History

• PO Order Status by Vendor

PO Detail Listing by PO Date Report
The PO Detail Listing by PO Date report provides detailed purchase order information sorted by purchase 
order date, list PO ID, Vendor ID, Item ID, Item Description, and more.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

From Date System Date No

Through Date System Date No

Business Unit <Any> No

Vendor SetID <Any> No
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Parameter Default Value Mandatory

Vendor ID <Any> No

Buyer <Any> No

Report Tables
The following tables are included in the report:

• PS_BUS_UNIT_TBL_FS

• PS_BUS_UNIT_TBL_PM

• PS_CNTRCT_CONTROL

• PS_OPR_DEF_TBL_FS

• PS_OPR_DEF_TBL_PM

• PS_PO_HDR

• PS_PO_LINE

• PS_PO_LINE_SHIP

• PS_SETID_TBL

• PS_VENDOR

• PSOPRDEFN

Non-Owned Purchase History Report
The Non-Owned Purchase History report lists utilization information of no-stock items for a business unit or 
departments. The report information can help to evaluate vendor contracts, establish and maintain budgets, 
and anticipate supply needs for a company.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Business Unit <Any> Yes

Select Date Option As Of Date No

As Of Date (yyyy-MM-dd) - No

DateRange:
From (yyyy-MM-dd)
To (yyyy-MM-dd)

- No

For Department Range:
From
To

- No
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Parameter Default Value Mandatory

All/Specific Item ID <Any> No

For Item ID Range:
From
To

- No

Report Tables
The following tables are included in the report:

• PS_BUS_UNIT_TBL_FS

• PS_DEPT_TBL

• PS_MASTER_ITEM_TBL

• PS_PO_HDR

• PS_PO_LINE

• PS_PO_LINE_SHIP

• PS_VENDOR

• PS_PO_LINE_DISTRIB

PO Order Status by Vendor Report
This PO Order Status by Vendor report provides purchase order status information sorted by vendor or 
supplier.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Business Unit <Any> Yes

From Date (yyyy-MM-dd) - No

To Date (yyyy-MM-dd) - No

Report Tables
The report includes the following tables:

• PS_BUS_UNIT_TBL_FS

• PS_BUS_UNIT_TBL_PM

• PSOPRDEFN

• PS_PO_HDR

• PS_PO_LINE
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• PS_PO_LINE_SHIP

• PS_VENDOR

• PSXLATITEM

Accounts Receivable Reports
In the Accounts Receivable module, you can run the following reports:

• AR Deposit Summary

• AR Payment Details

• AR Payment Summary

AR Deposit Summary Report
The AR Deposit Summary report lists detailed information for deposits, in either the business unit base 
currency or the entry currency. It displays the entry date, deposit ID, bank account, post status, control 
amount, entered amount, posted amount, and more.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

From Date 1900-01-01 Yes

To Date System Date Yes

Unit <Any> Yes

Amount Type Bass Curr No

UserID <Any> No

Deposit Type <Any> No

Bank Code <Any> No

Bank Account <Any> No

Posting Status All No

Report Tables
The following tables are included in the report:

• PSXLATITEM

• PS_BANK_ACCT_CPTY

• PS_BANK_ACCT_DEFN
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• PS_BANK_BRANCH_TBL

• PS_BANK_CD_TBL

• PS_BUS_UNIT_TBL_AR

• PS_BUS_UNIT_TBL_GL

• PS_DEPOST_TYPE_TBL

• PS_OPR_DEF_TBL_AR

• PS_OPR_DEF_TBL_FS

• PS_PAYMENT

• PS_SET_CNTRL_REC

• PS_DEPOSIT_CONTROL

• PS_BUS_UNIT_TBL_FS

AR Payment Detail Report
The AR Payment Detail report lists detailed information for all of the payments within a deposit, in either the 
business unit base currency or the entry currency. The payment details are unavailable if the posting status is 
"not posted."

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

From Date 1900-01-01 Yes

Thru Date System Date Yes

Deposit Unit <Any> Yes

Amount Type Base Curr No

User ID <Any> No

Deposit ID <Any> No

Posting Status All No

Report Tables
The following tables are included in the report:

• PS_DEPOSIT_CONTROL

• PS_PAYMENT

• PS_OPR_DEF_TBL_AR

• PS_OPR_DEF_TBL_FS

• PS_PENDING_ITEM

• PS_GROUP_CONTROL
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• PS_ENTRY_TYPE_TBL

• PS_CUSTOMER

• PS_SET_CNTRL_REC

• PS_BUS_UNIT_TBL_AR

• PS_BUS_UNIT_TBL_FS

AR Payment Summary Report
The AR Payment Summary report lists the status for all payments within a deposit, in either the business unit 
base currency or the entry currency. The report lists the entry date, deposit ID, post status, entered amount, 
payment status, and more.

Report Parameters
The following table describes the report parameters:

Parameter Default Value Mandatory

From Date 1900-01-01 Yes

Thru Date System Date Yes

Deposit Unit <Any> Yes

Amount Type Base Curr No

User ID <Any> No

Deposit ID <Any> No

Posting Status All No

Report Tables
The following tables are included in the report:

• PS_BUS_UNIT_TBL_AR

• PSXLATITEM

• PS_BUS_UNIT_TBL_FS

• PS_OPR_DEF_TBL_AR

• PS_OPR_DEF_TBL_FS

• PS_PAYMENT

• PS_DEPOSIT_CONTROL
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General Ledger Reports
In the General Ledger module, you can run the following reports:

• GL Trial Balance

• GL Journal Activity

• GL Journal Entry Detail

GL Trial Balance Report
The GL Trial Balance report combines detail and summary balance information. The report displays the 
ending ledger balances for the specified year and period by chatfield combination, and prints a final total for 
debits and credits.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Ledger <Any> Yes

Business Unit <Any> Yes

Fiscal Year - Yes

Currency Option <Any> No

For Account Range:
From
To

- No

For Account Range:
From
To

- No

Report Tables
The following tables are included in the report:

• PS_BUS_UNIT_TBL_GL

• PS_BUS_UNIT_TBL_FS

• PS_CAL_DETP_TBL

• PS_CURRENCY_CD_TBL

• PS_GL_ACCOUNT_TBL

• PS_LEDGER

• PS_LED_DEFN_TBL

• PS_PRODUCT_TBL
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GL Journal Activity Report
The GL Journal Activity report displays information about journals. It lists the journal date, journal ID, 
description, and debit and credit amount totals for each journal.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

Ledger <Any> Yes

Business Unit <Any> Yes

Ledger Group <Any> Yes

Date or Period Date Yes

For Date:
From Date (yyyy-MM-dd)
To Date (yyyy-MM-dd)

- No

Date Option Journal Date No

For Period:
From
To
Fiscal Year

- No

Detail/Summary Detail No

Journal Status ALL No

Report By Account No

Report Tables
The following tables are included in the report:

• PS_BUS_UNIT_TBL_GL

• PS_BUS_UNIT_TBL_FS

• PSXLATITEM

• PS_JRNL_HEADER

• PS_JRNL_LN

• PS_LED_DEFN_TBL

• PS_LED_GRP_TBL

• PS_SOURCE_TBL
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GL Journal Entry Detail Report
The GL Journal Entry Detail report shows journal entry detail information by business unit, journal ID, ledger 
and ledger group, and source. The report lists like accounts and products based on the chart fields selected. 
It also displays debits, credits, and totals for the journal.

Report Parameters
The following table describes the report input parameters:

Parameter Default Value Mandatory

From Date (yyyy-MM-dd) - No

To Date (yyyy-MM-dd) - No

Journal ID ALL No

Journal Status ALL No

Business Unit <Any> Yes

Ledger Group <Any> Yes

Ledger <Any> Yes

Source ALL No

Account <Any> No

Product <Any> No

Report Tables
The following tables are included in the report:

• PS_BUS_UNIT_TBL_GL

• PS_BUS_UNIT_TBL_FS

• PSXLATITEM

• PS_JRNL_HEADER

• PS_JRNL_LN

• PS_LED_DEFN_TBL

• PS_LED_GRP_TBL

• PS_SOURCE_TBL

• PS_GL_ACCOUNT_TBL

• PS_OPEN_ITEM_GL

• PS_PRODUCT_TBL

276       Chapter 19: Oracle PeopleSoft Applications Retirement Reports



Saving the Reports to the Archive Folder
Before you can run a report, you must save the imported reports to the Data Vault archive folder where you 
retired the application data.

1. Click Data Visualization > Reports and Dashboards. 

2. Click the check box next to the imported reports to select all of the reports. 

3. Click Actions > Save As. 

The Save As window appears.

4. Select the Data Vault archive folder where you retired the application data. 

5. Enter a name for the reports folder. 

6. Click OK. 

Data Archive creates the reports folder within the archive folder.

Running a Report
You can run a report through the Data Visualization area of Data Archive. Each report has two versions. To 
run the report, use the version with "Search Form" in the title, for example "Invoice Journal Report - Search 
Form.cls."

To ensure that authorized users can run the report, review the user and role assignments for each report in 
Data Archive.

1. Click Data Visualization > Reports and Dashboards. 

2. Select the check box next to the report that you want to run. 

3. Click Actions > Run Report. 

The Report Search Form window appears.

4. Enter or select the values for each search parameter that you want to use to generate the report. 

5. Click Apply. 

Saving the Reports to the Archive Folder       277



C h a p t e r  2 0

Language Settings
This chapter includes the following topics:

• Language Settings Overview, 278

• Changing Browser Language Settings, 278

Language Settings Overview
You can change language settings in the Information Lifecycle Management web user interface at the 
browser level.

Changing Browser Language Settings
The browser language settings allow you to change the browser’s default language to your preferred 
language.

To change the language settings at the browser level:

1. Open the Internet Explorer web browser.

2. Click Tools > Internet Options.

3. Click the General tab.

4. Click Languages.

5. In the Language Preference window, click Add.

6. Select the language. 

For example: French(France) [fr-FR] to change the language to French.

7. Click OK.
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A p p e n d i x  A

Data Vault Datatype Conversion
This appendix includes the following topics:

• Data Vault Datatype Conversion Overview, 279

• Data Vault, 279

• Datatype Conversion Errors, 287

Data Vault Datatype Conversion Overview
When you archive to a file, the Data Archive project includes the Data Vault Loader job. One of the tasks that 
the Data Vault Loader job performs is the datatype conversion between the source database and Data Vault. 
The Data Vault Loader job can convert datatypes from Oracle, Microsoft SQL Server, IBM DB2 UDB, and 
Teradata databases.

If you have custom datatypes on your source database, you must manually map each custom datatype to a 
Data Vault datatype before you run the Data Vault Loader job. For information on how to map custom 
datatypes, see the Data Archive Administrator Guide.

Data Vault
The Data Vault Loader job converts native datatypes based on the database.

Oracle Datatypes
The following table describes how the Data Vault Loader job converts Oracle native datatypes to Data Vault 
datatypes:

Oracle Datatype Data Vault Datatype

CHAR - If length is less than or equal to 32768, converts to CHAR(length).
- If length is greater than 32768, converts to CLOB.

VARCHAR - If length is less than or equal to 32768, converts to VARCHAR(length).
- If length is greater than 32768, converts to CLOB.
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Oracle Datatype Data Vault Datatype

DATE TIMESTAMP

TIMESTAMP TIMESTAMP

TIMESTAMP WITH TIME ZONE VARCHAR(100)

TIMESTAMP(9) WITH TIME ZONE VARCHAR

INTERVAL YEAR TO MONTH VARCHAR

INTERVAL YEAR(4) TO MONTH VARCHAR

INTERVAL DAY TO SECOND VARCHAR

INTERVAL DAY(9) TO SECOND(9) VARCHAR

BFILE BLOB

BLOB BLOB

CLOB CLOB

RAW (2000) VARCHAR (4000)

LONG RAW BLOB

LONG BLOB

NUMBER DECIMAL

FLOAT - If length is less than or equal to 63, converts to REAL.
- If length is greater than 63 but less than or equal to 126, converts to 

FLOAT(53).
- If length is greater than 126, converts to FLOAT.

DECIMAL DECIMAL

DEC DECIMAL

INT INTEGER

INTEGER INTEGER

SMALLINT SMALLINT

REAL - If length is less than or equal to 63, converts to REAL.
- If length is greater than 63 but less than or equal to 126, converts to 

FLOAT(53).
- If length is greater than 126, converts to FLOAT.

DOUBLE PRECISION DOUBLE PRECISION
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Oracle Datatype Data Vault Datatype

ROWID VARCHAR(18)

UROWID VARCHAR

Manual Conversion of Oracle Datatypes
The following table describes the Oracle datatypes that require manual conversion:

Source Datatype Data Vault Datatype

NUMBER If the length is more than 120, change the datatype to DOUBLE in the metadata XML file.

IBM DB2 Datatypes
The following table describes how the Data Vault Loader job converts IBM DB2 native datatypes to Data Vault 
datatypes:

IBM DB2 Datatype Data Vault Datatype

CHARACTER - If length is less than or equal to 32768, converts to CHAR(length).
- If length is greater than 32768, converts to CLOB.

VARCHAR - If length is less than or equal to 32768, converts to VARCHAR(length).
- If length is greater than 32768, converts to CLOB.

LONG VARCHAR CLOB

DATE TIMESTAMP

TIME VARCHAR

TIMESTAMP TIMESTAMP

BLOB BLOB

SMALLINT SMALLINT

INTEGER INTEGER

BIGINT DECIMAL(19)

REAL - If length is less than or equal to 63, converts to REAL.
- If length is greater than 63 but less than or equal to 126, converts to FLOAT(53).
- If length is greater than 126, converts to FLOAT.

FLOAT - If length is less than or equal to 63, converts to REAL.
- If length is greater than 63 but less than or equal to 126, converts to FLOAT(53).
- If length is greater than 126, converts to FLOAT.
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IBM DB2 Datatype Data Vault Datatype

DOUBLE PRECISION DOUBLE PRECISION

DECIMAL DECIMAL

Manual Conversion of IBM DB2 Datatypes
The following table describes the IBM DB2 datatypes that require manual conversion:

Source Datatype Data Vault Datatype

GRAPHIC Change to VARCHAR in the metadata XML file.

VARGRAPHIC Change to VARCHAR in the metadata XML file.

LONG VARGRAPHIC Change to CLOB in the metadata XML file.

DBCLOB Change to CLOB in the metadata XML file.

Microsoft SQL Server Datatypes
The following table describes how the Data Vault Loader job converts Microsoft SQL Server native datatypes 
to Data Vault datatypes:

SQL Server Datatype Data Vault Service Datatype

CHAR - If length is less than or equal to 32768, converts to CHAR(length).
- If length is greater than 32768, converts to CLOB.

CHAR(8000) CHAR(8000)

TEXT CLOB

VARCHAR VARCHAR

VARCHAR(8000) VARCHAR(8000)

VARCHAR(MAX) CLOB

DATE TIMESTAMP

DATETIME2(7) VARCHAR

DATETIME TIMESTAMP

DATETIMEOFFSET VARCHAR(100)

SMALLDATETIME TIMESTAMP

TIME VARCHAR(100)
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SQL Server Datatype Data Vault Service Datatype

BIGINT DECIMAL(19)

BIT VARCHAR(10)

DECIMAL DECIMAL

INT INTEGER

MONEY DECIMAL(19,4)

NUMERIC DECIMAL(19)

SMALLINT SMALLINT

SMALLMONEY INTEGER

TINYINT INTEGER

FLOAT - If length is less than or equal to 63, converts to REAL.
- If length is greater than 63 but less than or equal to 126, converts to FLOAT(53).
- If length is greater than 126, converts to FLOAT.

REAL - If length is less than or equal to 63, converts to REAL.
- If length is greater than 63 but less than or equal to 126, converts to FLOAT(53).
- If length is greater than 126, converts to FLOAT.

BINARY BLOB

BINARY(8000) BLOB

IMAGE BLOB

VARBINARY BLOB

VARBINARY(8000) BLOB

VARBINARY(MAX) BLOB

Salesforce Datatypes
The following table describes how the Data Vault Loader job converts Salesforce datatypes to Data Vault 
datatypes:

Salesforce Datatype Data Vault Datatype

ID VARCHAR

TEXT VARCHAR

PERCENT DECIMAL

EMAIL VARCHAR
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Salesforce Datatype Data Vault Datatype

LONGTEXTAREA CLOB

MULTISELECTPICKLIST VARCHAR

DATETIME TIMESTAMP

PICKLIST VARCHAR

HTML CLOB

TEXTAREA VARCHAR

ENCRYPTEDTEXT VARCHAR

AUTONUMBER VARCHAR

REFERENCE VARCHAR

DATE DATE

PHONE VARCHAR

URL VARCHAR

CHECKBOX VARCHAR

CURRENCY DECIMAL

COMBOBOX VARCHAR

NUMBER DECIMAL

INT DECIMAL

Teradata Datatypes
The following table describes how the Data Vault Loader job converts Teradata native datatypes to Data 
Vault datatypes:

Teradata Datatype Data Vault Datatype

BYTE BLOB

BYTE(64000) BLOB

VARBYTE(64000) BLOB

BLOB BLOB

CHARACTER - If length is less than or equal to 32768, converts to CHAR(length).
- If length is greater than 32768, converts to CLOB.
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Teradata Datatype Data Vault Datatype

CHARACTER(32000) CLOB

LONG VARCHAR CLOB

VARCHAR(32000) CLOB

LONGVARGRAPHIC CLOB

VARGRAPHIC - If length is less than or equal to 8192, converts to VARCHAR(4x).
- If length is greater than 8192, converts to CLOB.

CLOB CLOB

DATE TIMESTAMP

TIME VARCHAR

TIME WITH TIMEZONE VARCHAR

TIMESTAMP VARCHAR

TIMESTAMP WITH TIMEZONE VARCHAR

INTERVAL YEAR VARCHAR

INTERVAL YEAR(4) VARCHAR

INTERVAL YEAR(4) TO MONTH VARCHAR

INTERVAL YEAR TO MONTH VARCHAR(100)

INTERVAL MONTH VARCHAR

INTERVAL MONTH(4) VARCHAR

INTERVAL DAY VARCHAR

INTERVAL DAY(4) VARCHAR

INTERVAL DAY TO HOUR VARCHAR(100)

INTERVAL DAY(4) TO HOUR VARCHAR

INTERVAL DAY TO MINUTE VARCHAR

INTERVAL DAY(4) TO MINUTE VARCHAR

INTERVAL DAY TO SECOND VARCHAR

INTERVAL DAY(4) TO SECOND VARCHAR

INTERVAL HOUR VARCHAR

INTERVAL HOUR(4) VARCHAR
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Teradata Datatype Data Vault Datatype

INTERVAL HOUR TO MINUTE VARCHAR

INTERVAL HOUR(4) TO MINUTE VARCHAR

INTERVAL HOUR TO SECOND VARCHAR

INTERVAL HOUR(4) TO SECOND(6) VARCHAR

INTERVAL MINUTE VARCHAR

INTERVAL MINUTE(4) VARCHAR

INTERVAL MINUTE TO SECOND VARCHAR

INTERVAL MINUTE(4) TO SECOND(6) VARCHAR

INTERVAL SECOND VARCHAR

INTERVAL SECOND(4,6) VARCHAR

SMALLINT SMALLINT

INTEGER INTEGER

BIGINT DECIMAL(19)

BYTEINT INTEGER

REAL - If length is less than or equal to 63, converts to REAL.
- If length is greater than 63 but less than or equal to 126, converts to 

FLOAT(53).
- If length is greater than 126, converts to FLOAT.

FLOAT - If length is less than or equal to 63, converts to REAL.
- If length is greater than 63 but less than or equal to 126, converts to 

FLOAT(53).
- If length is greater than 126, converts to FLOAT.

DOUBLE PRECISION - If length is less than or equal to 63, converts to REAL.
- If length is greater than 63 but less than or equal to 126, converts to 

FLOAT(53).
- If length is greater than 126, converts to FLOAT.

DECIMAL DECIMAL

PERIOD(DATE) UDCLOB

PERIOD(TIMESTAMP WITH TIMEZONE) UDCLOB

PERIOD(TIME WITH TIMEZONE) UDCLOB

PERIOD(TIMESTAMP) UDCLOB
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Datatype Conversion Errors
The Data Vault Loader job may not always convert datatypes automatically. The Data Vault Loader job may 
not be able to find a generic datatype to convert when it creates objects in Data Vault. Or, the Data Vault 
Loader job may have conversion errors or warnings when it loads numeric data to Data Vault. In either case, 
you must convert the datatypes manually.

Convert the datatypes if you receive one of the following errors in the log file:
Unsupported Datatype Error

If the Data Vault Loader job processes an unsupported datatype and is not able to identify a generic 
datatype, you receive an error message in the log file. The log file indicates the unsupported datatype, 
the table and column the datatype is included in, and the metadata xml file location that requires the 
change.

Conversion Error

If the Data Vault Loader job loads columns that have large numeric data or long strings of multibyte 
characters, it generates conversion warnings in the log file. The log file indicates the reason why the job 
failed if there is a problem converting data.

Converting Datatypes for Unsupported Datatype Errors
Manually convert datatypes to resolve the unsupported datatype error in the Data Vault Loader log file.

1. Access the log file. 

2. Search the log for the unsupported datatype error. 

Use the error description to find the table and corresponding datatype that you need to convert.

3. Access the metadata xml file that the ILM engine generated. 

Use the error description to find the file location.

4. Change the datatype to a supported Data Vault Service datatype. 

Use the error description to find the table and corresponding datatype that you need to convert.

5. Resume the Data Vault Loader job. 

Converting Datatypes for Conversion Errors
Manually modify columns to resolve the conversion errors generated by the Data Vault Loader job. Data 
Archive ships with sample scripts that you could modify to make column changes to the Data Vault. You can 
use the SQL Worksheet to run the scripts on the Data Vault.

1. Use a text editor to open the sample script installed with Data Archive. 

2. Modify the script for the column changes you need to make. 

3. Run the script. 

4. Resume the Data Vault Loader job. 

If the conversion error involves a change in the size of a column, use the following sample script to change 
the size of columns in the Data Vault:

CREATE DOMAIN "dbo"."D_TESTCHANGESIZE_NAME_TMP" VARCHAR(105);
ALTER TABLE "dbo"."TESTCHANGESIZE" ADD COLUMN 
"NAME_TMP" "dbo"."D_TESTCHANGESIZE_NAME_TMP";
ALTER TABLE "dbo"."TESTCHANGESIZE" DROP COLUMN NAME;
ALTER TABLE "dbo"."TESTCHANGESIZE" RENAME COLUMN "NAME_TEMP" "NAME";
DROP DOMAIN "dbo"."D_TESTCHANGESIZE_NAME";
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RENAME DOMAIN "dbo"."D_TESTCHANGESIZE_NAME_TMP" "D_TESTCHANGESIZE_NAME";
COMMIT;

If the conversion error involves a change in the number of columns in the table, use the following sample 
script to add columns to the table in the Data Vault:

CREATE DOMAIN "dbo"."D_TESTCHANGESIZE_DOB" TIMESTAMP;
ALTER TABLE "dbo"."TESTCHANGESIZE" ADD COLUMN "DOB" "dbo"."D_TESTCHANGESIZE_DOB";
COMMIT;
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A p p e n d i x  B

Special Characters in Data Vault
This appendix includes the following topic:

• Special Characters in Data Vault, 289

Special Characters in Data Vault
When you retire data to the Data Vault, the presence of special characters in the table, column, or schema 
names of the data might cause the Data Vault Loader job or other Data Vault functions, such as retention, 
legal hold, or Data Visualization, to fail.

Before you create a retirement project, check for the presence of special characters in table, column, and 
schema names.

Supported Special Characters
Certain special characters are supported for schema, table, and column names in Data Vault.

Table and Column Names 

The following special characters are supported for table and column names in Data Vault: _ $ ~ ! @ ^ & - + = : < 
> ? | { }

Schema/Database Names 

The following special characters are supported for schema and database names in Data Vault: _ $

Note: Schema names should not start with _ or $.
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A p p e n d i x  C

SAP Application Retirement 
Supported HR Clusters

This appendix includes the following topics:

• SAP Application Retirement Supported HR Clusters Overview , 290

• PCL1 Cluster IDs, 291

• PCL2 Cluster IDs, 291

• PCL3 Cluster IDs, 300

• PCL4 Cluster IDs, 300

• PCL5 Cluster IDs, 300

SAP Application Retirement Supported HR Clusters 
Overview

SAP applications encode data in an SAP format. You can only read the data through the SAP application 
layer, not the database layer. The retirement job reads and transforms the SAP encoded data for certain 
clusters.

The retirement job logs in to the SAP system and uses the ABAP import command to read the SAP encoded 
cluster data. The job transforms the encrypted data into XML format during the extraction process. The XML 
structure depends on the cluster ID in the transparent table.

The job reads data from the PCL1, PCL2, PCL3, PCL4, and PCL5 transparent HR tables. The tables store 
sensitive human resource data. The job transforms the data by cluster IDs. The transformation is not 
supported for all cluster IDs. The job also transforms data for the all cluster IDs for the STXL text table.
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PCL1 Cluster IDs
The retirement job converts encrypted data into XML format depending on the HR cluster ID.

The following table lists the PCL1 cluster IDs that the retirement job transforms into XML:

SAP Cluster ID SAP Cluster Description

B1 PDC data

G1 Group incentive wages

L1 Ind. incentive wages

PC Personnel calendar

TA General data for travel expense acctg

TC Credit card data for travel expense acctg

TE HR travel expenses international

TX Texts for PREL

PCL2 Cluster IDs
The retirement job converts encrypted data into XML format depending on the HR cluster ID.

The following table lists the PCL2 cluster IDs that the retirement job transforms into XML:

SAP Cluster ID SAP Cluster Description

A2 Payroll results Argentina: Annual consolidation

AA Payroll results (Saudi Arabia)

AB Payroll results (Albania)

AD Payroll results (Andorra)

AE Payroll results (garnishment)

AG Payroll results (Antigua)

AH Payroll results (Afghanistan)

AM Payroll results (Armenia)

AO Payroll results (Angola)

AR Payroll results (Argentina)
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SAP Cluster ID SAP Cluster Description

AW Payroll results (Aruba)

AZ Payroll results (Azerbaijan)

B2 PDC data (month)

BA Payroll results (Bosnia and Herzegovina)

BB Payroll results (Barbados)

BD Payroll results (Bangladesh)

BF Payroll results (Burkina Faso)

BG Payroll results (Bulgaria)

BH Payroll results (Bahrain)

BI Payroll results (Burundi)

BJ Payroll results (Benin)

BM Payroll results (Bermuda)

BN Payroll results (Brunei)

BO Payroll results (Bolivia)

BR Payroll results (Brazil)

BS Payroll results (Bahamas)

BT Payroll results (Bhutan)

BW Payroll results (Botswana)

BY Payroll results (Belarus)

BZ Payroll results (Belize)

CA Cluster directory (CU enhancement for archiving)

CF Payroll results (Central African Republic)

CG Payroll results (Democratic Republic of the Congo)

CI Payroll results (Ivory Coast)

CK Payroll results (Cook Islands)

CL Payroll results (Chile)

CM Payroll results (Cameroon)
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SAP Cluster ID SAP Cluster Description

CN Payroll results (China)

CO Payroll results (Colombia)

CV Payroll results (Cape Verde)

DJ Payroll results (Djibouti)

DM Payroll results (Dominica)

DO Payroll results (Dominican Republic)

DP Garnishments (DE)

DQ Garnishment directory

DY Payroll results (Algeria)

EC Payroll results (Ecuador)

EE Payroll results (Estonia)

EG Payroll results (Egypt)

EI Payroll results (Ethiopia)

EM Payroll results (United Arab Emirates)

ER Payroll results (Eritrea)

ES Payroll results (totals)

ET Payroll results (totals)

FI Payroll results (Finland)

FJ Payroll results (Fiji)

FM Payroll results (Federated States of Micronesia)

FO Payroll results (Faroe Islands)

GA Payroll results (Gabon)

GD Payroll results (Grenada)

GE Payroll results (Georgia)

GF Payroll results (French Guiana)

GH Payroll results (Ghana)

GL Payroll results (Greenland)
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SAP Cluster ID SAP Cluster Description

GM Payroll results (Gambia)

GN Payroll results (Guinea)

GP Payroll reconciliations (GB)

GQ Payroll results (Equatorial Guinea)

GR Payroll results (Greece)

GT Payroll results (Guatemala)

GU Payroll results (Guam)

GW Payroll results (Guinea-Bissau)

GY Payroll results (Guyana)

HK Payroll results (HongKong)

HN Payroll results (Honduras)

HR Payroll results (Croatia)

HT Payroll results (Haiti)

IC Payroll results (Iceland)

ID Interface toolbox - Directory for interface results

IE Payroll results (Ireland)

IF Payroll interface

IL Payroll results (Israel)

IN Payroll results India

IQ Payroll results (Iraq)

IR Payroll results (Iran)

IS Payroll results (Indonesia)

JM Payroll results (Jamaica)

JO Payroll results (Jordan)

KE Payroll results (Kenya)

KG Payroll results (Kyrgyzstan)

KH Payroll results (Cambodia)
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SAP Cluster ID SAP Cluster Description

KI Payroll results (Kiribati)

KM Payroll results (Comoros)

KO Payroll results (Democratic Republic of the Congo)

KP Payroll results (North Korea)

KR Payroll results (Korea)

KT Payroll results (Saint Kitts and Nevis)

KU Payroll results (Cuba)

KW Payroll results (Kuwait)

KZ Payroll results (Kazakhstan)

LC Payroll results (Saint Lucia)

LE Payroll results (Lebanon)

LI Payroll results (Liechtenstein)

LK Payroll results (Sri Lanka)

LO Payroll results (Laos)

LR Payroll results (Liberia)

LS Payroll results (Lesotho)

LT Payroll results (Lithuania)

LU Payroll results (Luxembourg)

LV Payroll results (Latvia)

LY Payroll results (Libya)

MA Payroll results (Morocco)

MC Payroll results (Monaco)

MD Payroll results (Moldova)

MG Payroll results (Madagascar)

MH Payroll results (Marshall Islands)

MK Payroll results (Macedonia, FYR of)

ML Payroll results (Mali)
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SAP Cluster ID SAP Cluster Description

MM Payroll results (Myanmar)

MN Payroll results (Mongolia)

MP Payroll results (Northern Mariana Islands)

MR Payroll results (Mauritania)

MT Payroll results (Malta)

MU Payroll results (Mauritius)

MV Payroll results (Maldives)

MW Payroll results (Malawi)

MX Payroll results (Mexico)

MZ Payroll results (Mozambique)

NA Payroll results (Namibia)

NC Payroll results (New Caledonia)

NE Payroll results (Niger)

NG Payroll results (Nigeria)

NP Payroll results (Nepal)

NR Payroll results (Nauru)

NZ Payroll results (New Zealand)

OD Civil service - staggered payment (directory)

OM Payroll results (Oman)

PA Payroll results (Panama)

PE Payroll results (Peru)

PF Payroll results (French Polynesia)

PG Payroll results (Papua New Guinea)

PH Payroll results (Philippines)

PK Payroll results (Pakistan)

PL Payroll results (Poland)

PO Payroll results (Puerto Rico)
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SAP Cluster ID SAP Cluster Description

PS Schema

PT Schema

PU Payroll results (Paraguay)

PW Payroll results (Palau)

Q0 Statements (international)

QA Payroll results (Qatar)

RA Payroll results (Austria)

RB Payroll results (Belgium)

RC Payroll results (Switzerland), all data

RD Payroll results (Germany), all data

RE Payroll results (Spain)

RF Payroll results (France), all data

RG Payroll results (Britain)

RH Payroll results (Hungary)

RI Payroll results (Italy)

RJ Payroll results (Japan)

RK Payroll results (Canada)

RL Payroll results (Malaysia)

RM Payroll results (Denmark)

RN Payroll results (Netherlands)

RO Payroll results (Romania)

RP Payroll results (Portugal)

RQ Payroll results (Australia)

RR Payroll results (Singapore)

RS Payroll results (Sweden)

RT Payroll results (Czech Republic)

RU Payroll results (USA)
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SAP Cluster ID SAP Cluster Description

RV Payroll results (Norway)

RW Payroll results (South Africa)

RX Payroll results (international), all data

SC Payroll results (Seychelles)

SD Payroll results (Sudan)

SI Payroll results (Slovenia)

SK Payroll results (Slovakia)

SL Payroll results (Sierra Leone)

SM Payroll results (San Marino)

SN Payroll results (Senegal)

SO Payroll results (Somalia)

SR Payroll results (Suriname)

SV Payroll results (El Salvador)

SY Payroll results (Syria)

SZ Payroll results (Swaziland)

TD Payroll results (Chad)

TG Payroll results (Togo)

TH Payroll results (Thailand)

TJ Payroll results (Tajikistan)

TM Payroll results (Tunisia)

TN Payroll results (Taiwan)

TO Payroll results (Tonga)

TP Payroll results (East Timor)

TR Payroll results (Turkey)

TT Payroll results (Trinidad and Tobago)

TU Payroll results (Turkmenistan)

TV Payroll results (Tuvalu)
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SAP Cluster ID SAP Cluster Description

TZ Payroll results (Tanzania)

UA Payroll results (Ukraine)

UG Payroll results (Uganda)

UN Payroll results (United Nations)

UR Payroll results (Russia)

UY Payroll results (Uruguay)

UZ Payroll results (Uzbekistan)

VA Payroll results (Vatican City)

VC Payroll results (Saint Vincent)

VE Payroll results (Venezuela)

VN Payroll results (Vietnam)

VU Payroll results (Vanuatu)

WA Payroll results (Rwanda)

WS Payroll results (Samoa)

XA Special run (Austria)

XD Payroll results (Germany), all data

XE Payroll results (Spain)

XM Payroll results (Denmark)

YE Payroll results (Yemen)

YJ Cluster YJ (year-end adjustment) (Japan)

YS Payroll results (Solomon Islands)

YT Payroll results (Sao Tome)

YU Payroll results (Serbia and Montenegro)

ZL Time wage types/work schedule

ZM Payroll results (Zambia)

ZS VBL/SPF onetime payment

ZV SPF data
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SAP Cluster ID SAP Cluster Description

ZW Payroll results (Zimbabwe)

ZY Payroll results (Cyprus)

PCL3 Cluster IDs
The retirement job converts encrypted data into XML format depending on the HR cluster ID.

The following table lists the PCL3 cluster IDs that the retirement job transforms into XML:

SAP Cluster ID SAP Cluster Description

AL Letters for actions

AN Notepad for actions

AP Applicant actions

TY Applicant data texts

PCL4 Cluster IDs
The retirement job converts encrypted data into XML format depending on the HR cluster ID.

The following table lists the PCL4 cluster IDs that the retirement job transforms into XML:

SAP Cluster ID SAP Cluster Description

LA Long-term receipts for PREL

PR Logging of report start (T599R)

SA Short-term receipts for PREL

PCL5 Cluster IDs
The retirement job converts SAP encoded data into XML format depending on the HR cluster ID.

The retirement job transforms data into XML for the PCL5 AL cluster ID.
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A p p e n d i x  D

Glossary
access policy

A policy that determines the segments that an individual user can access. Access policies can restrict 
access to segments based on the application user, database user, or OS user.

administrator

The administrator is the Data Archive super user. The administrator includes privileges for tasks such as 
creating and managing users, setting up security groups, defining the system profile, configuring repositories, 
scheduling jobs, creating archive projects, and restoring database archives.

application

A list of brand names that identify a range of ERP applications, such as Oracle and PeopleSoft.

application module

A list of supported Application Modules for a particular Application Version.

application version

A list of versions for a particular application.

archive

Informatica refers to a backed up database as an Archive. From the process perspective, it also means 
archiving data from an ERP/CRM instance to an online database using business rules.

archive (Database)

A database archive is defined as moving data from an ERP/CRM instance to another database or flat file.

archive (File)

File archive is defined as moving data from an ERP/CRM instance to one or more BCP files.

archive action

Data Archive enables data to be copied from Data Source to Data Target (Archive Only), deleted from Data 
Source after the backup operation (Archive and Purge), or deleted from the Data Source as specified in the 
Archive Project (Purge Only).

archive definition

An Archive Definition defines what data is archived, where it is archived from, and where it is archived to.



archive engine

A set of software components that work together to archive data.

archive project

An archive project defines what data is to be archived, where it is archived from, and where it is archived to.

business rule

A business rule is criteria that determines if a transaction is eligible to be archived or moved from the default 
segment.

business table

Any Table that (with other Tables and Interim Tables) contributes to define an Entity.

column level retention

A rule that you apply to a retention policy to base the retention period for records in an entity on a column in 
an entity table. The expiration date for each record in the entity equals the retention period plus the date in 
the column. For example, records in the EMPLOYEE entity expire 10 years after the date stored in the 
EMP.TERMINATION_DATE column.

custom object

An Object (Application / Entity) defined by an Enterprise Data Manager Developer.

dashboard

A component that generates information about the rate of data growth in a given source database. The 
information provided by this component is used to plan the archive strategy.

Data Archive

A product of the Information Lifecycle Management Suite, which provides flexible archive / purge 
functionality that quickly, reduces the overall size of production databases. Archiving for performance, 
compliance, and retirement are the three main use cases for Data Archive.

Data Archive metadata

Metadata that is specific to a particular ILM product.

data classification

A policy that defines the data set in segments based on criteria that you define, such as dimensions.

data destination

The database containing the archived data.

Data Model Metadata

Metadata that is common to Data Archive.
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Data Privacy

A product of the Information Lifecycle Management Suite, which provides a comprehensive automated data 
privacy solution for sensitive data stored in everything from mission critical production systems to internal 
QA and development environments to long term data repositories over a heterogeneous IT infrastructure.

data source

The database containing the data to be archived.

Data Subset

A product of the Information Lifecycle Management Software, which enables organizations to create smaller, 
targeted databases for project teams that maintain application integrity while taking up a fraction of the 
space.

data target

The database containing the archived data. This might alternatively be referred to as History Database.

Data Vault access role

User-defined role that restricts access to archived data in the Data Discovery portal. You assign access roles 
directly to entities and users. For further restriction, you can assign an access role to the archive or 
retirement project.

de-referencing

The process of specifying inter-Column Constraints for JOIN queries when more than two Tables are 
involved. Enterprise Data Manager dictates that two Tables are specified first and then a Column in the 
Second Table is De-Referenced to specify a Third Table (and so on) for building the final JOIN query.

entity

An entity is a hierarchy of ERP/CRM tables whose data collectively comprise a set of business transactions. 
Each table in the hierarchy is connected to one or more other tables via primary key/foreign key relationships. 
Entity table relationships are defined in a set of metadata tables.

ERP application

ERP applications are software suites used to create business transaction documents such as purchase 
orders and sales orders.

expiration date

The date at which a record is eligible for deletion. The expiration date equals the retention period plus a date 
that is determined by the retention policy rules. The Purge Expired Records job uses this date to determine 
which records to delete from the Data Vault. A record expires on its expiration date at 12:00:00 a.m. The time 
is local to the machine that hosts the Data Vault Service. A record with an indefinite retention period does not 
have an expiration date.

expression-based retention

A rule that you apply to a retention policy to base the retention period for records in an entity on a date value 
that an expression returns. The expiration date for each record in the entity equals the retention period plus 
the date value from the expression. For example, records in the CUSTOMER table expire five years after the 
last order date, which is stored as an integer.
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formula

A procedure that determines the value of a new time dimension slice based on the end value of the previous 
dimension slice.

general retention

A rule that you apply to a retention policy to base the retention period for records in an entity on the archive 
job date. The expiration date for each record in the entity equals the retention period plus the archive job 
date. For example, records in an entity expire five years after the archive job date.

history database

Database used to store data that is marked for archive in a database archive project.

home database

The database containing metadata and other tables used to persist application data. This is contained in the 
Schema, usually known as “AMHOME”.

interim

Temporary tables generated for an Entity for data archive.

job

A process scheduled for running at a particular point in time. Jobs in Data Archive include Archive Projects or 
Standalone Jobs.

metadata

Metadata is data about data. It not only contains details about the structure of database tables and objects, 
but also information on how data is extracted, transformed, and loaded from source to target. It can also 
contain information about the origin of the data.

Metadata contains Business Rules that determines whether a given transaction is archivable.

production database

Database which stores Transaction data generated by the ERP Application.

restore (Cycle)

A restore operation based on a pre-created Archive Project.

restore (Full)

A restore operation that involves complete restoration of data from Data Target to Data Source.

restore (Transaction)

A restore operation that is carried out by precisely specifying an Entity, Interim Tables and related WHERE 
clauses for relevant data extractions.

retention management

The process of storing records in the Data Vault and deleting records from the Data Vault. The retention 
management process allows you to create retention policies for records. You can create retention policies for 
records as part of a data archive project or a retirement archive project.
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retention policy

The set of rules that determine the retention period for records in an entity. For example, an organization 
must retain insurance policy records for five years after the most recent message date in the policy, claims, 
or client message table. You apply a retention policy to an entity. You can apply a retention policy rule to a 
subset of records in the entity.

security group

A Security Group is used to limit a User (during an Archive Project) to archive only data that conforms to 
certain scope restrictions for an Entity.

staging schema

A staging schema is created at the Data Source for validations during data backup.

standard object

An Object (Application / Entity) which is pre-defined by the ERP Application and is a candidate for Import into 
Enterprise Data Manager.

system-defined role

Default role that includes a predefined set of privileges. You assign roles to users. Any user with the role can 
perform all of the privileges that are included in the role.

system profile

Technical information about certain parameters, usually related to the Home Schema, or Archive Users 
comprises the System Profile.

transaction data

Transaction data contain the information within the business documents created using the master data, such 
as purchase orders, sales orders etc. Transactional Data can change very often and is not constant. 
Transaction data is created using ERP applications.

Transaction data is located in relational database table hierarchies. These hierarchies enforce top-down data 
dependencies, in which a parent table has one or more child tables whose data is linked together using 
primary key/foreign key relationships.

translation column

A column which is a candidate for a JOIN query on two or more Tables. This is applicable to Independent 
Archive, as Referential Data is backed up exclusively for XML based Archives and not Database archive, 
which contain only Transaction Data.

Note that such a scenario occurs when a Data Archive job execution extracts data from two Tables that are 
indirectly related to each other through Constrains on an intermediary Table.

user

Data Archive is accessible through an authentication mechanism, only to individuals who have an account 
created by the Administrator. The level of access is governed by the assigned system-defined roles.

user profile

Basic information about a user, such as name, email address, password, and role assignments.
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